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Xerox Nuvera® System
Administrator Guide Start
Page

Please select one of the sections below or from the sidebar.

DescriptionSection

Begin with this option to assure that your system is correctly
communicating over the network using the TCP/IP protocol.

Required Setup Steps

See this section for instructions on how to install this device
in a variety of NOS environments in addition to the TCP/IP
protocol.

Network Operating System
(NOS) Selection Menu

Refer to this section for a list of additional set up steps that
you might wish to perform.

Recommended Setup Steps

Follow these instructions to install print drivers on your work-
stations.

Print Driver Installation

This section lists available system features and how to set
them up.

Configuring System Features

See this section for information on how to troubleshoot com-
mon issues.

Troubleshooting Tips

A listing of all applicable copyright statements from products
mentioned in this document.

Copyright Statement
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Copyright and Trademark
Declarations

©1998-2014 Xerox Corporation. All rights reserved. Xerox® and Xerox and Design®,
Xerox Nuvera®, FreeFlow®, CentreWare® and VIPP® (Variable-data Intelligent
PostScript Printware) are registered trademarks of Xerox Corporation in the US and/or
other countries.

Microsoft®, Windows®, and Active Directory® are registered trademarks of Microsoft
Corporation. Internet Explorer is a copyright protected program of Microsoft Corporation.

Novell® and NetWare® are registered trademarks of Novell, Inc.

Adobe® and PostScript® are registered trademarks of Adobe Systems Incorporated.
TIFF is a copyright of Adobe Systems Incorporated.

AppleTalk, LaserWriter, and Macintosh are trademarks of Apple Computer, Inc. PCL®
and HP-GL® are registered trademarks of Hewlett-Packard Corporation.

WinZip® is a registered trademark of Nico Mak Computing, Incorporated.

Digi is a trademark of Digi International.

VTAM® is a registered trademark of IBM Corporation. IPDS is a trademark of IBM
Corporation.

Solaris and Java are trademarks of Oracle and/or its affiliates.

Linux® is a registered trademark of Linus Torvalds.

Red Hat® is a registered trademark of Redhat, Inc.

Mandrake and Linux-Mandrake are trademarks of MandrakeSoft.

CUPS is a trademark of Easy Software Products.

EFI® and Fiery® are trademarks of Electronics for Imaging, Inc.
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3
Required Setup Steps

Follow these instructions to assure that your system is correctly communicating over
the network using the TCP/IP protocol (the default protocol for the UNIX operating
system running on this device).
1. Power off and connect the system.
2. Power on and configure the system.
3. Log on as a System Administrator.

Learn more about user types and access rights.

4. Check installed options with the license manager.
a) View licensed options.
b) Enable licensed options.
c) Install licensed options.

5. Set up TCP/IP.

Note
TCP/IP communications must be enabled to support print job submission from
networked workstations using the Web Interface. Dynamic Host Configuration Protocol
(DHCP) is the factory-default TCP/IP addressing method. If you prefer to use Static
IP addressing, be prepared with a valid IP address, Subnet Mask, and Gateway address
(if used).

6. Set up LPD.
7. Enter proxy information into remote services.
8. Log off the system.
9. Reboot the system.

Note
Only reboot the system if prompted to do so.

10. Verify TCP/IP communications with ping.
11. Verify printing over TCP/IP using LPR.
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How to power the system off
1. From the System menu select Shutdown

• Yes - system will complete job processing and shutdown
• Interrupt - system will shutdown immediately without completing job processing
• No - system returns to the UI.

2. Wait for the status window to finish displaying its power down in progress message.
3. Power off any third party peripheral equipment (finishers, for example).

Cable Connection
1. Connect one end of a Category 5 twisted pair cable to the RJ-45 socket located behind

an access panel on the left side of the print station where shown.

Note
This task is typically performed by the Xerox Customer Service Engineer at the time
of initial install. After being plugged into the internal RJ-45 socket, the cable should
be routed out of the arch-shaped cutout in the rear cover of the print station.

2. Connect the opposite end of the cable to a live Ethernet drop.

Related Hints and Tips

If using a Gigabit Ethernet connection, use "AUTO" speed setting in Network Config.
This is the default. If there is no live network connection to this device, the Network
Configuration screen will be grayed out and IP will be disabled.
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Note
Full-Duplex Ethernet can not be forced through Network Configuration. The 10 MB and
100 MB Ethernet settings are for Half-Duplex only. If you can not use Auto for Full-Duplex
settings, then you must manually enable forced Full-Duplex.

How to power the system on
Powering the system on/off
1. Power on any third party peripheral equipment (such as finishers, for example).

Note
Xerox equipment modules do not have power buttons as they are powered on
electronically.

2. Press the on position (labeled I) on the power on/off button, located on the right
front of the print station (to the right of the system's monitor).

Note
As the system starts up, both the MAC address (Network Interface Card's hardware
address) and the Host name will be displayed a few minutes apart on the system's
monitor.

3. Wait for the Xerox FreeFlow® Print Server screen to display and observe the status
window until the window displays Printer Idle and Idle respectively (not InitializingIdle,
or LoadingIdle).

The system will take several minutes to be ready for use.

NIC Speed Setting
Automatic network speed detection and appropriate setting of the network interface
card (NIC) is provided by the system as a factory default setting.

Speed settings can be manually changed at the printer as follows:
1. Select Logon... from the Logon menu.
2. Select System Administrator from the User Name drop-down list box.
3. Enter the System Administrator password (for example, administ).
4. Select OK.
5. Select Network Configuration from the system's Setup menu.
6. Select the Options tab and use the Ethernet Speed drop-down arrow to select your

desired speed.
7. If unknown, leave as Automatic.
8. Select OK to save your settings.
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Logging on as System Administrator
1. At the print station, select Logon... from the Logon menu.
2. Select System Administrator from the User Name drop-down list box.
3. Enter the System Administrator password (for example, administ).

Note
To maintain security, it is recommended that all logon passwords be changed after
the system has been installed. To do this, refer to the Changing Logon Passwords
procedure in the Recommended Set Up Steps section of this guide.

4. Select OK.

General Information on user types and access rights

There are three main user account groups that are allowed access to the system. For
FreeFlow Print Server, the three account groups are Administrators, Operators, and Users.
For each of these user groups there is a built-in user account. Note how the access level
of each group corresponds to the access level in previous (legacy) versions of FreeFlow
Print Server.

Access Level in Previous Free-
Flow Print Server versions

Built-in User AccountGroup

System AdministratorSystem AdministratorAdministrators

Trusted UserOperatorOperators

Walk-up UserUserUsers

The group name of the logged-in user displays in the title bar of the currently active
window on the system's monitor.

The access levels for each of the users are defined as follows:

• The Users group typically has minimum access rights on the system. The allowed
access corresponds to the Walk-up User level in previous DocuSP or FreeFlow Print
Server versions.

• The Operators group has greater access to the system than the Users group. The
allowed access corresponds to the Trusted User level in previous DocuSP or FreeFlow
Print Server versions.

• The Administrators group has full access to all the system functions. This is identical
to the System Administrator access level in previous DocuSP or FreeFlow Print Server
versions.

In addition to the three built-in User Accounts there is a fourth account, named "cse,"
intended for use by the Xerox Customer Service Engineer. This account is a member of
the Administrators group by default.
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Note
When the autologon feature is enabled, users are not required to log on to gain access
to the system. The allowed access, however, corresponds to the privileges of the Users
group. The autologon feature is configurable by a member of the Administrators group
through the Security Profiles menu. Autologon is enabled in the Medium, Low, and None
security profiles. It is disabled in the High security profile.

Related Hints and Tips

Under Users and Groups, the system displays the built-in accounts using friendly names
instead of the actual user names:

Actual user nameFriendly name

userUser

operatorOperator

saSystem Administrator

cseCustomer Service Engineer

Checking Installed Options with License
Manager
Option licensing enables the use of Ethernet, Network Gateways, Page Description
Languages, printing speeds, Remote Services, and capabilities such as variable-data
intelligent PostScript printing (VIPP) and scanning to the network. After initial installation
of the system by a Customer Service Engineer, License Manager is used to control
subsequent viewing, enabling or disabling, and installation of licensed options. To make
certain that your system has the correct options installed to assure successful network
set up, you should check installed system options using License Manager.

Note
Your system will not have certain features or will operate differently depending on what
licenses are enabled or not enabled. The Productivity Pack license is required to enable
features such as multiple queue capability, running LCDS and IPDS jobs and setting up
streaming queues, use of the stock library, and ability to specify the minimum/maximum
nominal paper weight range for the stock that is programmed and loaded. If the
Productivity Pack license is not installed and enabled, the system uses, for example,
default paper weight buckets. Another license, the Enhanced Line Screens license (Image
Quality), enables image quality options such as adjusting halftones and selecting various
line screens.

Viewing Licensed Options
1. Select Logon from the Logon menu.
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2. Select System Administrator from the User Name drop-down list box, enter the
System Administrator password, and select OK.

3. Select Feature Licenses from the Setup menu.
The License Manager window displays the Name, Type, Status, State, and Expiration
Date of all the licensed options installed on your system. Licensed packages of bundled
features may also be displayed as identified by a cascading documents icon. Clicking
the icon displays the package's contents of individual features.

4. To view the properties of any displayed option, select a License Name and select
Properties from the bottom of the window.

Enabling Licensed Options
1. Select the option or license package that you are interested in, and select the

Properties option from the pop-up menu.
2. In the Properties window, select the Activate radio button under the License heading.
3. Select the Enable radio button under the Feature heading. For license packages, if

required, deselect (uncheck) the Maintain Current States box, select Enable All, then
recheck the Maintain Current States box. This checkbox is only available on bundled
license features that contain other license features.

4. Make sure that your selected option is the name displayed under the License Name
heading.

5. The License String box should be filled in with a lengthy string of characters (letters
and numbers). If this is not the case, contact your Xerox representative.

6. Click OK to save your settings.

The individual features of license packages can be enabled or disabled by right-clicking
on the feature line, selecting Properties, then selecting Enable or Disable. Do not
Deactivate an entire license package to disable one feature (such as AppleTalk in the
Ethernet package). If a license is deactivated, the system removes the license string. The
license or feature can not be reactivated by using the Activate button. To reactivate a
license or feature, you must reinstall a valid license.

Installing Licensed Options
1. Contact your Xerox representative to purchase the license or license package for the

option or features that you need.
2. When you receive your license file from Xerox, log on to your system as System

Administrator, then select Feature Licenses... from the Setup menu.
3. Right-click the system mouse anywhere within the License Manager window and

select Load License File.

Note
You can alternatively click the Load License File... button.

4. Use the Select License File window to indicate the location of your new license file
and click OK.

5. Follow any additional instructions that came with the license file to assure a successful
installation.
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Setting Up TCP/IP
1. From the system's Setup menu, select Network Configuration.
2. If it is not already enabled by factory default, click on the Enable IP check box to

enable it with a check mark.
3. DHCP is the TCP/IP addressing method enabled by factory default. When this system

was first powered on, it should have contacted your DHCP server and obtained an IP
Address, Subnet Mask, and Default Gateway address. These items should now be
displayed on screen. If they are not, click Apply to let the system contact your DHCP
server. Otherwise, click on the IP Configuration Method selection arrow to set a static
IP address as stated below.

Note
Do not use IP addresses for this device in the following range: 10.40.101.0 to
10.40.101.255. The printer uses this address range for internal communications.

4. If DHCP addressing was unsuccessful, or is not desired, select Static IP Configuration.
Note that you can alternatively select BOOTP Enabled, if a BOOTP server is available.

5. Select the IP Address tab.
6. In the available text boxes enter in a valid IP Address for this device, the Subnet Mask

for your network, and the Default Gateway address (if used) for your network. Click
Apply or OK to save your settings.

7. In the Hostname box, if you will be communicating with this device over the Internet,
or are using DNS, WINS, or NIS to resolve host names to IP Addresses on your network,
enter in a unique host name for this device.

8. If you will be using DNS for Host name resolution on your network, select the DNS
tab.
a) If it is not already enabled by factory default, click on the Enable DNS check box

to enable it with a check mark.
b) Click on the Enable Dynamic DNS Registration check box if your network uses a

dynamic DNS server to automatically update host name to IP address mapping.
c) In the Domain Name box, type in the domain that this device resides in (for

example, Xerox.com).
d) In the Hostname box, note that this read only name is the same as the unique

host name that was entered on the IP Address tab.
e) In the DNS Server list, provide the IP addresses of up to three DNS servers to search

when resolving host names to IP addresses.
f) In the Domain Search list, provide the names of other domains to search, if needed,

to resolve the host name.
g) Click Apply or OK to save your settings.

9. If you will be using WINS for NetBIOS name resolution on your Microsoft network,
select the WINS tab.
a) Click on the Enable WINS check box to enable it with a check mark.

3-7Xerox® Nuvera®

System Administrator Guide

Required Setup Steps



b) In the two boxes supplied, type in the IP addresses of the Primary and Secondary
(if used) WINS Servers for resolution of NetBIOS names to IP addresses on the
Microsoft network.

c) Click Apply or OK to save your settings.

10. If you will be using NIS to distribute password, group, or host address information
on your UNIX network, select the NIS/NIS+ tab.
a) Click on the Enable Name Service check box to enable it with a check mark.

Note that the NIS+ radio button is enabled by default. If desired, select the NIS
radio button instead.

b) Click on the Find NIS+ Server check box to query the network for the name and
IP address of the Network Information Service server.
If the NIS+ Server is not found, or the Find NIS+ Server check box is left unchecked,
use the supplied boxes to type in the Domain Name, Server IP address, and Server
Name for NIS/NIS+, if known.

c) Click Apply or OK to save your settings.

Related Hints and Tips

Enabling WINS and without specifying a
Primary WINS server will cause the device to
use broadcast mode.

Broadcast mode

You must "shutdown" instead of "reboot" any-
time you perform a Restore Defaults ALL, or IP
defaults only.

Restore Defaults All or IP Defaults Only: Shut-
down instead of reboot

Both NIS and Microsoft ADS provide network
authentication services, one in the UNIX world,
the other in the Windows 2000 and later world.
They cannot be used at the same time. In order
to ensure that the Microsoft ADS authentica-
tion performs correctly, NIS needs to be dis-
abled in the Network Configuration.

ADS and NIS cannot be used at the same time
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The Microsoft ADS authentication feature uses
the Kerberos security protocol. Kerberos authen-
tication mandates that the difference between
the local times on the Nuvera system and the
local time on the domain controller be within
a reasonable range. This range is configurable
at the domain controller and it is 5 minutes by
default. If the time difference is higher than
the configured range, the logon will fail but
there will be no indication that the failure was
caused by the time difference. If an ADS logon
fails for no apparent reason, make sure that
the local system time is synchronized with the
domain controller time (within 5 minutes by
default). The system supports automatic time
synchronization with the ADS domain controller
over NTP (network time protocol), therefore the
lack of synchronization is unlikely to happen.
When it happens, the domain controller not
acting as a reliable NTP time source could have
caused it. Consult the Microsoft documentation
for information on how to configure the domain
controller to act as a reliable NTP time source.

ADS logon failure

The user may change the language of SNMP
Agent/MIB data by changing the localization
setting via the SNMP Gateway configuration
page. This feature is only available if the user
has installed the language pack of their choice
into the FreeFlow Print Server software.

Change the language

Setting Up LPD
1. From the system's Setup menu, select Gateways.
2. Select the LPD tab.
3. If it is not already enabled by factory default, select the Enabled radio button for

Line Printer Daemon (LPD).
4. Select the Enabled radio button for LPD Default Queue.

By enabling the LPD Default queue, the system will process jobs in the default queue
if the queue specified by the user does not exist.

Note
When the LPD Default queue is not enabled, the user must specify the system's
queue. For systems with the Productivity Pack license enabled and that have numerous
internal print queues created in Queue Manager, users must configure the client LPR
ports for a valid print queue in order to send jobs.

5. Leave the LPD Port at its default value of 515.
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Note
LPD listens on port 515 for incoming TCP connections from clients.

6. Click Apply or OK to save your settings.

Entering Proxy Information into Remote
Services
Xerox Remote Print Services offers automated features that increase system productivity
by allowing meter reads, printer status information, and supply orders to be transmitted
directly back to Xerox.

Configure Remote Services with the Proxy Server information. This will automatically
update Internet Browser features with this information when using a Proxy Server to
access the Internet.

Check the status of Remote Services under the System Tab on the Remote Services
screen to validate that you have a valid Remote Services License and that it is enabled.
Once you validate that Remote Services is licensed and enabled, you will need to enter
your HTTP Proxy Server name and HTTP Proxy Port number into the Remote Services
feature of the system at the time that your system is first installed or during network
configuration. Make sure that your proxy server is configured to allow outgoing HTTP
connections.

Note
If you are not using a Proxy Server to access the Internet, leave the Remote Services
Proxy settings blank. However, if left blank, DNS must be enabled on the printer to
support the Remote Services feature. To enable the use of DNS on the printer, refer to
the Setting Up TCP/IP procedure in this section of the System Administrator's Guide. If
you are using a service provider to access the Internet, enter the service provider's DNS
server IP Address in the DNS Server list, when enabling DNS as part of the Setting Up
TCP/IP procedure.

Note
The purpose of this procedure is to enable the printer to send operating data to a secure
server in the support.xerox.com domain using HTTP and the 256-bit encrypted Secure
Socket Layer (SSL). The remote Xerox server is not pulling data from this printer through
the firewall. No image data is being accessed or transmitted.

1. Select Logon... from the Logon menu.
2. Select System Administrator from the User Name drop-down list box, enter the

System Administrator password, and select OK.
3. Select System from the toolbar, and then select Remote Services.
4. From the Options pull-down located at the top, left of the window, select Configure

Remote Services....
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5. Enter the required information in the HTTP Proxy Server and HTTP Proxy Port
(number) fields.

6. If client Proxy authentication is required, enter the required information in the Proxy
Username and Proxy Password fields.

7. Select OK, then Close.

The main FreeFlow Print Server window will be displayed. The Remote Services software
will initialize. A window will display automatically while attempting to synchronize with
Xerox.

Troubleshooting steps

If synchronization fails, you may also try to perform a manual synchronization to make
sure that the printer can communicate with the Xerox server. If it fails again, check the
following:

• Ensure that the network is operating correctly, check network connectivity settings
• Ensure that the proxy settings that you placed into the device correct and that your

Proxy server is configured to allow a client access to the Internet. You must call your
Systems Administrator to verify that the device is configured properly. Performing a
manual synchronization will confirm that the proxy information that was entered is
correct, and that DNS does not need to be enabled on the printer for it to
communicate with Xerox.

• If the device can perform a successful synchronization with Xerox, then your
connectivity settings are entered correctly. The system will display the enabled Remote
Services features on the main Remote Services window. If the Remote Monitoring
and Machine Data Transfer services are not displayed on the main window under
Services, and you can synchronize successfully with Xerox, then one of two things has
taken place:

• At the time the machine was ordered, Remote Services features were not ordered,
and therefore the Xerox server will not allow the machine to transmit data (allow the
services to be enabled on the machine); in this case you must contact your Xerox
sales person so that an order for Remote Services can be placed thru the Xerox sales
and support personnel to have the server enabled for your machine's serial number.

• Or, the machines entire software was reloaded, in which case the machine will need
up to 1 hour to restore its services. Try again in 1 hour.

Note
If the machine is rebooted for any reason, Remote Services are the last piece of software
to startup after the machine has come up. You may have to wait up to 10 minutes after
the system is up for the services to appear on the Remote Services window, or for the
Submit Data button to be available to send data to Xerox.
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Logging off
To log off the system at any time, select Logoff from the Logon menu of FreeFlow Print
Server (displayed on the print station's monitor).

Rebooting the system (if prompted)
If you were prompted to reboot the system to enable changes made to network
communication settings, perform the following procedure.
1. Power off the system
2. Wait for the status window to finish displaying its power down in progress message.
3. Power on the system.
4. Wait for the FreeFlow Print Server screen to display and observe the status window

until the window displays Printer Idle and Idle respectively.

The system will take several minutes to be ready for use.

How to power the system off
1. From the System menu select Shutdown

• Yes - system will complete job processing and shutdown
• Interrupt - system will shutdown immediately without completing job processing
• No - system returns to the UI.

2. Wait for the status window to finish displaying its power down in progress message.
3. Power off any third party peripheral equipment (finishers, for example).

How to power the system on
Powering the system on/off
1. Power on any third party peripheral equipment (such as finishers, for example).

Note
Xerox equipment modules do not have power buttons as they are powered on
electronically.

2. Press the on position (labeled I) on the power on/off button, located on the right
front of the print station (to the right of the system's monitor).

Note
As the system starts up, both the MAC address (Network Interface Card's hardware
address) and the Host name will be displayed a few minutes apart on the system's
monitor.
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3. Wait for the Xerox FreeFlow® Print Server screen to display and observe the status
window until the window displays Printer Idle and Idle respectively (not InitializingIdle,
or LoadingIdle).

The system will take several minutes to be ready for use.

Verifying TCP/IP Communications with
Ping
From the Command (DOS) prompt of any Windows workstation, or the command line
of the terminal window in UNIX/Linux, type: ping xxx.xxx.xxx.xxx and press Enter. Note
that there is a space between the word ping and the first xxx. Let xxx.xxx.xxx.xxx represent
the IP address of the system as configured in the Setting Up TCP/IP instructions in this
guide.

If communications have been successfully set up, you will receive a reply such as: "Reply
from xxx.xxx.xxx.xxx: bytes=32 time<10ms TTL=128."

If you receive "Cannot connect to host," "Time Out," or "0 bytes received" notifications,
perform the following checks:

• Confirm that the target device is powered on, fully booted, and that it is connected
to the network. Look for network traffic light activity on the NIC.

• Verify that you entered the correct IP address for the target device in the ping
command. If necessary, go to the device, log on as Administrator, select Configuration
from the Setup menu and note the IP address displayed.

• Verify that the workstation and the target device are on the same subnet.

Verifying Printing over TCP/IP using LPR
Make sure to separate all individual elements of the command with a space.

• From a networked workstation running a print utility (spooler) that enables LPR jobs
to be sent to the printer, at the Command (DOS) prompt, type:
a) lpr -P raw -S xxx.xxx.xxx.xxx C:\filename.ext
b) Press Enter.

Note
Individual elements of the command must be separated with a space. Let xxx
represent the IP address of the system as configured in the Setting Up TCP/IP
instructions in this guide. Filename represents any test file supported by the device
and ext is the file's extension (such as .txt for a text file created in Notepad). The file
can be sent from any drive letter supported on the workstation (such as C:\ or A:\).
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• Alternatively, from the system prompt ($ or %) in UNIX, to print your host table (as
an example), type the following command:
a) /usr/ucb/lpr -P13.175.108.208:dinodoc /etc/hosts
b) Press Enter.

Note
In the example above, 13.175.108.208 is the IP address of the printer, dinodoc is the
name of the printer's queue, /etc/ is the path, and hosts is the file to be printed.

• Another acceptable method to use for printing from UNIX is the following:
a) lp -d13.175.108.208:dinodoc /etc/hosts
b) Press Enter.

• Another acceptable method to use for printing from Linux, is the following:
a) lpr -P localqueuename /path/filename
b) Press Enter. (Use your Printing Manager to create the local queue)

If TCP/IP and the Line Printer Daemon are correctly set up and functioning, the test file
should print out on the system.
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4
Recommended Setup Steps

This section contains a list of additional setup information.

• Enable Hyper Text Transfer Protocol (HTTP) to print from remote workstations using
a web interface.

- Verify that the HTTP gateway license is present.

- Verify that the HTTP gateway is enabled.

- Verify that the HTTP gateway is working.

• Install FreeFlow Remote Print Server software on a workstation.

- Read an overview of the remote workflow software.

- Find software installation and operating instructions.

- Configure the system to enable communications.

• Set passwords and system security.

- Tips on how to maintain a secure system and how to change login passwords.

- Change an individual password.

- Change passwords as an administrator.

- Let FreeFlow ensure passwords are as secure as possible.

- Set the number of times a user can attempt to login.

- Track the date and time information of user logins and logouts.

• Manage user access to the system.

• Configure Simple Network Management Protocol (SNMP) to monitor and diagnose
printer performance over the network.

- Learn about SNMP.

- Access the SNMP settings.

- Enable SNMP.
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- Configure SNMP community strings.

- View and configure SNMP serial numbers.

- Configure common settings.

- Set or edit trap parameters.

- Save your settings and exit the SNMP gateway.

• Select and create security profiles that control access to the system.

- Access the security profiles.

- Change the current profile.

- Set a default profile.

- Set the default profile as the current profile.

- View security profile properties.

- Copy and create new profiles.

Note
Additional information is available explaining the four tabs of the Security Profile
Properties window: General, System, RC2 & RC3 (INIT), and INETD.

Enabling HTTP
The Hyper Text Transport Protocol (HTTP) Gateway provides bi-directional communication
and enables the submission of print-ready files over the web from remote workstations
using a web interface.

Verify that the HTTP Gateway License is present

Refer to the Checking Installed Licenses with License Manager procedure in the Required
Steps section of this guide to verify that the HTTP Gateway License is present and
enabled. To view the HTTP Gateway selection line, click the turner (key style) graphic
preceding the Ethernet Network license package displayed in the License Manager
window.

Verify that the HTTP Gateway is enabled
1. Select Logon from the Logon menu.
2. Select System Administrator as the user access level from the User Name drop-down

list box.
3. Enter the System Administrator password (administ, for example) and click OK.
4. From the system Setup menu, select Gateways.
5. Select the HTTP tab.
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6. Verify that a check mark is displayed within the Enable HTTP checkbox.

If the HTTP Gateway License is not enabled in License Manager, the Enable HTTP
checkbox is disabled also.

7. If necessary, place a checkmark within the Enable HTTP checkbox. The checkbox in
License Manager will be updated and enabled also.

8. Click OK or Apply to save your settings, or Cancel to close the window without making
any changes.

9. Select Logoff from the Logon menu to log off.

Verify that the HTTP Gateway is working
1. At a network-connected workstation, start a web browser program.
2. In the browser's address field, enter the IP address of the printer.
3. Press Enter.

• If the HTTP Gateway is working, the printer's home page should be displayed on
your monitor.

• If the home page is not displayed, check your browser's connection settings to
make sure that you are not using a proxy server to connect to local area network
addresses. Retry the above procedure.

• If the home page fails to display, go to the printer and verify that the HTTP
Gateway is enabled as described above.

Installing Remote Workflow Software
The FreeFlow Print Server Remote Workflow software can be loaded on networked
workstations, running a variety of operating systems, allowing remote access to the
system's FreeFlow Print Server running version 4.00.00 or higher software.

After installing the FreeFlow Print Server Remote Workflow software, the FreeFlow Print
Server user interface can be displayed on the workstation, providing the System
Administrator the ability to remotely access the system for administrative functions.

Software Installation and Operating Instructions

Software installation and operating instructions are included in the Remote Workflow
software package.

Refer to the Xerox® Nuvera Remote Services Configuration Guide for additional
information about Remote Services.
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Configuring the system to enable communications
In order to remotely access the FreeFlow Print Server, the Enable All Connections radio
button must be enabled on the Remote Workflow tab of the System Preferences selection
of the Setup menu. To verify or enable this setting, perform the following steps:
1. Log on to the system by selecting Logon from the Logon menu.
2. Select System Administrator as the user from the User Name drop-down list box.
3. Enter the System Administrator password (administ, for example) and click OK.
4. From the system's Setup menu, select System Preferences.
5. Select the Remote Workflow tab.
6. Make sure that the Enable All Connections radio button is selected (enabled) or

configure specific connections using the Enable Specified Connections radio button.
7. Click OK or Apply to save the setting. To exit the window without making changes,

click Cancel.

Changing Passwords
To maintain system security, the logon passwords for the System Administrator and
Operator accounts should be changed immediately after system installation. At regular
intervals thereafter, the logon passwords for all users should be reviewed and changed
as deemed necessary.

Stricter security can be provided by using Strong Passwords, controlling Login Attempts,
setting Password Expiration and Login Tracking.

There are two ways to change logon passwords.

• Users can change their own passwords using the Change Password selection of the
Logon menu.

• Administrators can change the password of any user using the Users & Groups
selection of the Setup menu.

Individual Password Changing
1. Log on to the system from the Logon selection of the Logon menu.
2. Select Change Password from the Logon menu.
3. Type the current password in the Old Password field.

Characters appear as asterisks when typed

4. Type the new password in the New Password field.
Passwords consist of one to eight alphanumeric characters, and appear as asterisks
when typed. A carriage return at the end of the string has no effect.

5. Retype the new password in the second New Password field to verify typing and
spelling.
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6. Select OK to enter the new password.

An error dialog will be displayed if any entry is not valid.

Password Changing by an Administrator
1. Select Logon from the Logon menu.
2. Select System Administrator as the user from the User Name drop-down list box.
3. Enter the System Administrator password (administ, for example) and click OK.
4. Select Users & Groups... from the Setup menu.
5. Select the Users tab and double click on the user for which the password is being

changed.
6. Select (put a check mark in) the Change Password check box.
7. Type the new password in the Password field.
8. Type the new password in the Re-Type Password field.
9. Click OK or Apply to save your settings.

Strong Passwords
Strong passwords provide a more secure level of login protection. To enable strong
passwords:
1. The root (su) user must run the setstrongsecurity script located in the /opt/XRXnps/bin

directory.
2. The System Administrator must apply Strong Password Checking under Users &

Groups Management > Password Policy.

When enabled new users will be forced to have a strong password assigned to their
account. Passwords for existing users will remain the same and will continue to work as
before, but can be updated if necessary.

A strong password must:

• Be a minimum of eight characters in length

• Contain at least one capital letter

• Contain at least one number

• Contain at least one special character { !, @, #, $, %, ^, &, * }, including open and
closed parentheses { ( ) }, hyphen { - }, underscore { _ }, and period { . }

Login Attempts
The System Administrator can set the number of login attempts from 0 through 6. To
enable login attempts:
1. The root (su) user must run the setstrongsecurity script located in the /opt/XRXnps/bin

directory.
2. The System Administrator must enable Login Attempts Allowed and the number of

attempts, under Users & Groups Management > Password Policy.
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Password Expiration

The System Administrator can set the password expiration dates.

Although FreeFlow Print Server does not provide a System Administrator to set a password
expiration date on user accounts, there are a number of ways this can be done.

• Set via the command line
• Set via Admintool
• To set MINWEEKS and MAXWEEKS, edit the passwrd file in the /et/default directory.

Solaris sets the values to null by default.

The FreeFlow Print Server UI does not provide an interface for password expiration.
Thus, FreeFlow Print Server will not prompt the user to enter a new password if it has
expired. Instead, a message is posted indicating unknown user name or password. It is
up to the customer to determine that the password has expired. To do so, they need to
open a terminal window and attempt to login. If the password has expired, the system
will prompt for the user to enter a new password.

System Logging Capacity

Log of date/Time users Login/Logout

This information is kept in the authlog and syslog in the /var/log directory. Login/Logout
through FreeFlow Print Server is tracked as well as Network Login/Logout.

Managing User access to the system
User access to the system is managed through the m selection of the Setup menu.
1. Select Logon from the Logon menu.
2. Select System Administrator as the user from the User Name drop-down list box.
3. Enter the System Administrator password (administ, for example) and click OK.
4. Select Users & Groups... from the Setup menu.
5. Select the Users tab.
6. Right-click on any user name, or on a blank portion of the Users & Groups Management

window.
7. From the pop-up menu, select New..., Edit..., Delete, Enable, or Disable, depending

upon the parameters you wish to set.
For example, by selecting New..., you can add a new user, set up the user's password,
and enable the new user to be a member of one of the three user account groups
that are allowed access to the system. These groups are Administrators, Operators,
and Users.

8. Click OK or Apply to save your settings.
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About SNMP
SNMP (Simple Network Management Protocol) provides a method to remotely monitor
and diagnose printer performance over the network. Once SNMP has been enabled at
the printer, SNMP Manager software, running on a network-connected workstation, polls
the printer's SNMP Agent for operating information and receives traps from the Agent
regarding the occurrence of specific events. Examples of such events might be an alert
that one or more of the printer's trays is out of paper, or that the printer is low on toner.

Examples of typical SNMP Manager software include:

• IBM Network Printer Manager
• Novell Managewise
• TNG Unicenter
• HP OpenView
• Xerox CentreWare Web

Configuring SNMP
1. Select Logon from the system's Logon menu.
2. Select System Administrator as the user from the User Name drop-down list box.
3. Enter the System Administrator password (administ, for example) and click OK.
4. From the system's Setup menu, select Gateways.
5. Select the SNMP tab.

Accessing SNMP Settings
1. Select Logon... from the system’s Logon menu.
2. Select System Administrator as the user from the User Name drop-down list box.
3. Enter the System Administrator password (administ, for example) and click OK.
4. From the system’s Setup menu, select Gateways.
5. Select the SNMP tab.

Enabling SNMP
1. Verify that the Enabled check box is checked. If it is not, use the system's mouse to

place a check mark within the box to enable SNMP.
2. Place a check mark in the Enable Authentication Traps check box if you would like

to receive notification of authentication events at the device.
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Configuring SNMP Community Strings
1. Accept the default name or type a new name in the text box for Read Community

String.
This is the password for SNMP Get requests issued by the SNMP Manager to the
Agent.

2. Accept the default name or type a new name in the text box for Write Community
String.
This is the password for SNMP Set requests issued by the SNMP Manager to the
Agent.

Caution
If you change the Read (Get) and Write (Set) Community Strings, you must also
change the strings used by all network applications communicating by SNMP with
this Agent.

3. Accept the default name or type a new name in the text box for Trap Community
String.
This is the password for SNMP Traps sent by the Agent to the SNMP Manager.

Configuring or Viewing SNMP Serial Numbers
The status of components can be reported by serial numbers. Components with serial
numbers include feeders, trays, and stackers. To configure or view component serial
numbers:
1. Click the SNMP Serial Numbers button.
2. Where allowed, such as in the case of trays, type the serial numbers of the listed

components into the text boxes supplied.

Note
The serial numbers for feeders and stackers are supplied by the system and can only
be viewed.

3. Click OK to accept your entries, or Cancel to close the window without enabling any
changes.

Configuring Common Settings
Common Settings available for display to the SNMP Manager include: System
Administrator Name/Phone/Location, Operator Name/Phone/Location, Printer Name
and Printer Location. Additional settings are supplied for configuring the display of
information for Xerox Online Service and Support and Customer Online Links.
1. Click the Common Settings button.
2. Type the applicable information into the available text boxes.

For help with definitions of the various settings, click the Help button.

3. Click OK to save your settings.
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Setting or Editing Trap Parameters
1. Double click on any numbered horizontal line in the Traps table.
2. In the boxes supplied, type in the IP address of the workstation (Client) which is

running the SNMP Manager program.
3. In the Port Number box, if 162 is not already displayed, type 162 (for the port number

of the Client workstation that will be receiving UDP datagrams from the device's
SNMP Agent).

4. Under the Traps heading, use the system mouse to place a check mark in the available
boxes for the type of Traps you wish to send to the Manager.
For example, check the Warm Start box for traps regarding system reboots. Check
the Cold Start box for traps regarding the powering on of shut down systems.

5. Under the Trap SNMP Version heading, use the drop-down selection menu to select
the SNMP version supported by your SNMP Manager.

Note
The Xerox Common Management Interface (XCMI) used by this system supports
both SNMP versions 1 and 2c.

6. Click OK or Apply to save your settings.
7. Click either the Previous Trap or Next Trap selection arrow to set or edit the parameters

for other numbered lines in the Traps table.

Saving Settings and Exiting the SNMP Gateway
1. Click OK at the bottom of the SNMP tab to save your settings. You may be prompted

to Reboot the system to enable your settings.
2. If prompted to Reboot the system, log off by selecting Logoff from the Logon menu.
3. Follow the instructions for Rebooting the System in the Required, Initial Set Up Steps

section of this guide.

About Security Profiles
Security Profiles are collections of configurable settings that can be used to deny or
restrict the access to various device and operating system services.

Four Security Profiles (None, Low, Medium, and High) are factory supplied and are always
available for selection as the Current profile controlling system access. Although these
factory-supplied profiles cannot be edited or deleted, they can be copied allowing new
profiles to be created, edited, and selected by the System Administrator for use as the
Current Security Profile.
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Whenever a different profile is selected to be the Current profile, this selection remains
in effect until a new profile is chosen. One profile is also designated as the Default profile.
This Default profile can be selected as the Current profile by clicking the Restore Default
Profile button.

Accessing Security Profiles
1. Select Logon... from the system’s Logon menu.
2. Select System Administrator as the user from the User Name drop-down list box, or

type in a different user name that belongs to the System Administrator's group.
3. Enter the appropriate password and select OK.
4. From the system's Setup menu select Security Profiles... to display the Security

Profiles window.

Changing the Current Profile
1. Select a Profile Name in the Security Profiles window using the system mouse.
2. Right-click the mouse on the highlighted table row corresponding to the selected

Profile Name.
3. From the pop-up menu, select Set as Current.
4. When prompted to proceed to apply the new security profile, click Yes.

This operation will take several minutes to complete.

Making a Security Profile the Default Profile
1. Select a Profile Name in the Security Profiles window using the system mouse.
2. Right-click the mouse on the selected Profile Name.
3. From the pop-up menu, select Set as Default.

Selecting the Default Profile to be the Current Profile
1. Using the system mouse, click the Restore Default Profile button in the Security

Profiles window.
2. When prompted to proceed to apply the new security profile, click < Yes>.

This operation will take several minutes to complete.

Viewing Profile Properties
1. Select a Profile Name in the Security Profiles window using the system mouse.
2. Right-click the mouse on the selected Profile Name.
3. From the pop-up menu, select Properties.

When the Properties window displays, note that for the four system-supplied Security
Profiles, the properties are viewable but not editable. To create editable, User Defined
profiles, follow the steps for Copying Profiles and Creating New Profiles.
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Copying Profiles and Creating New Profiles
1. Select a Profile Name in the Security Profiles window using the system mouse.
2. Right-click the mouse on the selected Profile Name.
3. From the pop-up menu, select Copy.
4. Type a unique name for this new profile in the Name box.

The Type box for this profile is set to User Defined.

5. Click on any of the four tabs of the Properties window to edit available parameters.
Select the Help button of the Properties window for help with configuring specific
parameters. For additional explanations of the parameters available on the four
Properties window tabs, click on the General, System, RC2 & RC3 (INIT), and INETD
hyperlinks below.

6. Click OK to save your settings.

Tabs of the Security Profile Properties window

For additional explanations of the parameters available on the four Properties window
tabs, click on the hyperlinks below.

• General tab
• System tab
• INIT (Rc2 & RC3) tab
• Services
• RPC

General Tab (Security Profile Properties window)

The following parameters are available for configuration.

Apply Settings After Every Reboot

This setting determines whether the current security profile is reapplied each time the
device boots up. If changes were made to the system configuration through means
other than the security profiles (for example, by manually editing system files at a
terminal window), these changes will be overridden at the next reboot. Leave this setting
enabled (with a check mark in the box) unless you want to speed up the boot-up process.

Automatic Logon

Use this checkbox to enable or disable the ability of users to use the system, including
Web UI (HTTP) access to the system, without having to manually log on. When enabled
(with a check mark in the box), a system account (User by default) must be specified
from the User Name drop-down selection box. When Automatic Logon is disabled (by
default in high profiles), all system features, except for a logon window, will be
inaccessible, requiring users to manually log on to the system prior to its use.
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Logon Message and Setup button

If the Automatic Logon checkbox is disabled (unchecked), use the Setup... button to
select, edit, or create a message to be displayed to system users from the logon window.

Limit Reprint Manager Paths

When this setting is enabled (with a check mark in the box), the system restricts walk-up
(automatic logon) user access to the reprinting of files from the paths specified in the
entry box. This prevents unlimited reprinting of all of the available files on the system.
Click the Setup... button to select the allowed directory.

Minimum Password Length

Use the up or down arrows of the Minimum Password Length box to set the minimum
number of characters for a valid system user password. Note that the minimum
password length will be enforced when users change their own passwords from the
Logon menu.

General Services Table, Unix Terminal Authentication

When available and set to enabled, this setting requires users to re-authenticate upon
opening the Unix Terminal window. To change the setting, use the system mouse to
right-click on the Unix Terminal Authentication line and select Disable from the pop-up
menu.

General Services Table, Cleanup Menus

When available and set to enabled, the desktop displayed on the system's monitor will
show a limited number of menu items and there will be no terminal window access to
the underlying UNIX (Solaris) operating system. When set to disabled, the logged on
user will see a set of menu selections similar to that of DocuSP 3, with terminal window
access available. To change the setting, use the system mouse to right-click on the
Cleanup Menus line and select Disable or Enable from the pop-up menu.

System Tab (Security Profile Properties window)

The following parameters are available for configuration on the System tab.

Disable Cache

By default, the Cache function is disabled in all Security Profiles for passwd, group,
exec_attr, prof_attr, and user_attr. Disabling passwd and group cache is especially
important for securing password and group information in the older NIS, versus the
newer NIS+, environment. This is not a visible (selectable) setting.

Cron Allow and Cron Allow Username

This setting specifies the default UNIX user (root) permitted to schedule the running
of processes on the system. This is not a visible (selectable) setting.
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Users Deleted

The nuucp and listen accounts are deleted in all Security Profiles by default. As the
nuucp account and listen port monitor can be used to set up files and transfer them
over the network, this login and port monitor pose a security risk. This is not a visible
(selectable) setting.

Users Locked

The passwords for the following UNIX system accounts are locked in all Security Profiles
by default: daemon, bin, sys, adm, lp, uucp, nobody, noaccess, and nobody4. xrxusr is
locked in the NP high and medium profiles. This is not a visible (selectable) setting.

Additional System Services Settings

The following default settings are applied to the additional services shown below. Note
that these settings can be changed (if visible on screen for selection) within a
User-Defined (copy) Profile. Use the system mouse to right-click on an available service
line, then select your setting from the pop-up menu.

CommentDefault SettingService

Visible setting on systems with
Productivity Pack license en-
abled. True under None profile.

DisabledAllow_host.equiv_plus

Not a visible setting.DisabledMulticast routing

Not a visible setting.EnabledHide OS and host information
(Info banners)

Visible setting on systems with
or without Productivity Pack li-
cense enabled. False under
None profile.

EnabledSecurity Warning Banners

Visible setting on systems with
Productivity Pack license en-
abled. False under None profile.

EnabledSecure Sendmail

Visible setting on systems with
Productivity Pack license en-
abled. Enabled under None
profile.

DisabledExecutable Stacks

Visible setting on systems with
Productivity Pack license en-
abled. Enabled under None
profile.

DisabledRemote CDE logins

Not a visible setting.TrueSecure network parameters

Not a visible setting.EnabledRestrict the NFS port monitor

Not a visible setting.EnabledAnonymous ftp
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CommentDefault SettingService

Visible setting on systems with
Productivity Pack license en-
abled. Enabled under None
profile.

EnabledRouter

Visible setting on systems with
or without Productivity Pack li-
cense enabled.

Enabled in High, Medium pro-
files. Disabled in Low, None
profiles.

bsm

INIT (RC2 & RC3 Services)

This tab contains system wide services that, if visible on screen, can be enabled or disabled
in a User Defined (copy) Profile. When visible, right-click the system mouse on an available
service line, then select your setting. Default settings for the four System-Supplied Profiles
(High, Medium, Low and None) are shown in the tables below.

Table 1. RC2 table

StatusDefault SettingFunctionRC2.d Service

disabledHighClass II logical link control
driver

S40LLC2

disabledMedium

disabledLow (without Productiv-
ity Pack license)

disabledLow (with Productivity
Pack license)

enabledNone (without Productiv-
ity Pack license)

enabledNone (with Productivity
Pack license)

disabledHighAsynchronous PPP link man-
ager

PPPD

disabledMedium

disabledLow (without Productiv-
ity Pack license)

disabledLow (with Productivity
Pack license)

enabledNone (without Productiv-
ity Pack license)

enabledNone (with Productivity
Pack license)
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StatusDefault SettingFunctionRC2.d Service

disabledHighUUCP serveruucp

disabledMedium

disabledLow (without Productiv-
ity Pack license)

disabledLow (with Productivity
Pack license)

enabledNone (without Productiv-
ity Pack license)

enabledNone (with Productivity
Pack license)

disabledHighLDAP daemon to cache server
and client information for NIS
lookups

1ldap.client

disabledMedium

disabledLow (without Productiv-
ity Pack license)

disabledLow (with Productivity
Pack license)

disabledNone (without Productiv-
ity Pack license)

disabledNone (with Productivity
Pack license)

disabledHighScript executed during stub
JumpStart or /AUTOINSTALL
JumpStart

S72AUTOIN-
STALL

disabledMedium

disabledLow (without Productiv-
ity Pack license)

disabledLow (with Productivity
Pack license)

enabledNone (without Productiv-
ity Pack license)

enabledNone (with Productivity
Pack license)

4-15Xerox® Nuvera®

System Administrator Guide

Recommended Setup Steps



StatusDefault SettingFunctionRC2.d Service

disabledHighService Location Protocol dae-
mon

slp

disabledMedium

disabledLow (without Productiv-
ity Pack license)

disabledLow (with Productivity
Pack license)

enabledNone (without Productiv-
ity Pack license)

enabledNone (with Productivity
Pack license)

disabledHighnfs.client

disabledMedium

enabledLow (without Productiv-
ity Pack license)

enabledLow (with Productivity
Pack license)

enabledNone (without Productiv-
ity Pack license)

enabledNone (with Productivity
Pack license)

disabledHighautofs

disabledMedium

enabledLow (without Productiv-
ity Pack license)

enabledLow (with Productivity
Pack license)

enabledNone (without Productiv-
ity Pack license)

enabledNone (with Productivity
Pack license)
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StatusDefault SettingFunctionRC2.d Service

disabledHighsendmail

disabledMedium

disabledLow (without Productiv-
ity Pack license)

disabledLow (with Productivity
Pack license)

enabledNone (without Productiv-
ity Pack license)

enabledNone (with Productivity
Pack license)

disabledHighCIM Boot Manager: disables
WBEM clients from accessing
FreeFlow Print Server server.

S90WBEM

disabledMedium

disabledLow (without Productiv-
ity Pack license)

disabledLow (with Productivity
Pack license)

enabledNone (without Productiv-
ity Pack license)

enabledNone (with Productivity
Pack license)

enabledHighserverS25openssh.serv-
er

enabledMedium

enabledLow (without Productiv-
ity Pack license)

enabledLow (with Productivity
Pack license)

enabledNone (without Productiv-
ity Pack license)

enabledNone (with Productivity
Pack license)
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StatusDefault SettingFunctionRC2.d Service

disabledHighdaemonS73cachefs.dae-
mon

disabledMedium

disabledLow (without Productiv-
ity Pack license)

disabledLow (with Productivity
Pack license)

enabledNone (without Productiv-
ity Pack license)

enabledNone (with Productivity
Pack license)

Table 2. RC3 table

Default SettingFunctionFunctionRC3.d Service

disabledHighNFS Server. Disable ability to
export to FreeFlow Print Server
file systems. Enabled if Free-
Flow and Decomp Services are
enabled.

nfs.server

enabled with PP
license

Medium

enabledLow (without Productiv-
ity Pack license)

enabledLow (with Productivity
Pack license)

enabledNone (without Productiv-
ity Pack license)

enabledNone (with Productivity
Pack license)

disabledHighDisables Sun Solstice Enter-
prise Master Agent. FreeFlow
Print Server SNMP services are
not affected.

S76SNMPDX

disabledMedium

disabledLow (without Productiv-
ity Pack license)

disabledLow (with Productivity
Pack license)

disabledNone (without Productiv-
ity Pack license)

disabledNone (with Productivity
Pack license)
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Default SettingFunctionFunctionRC3.d Service

disabledHighSun Solstice DMI Service Pro-
vider

S77DMI

disabledMedium

disabledLow (without Productiv-
ity Pack license)

disabledLow (with Productivity
Pack license)

disabledNone (without Productiv-
ity Pack license)

disabledNone (with Productivity
Pack license)

enabledHighS92volmgt

enabledMedium

enabledLow (without Productiv-
ity Pack license)

enabledLow (with Productivity
Pack license)

enabledNone (without Productiv-
ity Pack license)

enabledNone (with Productivity
Pack license)

Services Tab

This tab, named for the Internet Daemon, contains the daemons for all the services in
the system's Internet environment. If visible on screen, individual daemons can be
enabled or disabled in a User Defined (copy) Profile. When visible, right-click the system
mouse on an available service line, then select your setting. Default settings for the four
System-Supplied Profiles (High, Medium, Low and None) are shown in the table below.

Security Settings for Internet Services found in the /etc/inetd file
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StatusDefault SettingFunctionService

disabledHighFile transfer protocol server.
This does not prevent use of
ftp from the FreeFlow Print
Server to another host running
FTP server.

ftp

enabled with PP
license

Medium

enabledLow (without Productiv-
ity Pack license)

enabledLow (with Productivity
Pack license)

enabledNone (without Productiv-
ity Pack license)

enabledNone (with Productivity
Pack license)

disabledHighDARPA Telnet protocol servertelnet

disabledMedium

disabledLow (without Productiv-
ity Pack license)

disabledLow (with Productivity
Pack license)

enabledNone (without Productiv-
ity Pack license)

enabledNone (with Productivity
Pack license)

disabledHighshell

disabledMedium

disabledLow (without Productiv-
ity Pack license)

disabledLow (with Productivity
Pack license)

enabledNone (without Productiv-
ity Pack license)

enabledNone (with Productivity
Pack license)
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StatusDefault SettingFunctionService

disabledHighObsolete IEN-116 name ser-
vice

name

disabledMedium

disabledLow (without Productiv-
ity Pack license)

disabledLow (with Productivity
Pack license)

enabledNone (without Productiv-
ity Pack license)

enabledNone (with Productivity
Pack license)

disabledHighRemote login server. Used by
rlogin command.

login

disabledMedium

disabledLow (without Productiv-
ity Pack license)

disabledLow (with Productivity
Pack license)

enabledNone (without Productiv-
ity Pack license)

enabledNone (with Productivity
Pack license)

disabledHighRemote execution server. Used
by rexec command.

exec

disabledMedium

disabledLow (without Productiv-
ity Pack license)

disabledLow (with Productivity
Pack license)

enabledNone (without Productiv-
ity Pack license)

enabledNone (with Productivity
Pack license)
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StatusDefault SettingFunctionService

disabledHighBiff server - mail notification
daemon

comsat

disabledMedium

disabledLow (without Productiv-
ity Pack license)

disabledLow (with Productivity
Pack license)

enabledNone (without Productiv-
ity Pack license)

enabledNone (with Productivity
Pack license)

disabledHighServer talk programtalk

disabledMedium

disabledLow (without Productiv-
ity Pack license)

disabledLow (with Productivity
Pack license)

enabledNone (without Productiv-
ity Pack license)

enabledNone (with Productivity
Pack license)

disabledHighUsed by uucp over IPuucp

disabledMedium

disabledLow (without Productiv-
ity Pack license)

disabledLow (with Productivity
Pack license)

enabledNone (without Productiv-
ity Pack license)

enabledNone (with Productivity
Pack license)
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StatusDefault SettingFunctionService

disabledHighRemote user information serv-
er

finger

disabledMedium

disabledLow (without Productiv-
ity Pack license)

disabledLow (with Productivity
Pack license)

enabledNone (without Productiv-
ity Pack license)

enabledNone (with Productivity
Pack license)

disabledHighOutdated time servicetime.dgram

disabledMedium

disabledLow (without Productiv-
ity Pack license)

disabledLow (with Productivity
Pack license)

enabledNone (without Productiv-
ity Pack license)

enabledNone (with Productivity
Pack license)

HighOutdated time servicetime.stream

Medium

disabledLow (without Productiv-
ity Pack license)

disabledLow (with Productivity
Pack license)

enabledNone (without Productiv-
ity Pack license)

enabledNone (with Productivity
Pack license)
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StatusDefault SettingFunctionService

disabledHighEchoes back characters sent to
it.

echo.dgram

disabledMedium

disabledLow (without Productiv-
ity Pack license)

disabledLow (with Productivity
Pack license)

enabledNone (without Productiv-
ity Pack license)

enabledNone (with Productivity
Pack license)

disabledHighEchoes back characters sent to
it.

echo.stream

disabledMedium

disabledLow (without Productiv-
ity Pack license)

disabledLow (with Productivity
Pack license)

enabledNone (without Productiv-
ity Pack license)

enabledNone (with Productivity
Pack license)

disabledHighDiscards everything sent to it.discard.dgram

disabledMedium

disabledLow (without Productiv-
ity Pack license)

disabledLow (with Productivity
Pack license)

enabledNone (without Productiv-
ity Pack license)

enabledNone (with Productivity
Pack license)
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StatusDefault SettingFunctionService

disabledHighDiscards everything sent to it.discard.stream

disabledMedium

disabledLow (without Productiv-
ity Pack license)

disabledLow (with Productivity
Pack license)

enabledNone (without Productiv-
ity Pack license)

enabledNone (with Productivity
Pack license)

disabledHighDisplays the date and time.daytime.dgram

disabledMedium

disabledLow (without Productiv-
ity Pack license)

disabledLow (with Productivity
Pack license)

enabledNone (without Productiv-
ity Pack license)

enabledNone (with Productivity
Pack license)

disabledHighDisplays the date and time.daytime.stream

disabledMedium

disabledLow (without Productiv-
ity Pack license)

disabledLow (with Productivity
Pack license)

enabledNone (without Productiv-
ity Pack license)

enabledNone (with Productivity
Pack license)
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StatusDefault SettingFunctionService

disabledHighSends revolving pattern of AS-
CII characters.

chargen.dgram

disabledMedium

disabledLow (without Productiv-
ity Pack license)

disabledLow (with Productivity
Pack license)

enabledNone (without Productiv-
ity Pack license)

enabledNone (with Productivity
Pack license)

disabledHighSends revolving pattern of AS-
CII characters.

chargen.stream

disabledMedium

disabledLow (without Productiv-
ity Pack license)

disabledLow (with Productivity
Pack license)

enabledNone (without Productiv-
ity Pack license)

enabledNone (with Productivity
Pack license)

disabledHighRemote quota server. Used by
the quota (1M) command to
display user quotas for remote
file systems.

rquotad

disabledMedium

disabledLow (without Productiv-
ity Pack license)

disabledLow (with Productivity
Pack license)

enabledNone (without Productiv-
ity Pack license)

enabledNone (with Productivity
Pack license)
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StatusDefault SettingFunctionService

disabledHighNetwork username serverrpc.rusersd

disabledMedium

disabledLow (without Productiv-
ity Pack license)

disabledLow (with Productivity
Pack license)

enabledNone (without Productiv-
ity Pack license)

enabledNone (with Productivity
Pack license)

disabledHighSpray server. Records packets
sent by spray (IM) command.

rpc.sprayd

disabledMedium

disabledLow (without Productiv-
ity Pack license)

disabledLow (with Productivity
Pack license)

enabledNone (without Productiv-
ity Pack license)

enabledNone (with Productivity
Pack license)

disabledHighNetwork server running rwall
daemon. Enables dissemina-
tion of broadcast messages.

rpc.rwalld

disabledMedium

disabledLow (without Productiv-
ity Pack license)

disabledLow (with Productivity
Pack license)

enabledNone (without Productiv-
ity Pack license)

enabledNone (with Productivity
Pack license)
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StatusDefault SettingFunctionService

disabledHighrpc.ttbserverd

disabledMedium

disabledLow (without Productiv-
ity Pack license)

disabledLow (with Productivity
Pack license)

enabledNone (without Productiv-
ity Pack license)

enabledNone (with Productivity
Pack license)

disabledHighXfont server. Used by CDE to
render fonts.

fs

disabledMedium

enabledLow (without Productiv-
ity Pack license)

enabledLow (with Productivity
Pack license)

enabledNone (without Productiv-
ity Pack license)

enabledNone (with Productivity
Pack license)

disabledHighCalendar manager service
daemon

rpc.cmsd

disabledMedium

enabledLow (without Productiv-
ity Pack license)

enabledLow (with Productivity
Pack license)

enabledNone (without Productiv-
ity Pack license)

enabledNone (with Productivity
Pack license)

RPC

Use this tab to access the following services: RPC including NFS, Traceroute, and Portmap.
Select any of the following options to update these services:

• Enable All Connections

• Disable All Connections

• Enable Specified Connections
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5
Network Operating System
(NOS) Selection Menu

Refer to this section to install this device in a variety of Network Operating environments
in addition to TCP/IP. When installing this device in a Client/Server network, be sure to
have your server's operating system manual available.

• TCP/IP addressing and name resolution

• TCP/IP (Enabling LPD for LPR Printing)

• Enable raw TCP/IP (Port 9100)

• Enable IPP

• Netware (NDS and Bindery)

- About Netware server

- Log on to the printer

- Set the frame type and Novell net number

- Access queue server to configure printer to server communications

- Configure queue server for your mode

• Using queue manager

- About queue manager

- Add a new queue

- View or modify queue properties

- Note regarding the override setting

- Lock/unlock folders/queues

- About hot folders

- Enable a hot folder
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- Disable a hot folder

- Mount a hot folder

• AppleTalk

- Enable AppleTalk through license manager

- View or change phase type and zone name

- View or change the AppleTalk printer name

TCP/IP Addressing and Name Resolution
This procedure should have been performed when the device was first installed on the
network. The procedure is repeated here to provide instructions for changing TCP/IP
addresses and the method used for Host or NetBIOS name resolution (DNS or WINS).
1. Select Logon... from the Logon menu.
2. Select System Administrator as the user from the User Name drop-down list box.
3. Enter the System Administrator password (administ, for example). If necessary, refer

to your Xerox Service Representative for the initial logon password.

Note
To maintain security, all logon passwords should be changed after the system has
been installed.

4. Select OK.
5. From the system's Setup menu, select Network Configuration.

Note
The Ethernet cable must be connected and "live" for you to enable IP.

6. If it is not already enabled, select Enabled from the Internet Protocol pull-down list.
7. The IP Configuration method is displayed. Also displayed is the IP Address, Default

Gateway, and Subnet Mask.
8. Select the IP Address tab.
9. In the available text boxes enter a valid IP Address for this device, the Subnet Mask

for your network, and the Default Gateway address (if used) for your network. Click
Apply or OK to save your settings.

10. In the Hostname box, if you will be communicating with this device over the Internet,
or are using DNS, WINS, or NIS to resolve host names to IP Addresses on your network,
enter a unique host name for this device.

11. If you will be using DNS for Host name resolution on your network, select the DNS
tab.
a) If it is not already enabled by factory default, click on the Enable DNS check box

to enable it with a check mark.
b) Click on the Enable Dynamic DNS Registration check box if your network uses a

dynamic DNS server to automatically update host name to IP address mapping.
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c) In the Domain Name box, type in the domain that this device resides in (for
example, Xerox.com).

d) In the Hostname box, note that this read only name is the same as the unique
host name that was entered on the IP Address tab.

e) In the DNS Server list, provide the IP addresses of up to three DNS servers to search
when resolving host names to IP addresses.

f) In the Domain Search list, provide the names of other domains to search, if needed,
to resolve the host name.

g) Click Apply or OK to save your settings.

12. If you will be using WINS for NetBIOS name resolution on your Microsoft network,
select the WINS tab.
a) Click on the Enable WINS check box to enable it with a check mark.
b) In the box supplied, type in the IP address of the Primary WINS Server for resolution

of NetBIOS names to an IP address on the Microsoft network.
c) Click Apply or OK to save your settings.

13. If you will be using NIS to distribute password, group, or host address information
on your UNIX network, select the NIS/NIS+ tab.
a) Click on the Enable Name Service check box to enable it with a check mark. Note

that the NIS+ radio button is enabled by default. If desired, select the NIS radio
button instead.

b) Click on the Find NIS+ Server check box to query the network for the name and
IP address of the Network Information Service server.

c) If the NIS+ Server is not found, or the Find NIS+ Server check box is left unchecked,
use the supplied boxes to type in the Domain Name, Server IP address, and Server
Name for NIS/NIS+, if known.

d) Click Apply or OK to save your settings.

TCP/IP (Enabling LPD for LPR Printing)
This procedure should have been performed as part of the Required Set Up Steps
contained in this guide. The procedure is repeated here in case the Line Printer Daemon
becomes disabled and needs to be re-enabled as described below.
1. Select Logon... from the Logon menu.
2. Select System Administrator as the user from the User Name drop-down list box.
3. Enter the System Administrator password (administ, for example).

If necessary, refer to your Xerox Service Representative for the initial logon password.

4. Select OK.
5. From the system's Setup menu, select Gateways.
6. Select the LPD tab.
7. If it is not already enabled by factory default, select the Enabled radio button for

Line Printer Daemon (LPD).
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8. Select the Enabled radio button for LPD Default Queue. By enabling the LPD Default
queue feature, jobs will be processed by the system's default queue if a nonexisting
queue is specified.

Note
For systems with the Productivity Pack license enabled and numerous internal printer
queues set up with Queue Manager, client LPR ports can be configured to send jobs
to your queue of choice, if the LPD Default Queue feature is disabled.

9. Leave the LPD Port at its default value of 515.
LPD listens on port 515 for incoming TCP connections from clients.

10. Click Apply or OK to save your settings. If you clicked Apply, click Cancel to close the
window.

11. To log off, select Logoff from the Logon menu.

Enabling Raw TCP/IP (Port 9100)
The Raw TCP/IP printing service (typically known as Port 9100) enables the receipt of
print jobs using a raw TCP/IP data stream. The raw data stream is passed from the
workstation through the printer's TCP Port directly to the printer's input buffer for
processing. Any end of job (EOJ) indicator in the data stream closes the port connection.
Note that Port 9100 should also be enabled to support IPP printing.

Note
While 9100 is typically the port number to select, you can edit the default port numbers
9100/9400 to any number in the range 1024 to 65535. The following directions will use
Port 9100.

1. Select Logon... from the Logon menu.
2. Select System Administrator as the user from the User Name drop-down list box.
3. Enter the System Administrator password (administ, for example).

If necessary, refer to your Xerox Service Representative for the initial logon password.

4. Select OK.
5. From the system's Setup menu, select Gateways.
6. Select the Socket tab.
7. Select Port 9100, right-click the system mouse, and select Properties.
8. Choose a VPS Option from the VPS Options drop-box.

The acronym VPS stands for VTAM Print Service, which enables the printer to operate
in a VTAM/SNA (mainframe data printing) environment. The VTAM/SNA architecture
is well defined in rfc 1646, available on the internet at the IETF web site. Select
Non-VPS for operation with page description languages such as PCL and PostScript.
Select VPS for work with data streams such as LCDS.
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9. If your system has the Productivity Pack license enabled, select a system queue from
the Select queue drop down box to configure the queue with the Port number
identified in Step 7. Jobs that come in on this port number are forwarded to the
associated queue. Select OK.

10. Select Port 9100, right-click the system mouse, and select Enable.
11. Click Apply or OK to save your settings. If you clicked Apply, click Cancel to close the

window.
12. To log off, select Logoff from the Logon menu.

IPP
IPP allows printing from virtually anywhere using Internet or Intranet access. In addition
to submitting jobs to the printer, a workstation user with the Internet Print Service and
the applicable print driver installed, can perform the following functions:

• Get a list of capabilities for a particular printer.
• Find out the status of a printer or a print job.
• Cancel a previously submitted print job.
• Support streaming if the designated queue's input value is set to Stream. A job can

start printing before all document data has been transferred.

To enable IPP on the printer, perform the following steps.
1. Select Logon... from the Logon menu.
2. Select System Administrator as the user from the User Name drop-down list box.
3. Enter the System Administrator password (administ, for example). If necessary, refer

to your Xerox Service Representative for the initial logon password.
4. Select OK.
5. From the system's Setup menu, select Gateways.
6. Select the IPP tab.
7. Verify that a check mark is displayed within the Enable IPP checkbox. If the IPP

License is not enabled in License Manager, the Enable IPP checkbox is disabled also.
If necessary, place a checkmark within the Enable IPP checkbox. The system will
update and enable the checkbox in License Manager.

8. Under the Remote Authorization heading, decide whether or not you wish to let
Internet or Intranet users cancel or purge their print jobs. To enable these capabilities,
use the system mouse to place a check mark in the box preceding the Allow Job
Cancel or Allow Job Purge settings. To disable these capabilities make sure that the
check boxes are empty.

9. Click the Common Settings button to edit general information available for display
by this printer.

10. Click Apply or OK to save your settings. If you clicked Apply, click Cancel to close the
window.

11. To log off, select Logoff from the Logon menu.
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NetWare (NDS and Bindery)
NDS - Set up a Print Server object, Print Queue object, and Printer object in the
appropriate Context (NDS Tree) using NetWare Administrator, NetAdmin, or PCONSOLE.
Refer to the documentation supplied by Novell ( www.novell.com ) to complete this task.
For later use in setting up the printer, record precisely (observing upper and lower case,
dot notation, etc.) the following items used in setting up objects on the server: NDS Tree,
NDS Context Name, Print Server Name, Print Server password. Note that if the printer
services queues on multiple file servers, the Print Server name and password must be
the same on all the file servers.

Bindery - Set up a Print Server, Queue, and Printer Configuration on the Primary (File)
Server using PCONSOLE. Refer to the documentation supplied by Novell ( www.novell.com
) to complete this task. For later use in setting up the printer, record precisely (observing
upper and lower case, punctuation, etc.) the following items: the File (Primary) Server
name, Print Server name, Print Server password, and the Queue name assigned. Note
that if the printer services queues on multiple file servers, the Print Server name and
password must be the same on all the file servers.

Log on to the Printer
1. Select Logon... from the Logon menu.
2. Select System Administrator as the user from the User Name drop-down list box.
3. Enter the System Administrator password (administ, for example).

If necessary, refer to your Xerox Service Representative for the initial logon password.

4. Select OK.

Set the Frame Type and Novell Net Number
1. From the system's Setup menu, select Gateways.
2. Select the NetWare tab. If the NetWare tab is grayed out, select Feature Licenses

under the Setup menu and verify that the Novell NetWare Gateway license is present
and enabled. If the license is not present, contact your Xerox representative.

3. The NetWare tab indicates NetWare routes and their supported frame types. Auto
configuration is the default setting for detection. Manual Configuration can be
selected by clicking the Setupbutton. Verify that a displayed Frame Type and Novell
Net Number matches your network settings.

4. To make changes to the displayed information, click the Setup button, select Manual
Configuration, then click OK. When the Warning prompt displays, click OK.

5. Select the line representing the setting that you would like to change and right-click
the system mouse.

6. From the displayed dialog, select Properties, Add, or Delete to bring up a dialog
enabling you to make your changes.
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7. Click OK on the dialog after your changes have been made, then respond to the
prompt as to whether you wish your changes to be configured Now or on the Next
Restart.

Accessing Queue Server to configure printer to server
communications
1. From the system's Setup menu, select Gateways.
2. Select the Queue Server tab.
3. In the upper left corner of the Queue Server window, note the displayed Mode.

The Queue Server window provides two tables for configuring the printer's connection
to the NetWare server. The upper table is used for configuring NDS connections, while
the lower table is used for configuring Bindery connections.

Configuring Queue Server for your Mode

For the set up steps that apply to your system, click on one of the two hot links below.

• Configuring Queue Server for systems with one queue
• Configuring Queue Server for systems with multiple queues

Configuring Queue Server for Systems with One Queue
Queue Server logs into the listed NetWare File Servers as a named Novell Print Server,
and determines what NetWare queues to service by reading the File Server's Print Server
configuration information. All jobs pulled from the Server's queues will be placed into
the printer's single, default internal queue for processing. The system supports at least
eight different Print Server connections in any combination of NDS or Bindery
configurations.
1. To view the properties of an existing connection configuration, in either the NDS or

Bindery table, right-click on a horizontal selection line and select Properties from the
pop-up menu.

2. To delete an existing connection configuration, in either the NDS or Bindery table,
right-click on a horizontal selection line and select Delete from the pop-up menu.

3. To add a new connection configuration, click on the New button in the window's
lower right corner, or right-click on a blank horizontal selection line and select New
from the pop-up menu.

4. When the New Queue Server window displays, select NDS or Bindery.
5. If you selected NDS, in the boxes provided, enter a Tree Name of up to 32 characters

and a Context Name of up to 256 characters and click< Next.
The Context Name can be in either typeful (CN=name.OU=name.O=name.C=name)
or distinguished (common_name.name.name.name) format. Note that these names
must match the NDS Tree Name and NDS Context Name that were recorded when
initially performing the Setting Up the NetWare Server procedure.
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a) In the boxes provided, enter the Print Server name and password that match those
that were recorded when initially performing the Setting Up the NetWare Server
procedure. Print Server names for NetWare 4.x and newer versions can be up to
64 characters long. The Print Server password can be up to 127 characters long.

b) For Query Interval (queue polling interval), either accept the 5 second default
setting, or use the selection arrows to choose a setting of 1 to 240 seconds.

6. If you selected Bindery, click Next and, in the boxes provided, enter a File Server
(Primary Server) name, Print Server name, and Print Server Password that match
those that were recorded when initially performing the Setting Up the NetWare Server
procedure. Print Server names for NetWare 3.x are limited to 47 characters. Print
Server names for NetWare 4.x and newer versions can be up to 64 characters long.
The Print Server password can be up to 127 characters long.

7. For Query Interval (queue polling interval), either accept the 5 second default setting,
or use the selection arrows to choose a setting of 1 to 240 seconds.

8. Click OK.
9. Respond to the prompt as to whether you wish your changes to be configured Now

or on the Next Restart.

Configuring Queue Server for Systems with Multiple Queues
Queue Server logs into the listed NetWare File Servers as a named Novell Print Server,
and services the NetWare queues specified in Queue Server by the user. Jobs pulled from
each NetWare queue are placed into one of a number of possible internal printer queues,
also specified in Queue Server by the user. The system supports at least eight different
Print Server connections in any combination of NDS or Bindery configurations.
1. To view the properties of an existing connection configuration, in either the NDS or

Bindery table, right-click on a horizontal selection line and select Properties from the
pop-up menu.

2. To delete an existing connection configuration, in either the NDS or Bindery table,
right-click on a horizontal selection line and select Delete from the pop-up menu.

3. To add a new connection configuration, click on the New button in the window's
lower right corner, or right-click on a blank horizontal selection line and select New
from the pop-up menu.

4. When the New Queue Server window displays, select NDS or Bindery.
5. If you selected NDS, in the boxes provided, enter a Tree Name of up to 32 characters

and a Context Name of up to 256 characters and click Next. The Context Name can
be in either typeful (CN=name.OU=name.O=name.C=name) or distinguished
(common_name.name.name.name) format. Note that these names must match the
NDS Tree Name and NDS Context Name that were recorded when initially performing
the Setting Up the NetWare Server procedure.
a) From the displayed list at the top of the next window, select a Print Server.
b) In the box provided, enter the Print Server Password that matches the password

recorded when initially performing the Setting Up the NetWare Server procedure.
The Print Server Password can be up to 127 characters long.

c) Click the Logon button.
d) From the displayed list at the top of the next window, under the NetWare heading,

select a Print Queue.
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e) For Query Interval (queue polling interval), either accept the 5 second default
setting, or use the selection arrows to choose a setting of 1 to 240 seconds.

f) From the displayed list at the bottom of the window, under the FreeFlow Print
Server heading, select an internal printer queue to receive the jobs pulled from
the previously selected NetWare queue.

Note
Internal printer queues are created using Queue Manager.

g) Click OK, then respond to the prompt as to whether you wish your changes to be
configured Now or on the Next Restart.

6. If you selected Bindery, click Next.
a) From the displayed list at the top of the next window, select a File Server.
b) In the User Name and Password boxes provided, enter your Bindery Server login

name and password (authenticating your rights to manage the print server and
queue).

c) Click the Logon button.
d) From the displayed list at the top of the next window, select a Print Server.
e) In the box provided, enter the Print Server Password that matches the password

recorded when initially performing the Setting Up the NetWare Server procedure.
The Print Server Password can be up to 127 characters long.

f) Click the Logon button.
g) From the displayed list at the top of the next window, under the NetWare heading,

select a Print Queue.
h) For Query Interval (queue polling interval), either accept the 5 second default

setting, or use the selection arrows to choose a setting of 1 to 240 seconds.
i) From the displayed list at the bottom of the window, under the FreeFlow Print

Server heading, select an internal printer queue to receive the jobs pulled from
the previously selected NetWare queue.

Note
Internal printer queues are created using Queue Manager.

j) Click OK, then respond to the prompt as to whether you wish your changes to be
configured Now or on the Next Restart.

Using Queue Manager
If the Productivity Pack license is installed and enabled on your system, multiple queues
are available for holding and printing jobs. Use Queue Manager to create numerous
internal printer queues that can be used to control the flow or handling of documents
in different ways. If the Productivity Pack license is not enabled, the system defaults to
using a single queue, which is accessed by selecting [ Defaults] from the Printer menu.
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Note: As described in Configuring Queue Server, under the NetWare (NDS & Bindery)
heading, these internal queues can be user selected to receive jobs from specific NetWare
Server queues.

For complete information on the use of Queue Manager, consult the FreeFlow Print
Server On Line Help.

To add a new queue (if the Productivity Pack license is installed
and enabled)
1. Open the Queue Manager by selecting Queue from the displayed list of Managers.
2. Select the Queue drop-down arrow at the top of the Queue Manager window.
3. Select New... from the displayed menu.
4. When the New Queue dialog displays, enter a name of up to 25 characters in the

Queue Name field. The name can consist of letters, numbers, and underscores.
5. Select a number between 1 and 65,500 to indicate the Quantity of job sets to be

printed for all jobs sent to this queue, unless otherwise specified in the job itself.
6. Set a priority between 1 (highest priority) and 100 (lowest priority) for the queue.
7. Select the job input mode and format to indicate the manner in which jobs will be

submitted to the queue.
8. Select a destination of either Print to print the document or Save to save the

document to the location designated in Save Location.
9. Make other, desired, setting selections from the Stock, Output, Image Quality, Image

Edit, and PDL Settings tabs.
10. Select Add Queue to complete the addition of the new queue.
11. Select Close to exit the New Queue dialog.
12. In the Queue list, right-click the new queue and choose Accept Jobs to enable the

queue.

To view or modify queue properties

• If the Productivity Pack license is installed and enabled on your system, follow these
steps:
a) Open the Queue Manager.
b) Select a queue and double click the system mouse to open Queue Properties.
c) Modify queue settings as desired, then click OK to have your changes enabled by

the system.

• If the Productivity Pack license is not installed and enabled on your system, follow
these steps:
a) Select Printer  > Defaults.
b) Modify queue settings as desired, then click OK to have your changes enabled by

the system.
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Note regarding the Override setting (if the Productivity Pack license is
installed and enabled)

Many options in the Queue Manager dialogs contain an override setting. Select Override
only if you want the queue settings to take precedence over any attributes programmed
with individual jobs.

Lock/Unlock Folders/Queues (if the Productivity Pack license is
installed and enabled)
The System Administrator can lock or unlock a queue. The properties can not be changed
in a locked queue.
1. Open Queue Manager.
2. Right-click on a queue.
3. Select Lock or Unlock.

Hot Folders

Hot Folders is a queue feature that is available on systems with or without the Productivity
Pack license installed and enabled. Hot Folders provide a quick and easy way to submit
jobs to a Nuvera system. When Hot Folders is enabled, the system creates a shared folder
on the FreeFlow Print Server that the user can access from their PC. Users can drag and
drop multiple print-ready files from the desktop into a Hot Folder for printing.

Hot Folders are stored in the directory: /var/spool/XRXnps/hotfolders.

Hot Folders are backed by the Backup/Restore function.

To enable a Hot Folder:
1. For systems with the Productivity Pack license enabled, open Queue Manager.
2. Right-click on a queue and select Hot Folder > Enable Hot Folder.
3. For systems without the Productivity Pack license, select System > Enable Hot Folder

FreeFlow Print Server transparently performs all the needed networking configuration,
utilizing SAMBA (SMB), then exports the Hot Folder onto the network so it is publicly
visible to all users.

To disable a Hot Folder:
1. For systems with the Productivity Pack license enabled, open Queue Manager.
2. Right-click on a queue and select Hot Folder > Disable Hot Folder.
3. For systems without the Productivity Pack license, select System > Disable Hot

Folder.
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Hot Folder Observer polling time

The Hot Folder Observer monitors the Hot Folders for new jobs: PDL files or XPIF tickets.
Supported PDL files Include: PDF, PS, PCL, TIFF, VIPP, and VIPP Projects.

• If there is a PDL job, Hot Folder Observer submits the job to the queue.
• If the job is a XPIF ticket, Hot Folder Observer processes the XPIF ticket to obtain the

PDL files specified in the Uniform Resource Identifier (URI) attribute in the XPIF ticket
and submit the job to the queue. Note: URL's can not contain Hot Folder locations.

• Jobs submitted without XPIF tickets print with default queue settings.

After a successful job submission to the queue, the Hot Folder Observer deletes the job
in the Hot Folder. If the Hot Folder Observer fails to submit a job to the queue, it copies
the offending job to folder title ERROR, a sub folder of the Hot Folder.

Hot Folder Observer polling time can be set for 5 to 10000 seconds.
Select Setup  > System Preferences > Job Processing  > Hot Folder.

FreeFlow Print Server must be restarted to recognize the polling time changes.

Mounting Hot Folders on a PC:
There are two procedures for mounting Hot Folders on a PC.

• Procedure #1
a) Launch the Run command from the Start window.
b) Type in two backslashes and the hostname. (Example: \\chevelle)
c) From the list of visible Hot Folders, double-click on a Hot Folder to mount it.

• Procedure #2
a) Open an Explorer window.
b) Select View  > Toolbars > Address Bar.
c) Type two backslashes, the hostname, a backslash and the Queue/Hot Folder name.

(Example: \\chevelle\HotFolderq)
d) Press Enter.

Enabling AppleTalk through License
Manager
1. Select Logon from the Logon menu.
2. Select System Administrator as the user from the User Name drop-down list box.
3. Enter the System Administrator password (administ, for example) and click OK.
4. Select Feature Licenses from the Setup menu.
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5. Right-click on the Ethernet Network license and the horizontal selection line labeled
AppleTalk Gateway. Select Properties from the pop-up menu.

6. Make sure that the Enable radio button under the Feature heading is selected.
7. Make sure that AppleTalk Gateway is the name displayed under the License Name

heading.
8. Click OK or Apply to save your settings. If no changes are required, or you clicked

Apply, click Cancel to close the window.
9. To log off, select Logoff from the Logon menu.

Viewing or Changing Phase Type and Zone Name
1. Select Logon... from the Logon menu.
2. Select System Administrator as the user from the User Name drop-down list box.
3. Enter the System Administrator password (administ, for example). If necessary, refer

to your Xerox Service Representative for the initial logon password.
4. Select OK.
5. From the system's Setup menu, select Gateways.
6. Select the AppleTalk tab.
7. Verify that a check mark is displayed within the Enable AppleTalk checkbox.

If the AppleTalk License is not enabled in License Manager, the Enable AppleTalk
checkbox is disabled also. If necessary, place a checkmark within the Enable AppleTalk
checkbox. The system will update and enable the checkbox in License Manager.

8. Note that the Phase Type is set to 2 by default. This denotes a multi-zoned network
of 256 workstations per zone. The Phase 1 setting, which is available by clicking the
selection arrow, is an older phase with a limit of 256 workstations on a single network.

9. Note that the Zone Name is set as a star (*) by default. This setting lets the closest
router assign the printer to the default zone.

10. Although not shown on screen, note for reference that the default AppleTalk printer
type is LaserWriter.

11. Make changes to the settings, if required, then click Apply or OK. If no changes are
required, or you clicked Apply, click Cancel to close the window.

12. To log off, select Logoff from the Logon menu.

Viewing or Changing the AppleTalk Printer Name

The AppleTalk Printer Name, selectable on the Macintosh workstation using Chooser, is
comprised of the printer's internal queue name or names. For systems with one queue,
this name is the same as the IP hostname followed by the letters VP. For systems with
the Productivity Pack license installed and enabled, all queues listed under the Queue
Manager are selectable as AppleTalk printers using Chooser.

Note
Changing the queue name can cause problems in client/server environments, with clients
that are using the older queue name for their network port connection.
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6
Print Driver Installation

Select a printing environment and follow the instructions.

• Drivers with Job Tickets (Xerox Custom Drivers)

• TCP/IP Peer to Peer (LPR) Printing

- Read this before starting installation

- Verify that TCP/IP is installed in the workstation

• IPP Printing

• AppleTalk Printing

- Read this before starting installation

- Install the driver into Macintosh OS

• Netware Bindery Printing

- Read this before starting installation

- Verify the correct protocol and service are installed in the workstation

• Netware NDS Printing

- Read this before starting installation

- Verify the correct protocol and service are installed in the workstation

• Common UNIX Printing System (CUPS)

- Read this before starting installation

- Installing CUPS on the UNIX workstation

- Installing the Xerox PPD on the workstation

- Adding the Xerox printer

- Printing with CUPS
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Drivers with Job Tickets (Xerox Custom
Drivers)
In addition to standard application print drivers, Drivers with Job Tickets (Xerox Custom
Drivers) are available for installation on Windows and Macintosh workstations.

These drivers offer a job ticket dialog that enables users to utilize the full feature set of
the selected Xerox device, in addition to the settings offered by the standard PostScript
or PCL5e driver.

Job ticket features are described in the CentreWare Getting Started Guide in the
CentreWare Drivers Kit along with the CentreWare Drivers CD-ROM.

Drivers with Job Tickets, in addition to the standard application print drivers, are available
on one of the CD-ROMs that came with your printer. These drivers are also available on
the xerox.com web site.

Unless otherwise indicated, the installation instructions for Drivers with Job Tickets are
the same as the installation instructions for the standard application drivers, described
throughout the Print Drivers section of this System Administrator's Guide.

As a helpful tip make sure that the HTTP and IPP gateways are enabled on the printer.
HTTP is enabled using the instructions contained in the Recommended Set Up Steps
section of this guide. IPP is enabled using the instructions contained in the NOS Selection
Menu section of this guide.

TCP/IP Peer to Peer (LPR) Printing
Print Driver Installation

Before you start

Obtain the Print Driver for your workstation's operating system. Drivers are available on
one of the CD-ROMs that came with your Printer. For complete print driver information
and installation instructions, refer to the CentreWare Printer Drivers Guide for Windows,
which is available on the driver CD or from www.xerox.com .

Verify that TCP/IP is installed in the workstation
1. On the Windows desktop, click Start  > Control Panel, and select the Network Center.

View your active networks and locate the Internet type connection.
a) Select the Local Area Connection link. The status window displays.
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2. Verify that the Internet Protocol (TCP/IP) has been loaded by selecting the Properties
button. The Properties window displays.

3. If listed, click on (highlight) this item and select the Properties button to verify that
this workstation is using either a dynamic or static method to obtain a valid TCP/IP
address.

4. If the TCP/IP protocol is not listed (loaded), select the Install button. From the window
that displays, select Protocol as the type of network component you wish to install.
a) Click the Add button and select Internet Protocol (TCP/IP).
b) With your Operating System Installer Disk readily available, click the Have Disk

button and follow any remaining instructions.

Once the protocol has been installed, you can click on (highlight) the item with your
mouse and click the Properties button to verify or set up the method being used for
TCP/IP addressing.

Verify that Print Services for Unix is installed in the workstation
You can skip this step if you prefer printing through the Standard TCP/IP Port (Port
9100), rather than through an LPR port.
1. On the Windows desktop, select Start  > Control Panel, then click Programs and

Features.
2. View the list of installed programs.
3. To install the program if needed, select Install a program and follow the instructions

on the window.
4. Close the Control Panel window.

To add the printer to the Windows desktop and to configure the
print driver

Refer to the CentreWare Printer Drivers Guide for Windows.

IPP Printing (Windows)
IPP (Internet Printing Protocol) enables the convenience of printing over the Internet
or Intranet through the creation of an IPP network port. This printing service is available
for other workstation operating systems through downloads from the Microsoft web
site. Follow the instructions provided by Microsoft, or other trusted sources on the Internet,
to install the IPP service on Windows operating systems.

For complete print driver information and installation instructions, refer to the CentreWare
Printer Drivers Guide for Windows, which is available on the driver CD or from
www.xerox.com .
1. Obtain the Print Driver for your workstation's operating system. Drivers are available

on one of the CD-ROMs that came with your printer.
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They are also typically available for downloading in Zip file format from the Internet
at www.xerox.com .

2. At the printer, log on as System Administrator and select Network Configuration
from the Setup menu.

3. Verify that IP is enabled and that the printer has been assigned a valid IP Address,
Subnet Mask, and Gateway.

4. Also verify that DNS is being used to resolve host names to IP addresses.

If either of these settings needs to be reconfigured, follow the steps supplied in the
TCP/IP Addressing & Name Resolution procedure in the NOS Selection Menu section
of this guide.

5. At the printer, from the Setup menu, select Gateways, then the IPP tab.
6. Verify that a check mark is displayed within the Enable IPP checkbox. If necessary,

place a checkmark within the Enable IPP checkbox.
a) If the IPP selections are unavailable, select Feature Licenses from the Setup menu

and verify that the IPP license is present and enabled.
Complete instructions are available in the Checking Installed Options with License
Manager procedure in the Required Set Up Steps section of this guide.

7. Verify that TCP/IP is installed on the workstation.

To add the printer to the Windows desktop and to configure the print driver, refer to the
CentreWare Printer Drivers Guide for Windows.

AppleTalk Printing
Before you start obtain the Adobe PostScript Print Driver for your Macintosh OS
workstation. Drivers are available on one of the CD-ROMs that came with your printer.
They are also typically available for downloading from the Internet at www.xerox.com.
For complete print driver information and installation instructions, refer to the
documentation that accompanies the print drivers.
1. At the printer, from the Setup menu, select Gateways, then the AppleTalk tab.
2. Verify that the Phase Type is set to match your network.

Phase Type is set to 2 by default. This denotes a multi-zoned network of 256
workstations per zone. The Phase 1 setting, which is available by clicking the selection
arrow, is an older phase with a limit of 256 workstations on a single network. Note
that the Zone Name is set as a star (*) by default. This setting lets the closest router
assign the printer to a zone.
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The AppleTalk Printer Name is comprised of the printer's internal queue name or
names. For systems with one queue, this name is the same as the printer's single,
internal queue name (either XRX followed by the MAC address, or the IP hostname
followed by the letters VP). For systems with multiple internal queues, use the Queue
Manager to either view or create a new queue (with accompanying AppleTalk Printer
Name). For information on the use of Queue Manager, refer to the NOS Selection
Menu section of this guide.

If AppleTalk selections are unavailable on the AppleTalk tab, select Feature Licenses
from the Setup menu and verify that the AppleTalk license is present and enabled.
Complete instructions are available in the Checking Installed Options with License
Manager procedure in the Required Setup Steps section of this guide.

Installing the Driver into Macintosh OS

Before installing the AdobePS printer driver and any of the Xerox PPDs or the PlugIn,
remove any old Adobe drivers, Xerox PPDs, and Xerox printer PlugIns from the Printer
Descriptions folder in the Extensions folder. Delete the Xerox Printer Preferences file
from the Preferences folder, then follow the installation procedures on the print driver
CD to install the drivers and configure the files .

NetWare Bindery Printing
Before you start, obtain the Print Driver for your workstation's operating system. Drivers
are available on one of the CD-ROMs that came with your printer. They are also typically
available for downloading from the Internet at www.xerox.com .

For complete print driver information and installation instructions, refer to the CentreWare
Printer Drivers Guide for Windows, which is available on the driver CD or from
www.xerox.com .

Verify that the Correct Protocol and Service are installed in the
workstation

• Verify that the NW Link/IPX/SPX/NetBIOS Compatible Transport Protocol is installed
in the Workstation.
a) On the Windows desktop, select Start  > Control Panel, and select the Network

Center. View your active networks and locate the Internet type connection. Select
the Local Area Connection link. The status window displays.

b) Verify that the Protocol has been loaded by selecting the Properties button. The
Properties window displays.

c) If the protocol is not loaded, click the Install button, then select Protocol as the
type of network component that you wish to install.

d) Click the Add button and select NW Link/IPX/SPX/NetBIOS Compatible Transport
Protocol.
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e) With your Operating System Installer Disk readily available, click the Have Disk
button and follow any remaining instructions.

• Verify that the Client Service for NetWare is installed in the Workstation.
a) On the Windows desktop, select Start  > Control Panel, and select the Network

Center. Select the Local Area Connection link and select Properties.
b) If the Client Service for NetWare is not loaded, click the Install button, then select

Client as the type of network component that you wish to install.
c) Click the Add button and select Client Service for NetWare.
d) With your Operating System Installer Disk readily available, click the Have Disk

button and follow any remaining instructions.

To add the printer to the Windows desktop and to configure the print driver, refer to the
CentreWare Printer Drivers Guide for Windows.

NetWare NDS Printing
Before you start, obtain the Print Driver for your workstation's operating system. Drivers
are available on one of the CD-ROMs that came with your printer. They are also typically
available for downloading from the Internet atwww.xerox.com .

For complete print driver information and installation instructions, refer to the CentreWare
Printer Drivers Guide for Windows, which is available on the driver CD or from
www.xerox.com .

Verify that the Correct Protocol and Service are installed in the
workstation

• Verify that the NW Link/IPX/SPX/NetBIOS Compatible Transport Protocol is installed
in the Workstation.
a) On the Windows desktop, select Start  > Control Panel, and select the Network

Center. View your active networks and locate the Internet type connection. Select
the Local Area Connection link. The status window displays.

b) Verify that the Protocol has been loaded by selecting the Properties button. The
Properties window displays.

c) If the protocol is not loaded, click the Install button, then select Protocol as the
type of network component that you wish to install.

d) Click the Add button and select NW Link/IPX/SPX/NetBIOS Compatible Transport
Protocol.

e) With your Operating System Installer Disk readily available, click the Have Disk
button and follow any remaining instructions.

• Verify that the Client Service for NetWare is installed in the Workstation.
a) On the Windows desktop, select Start  > Control Panel, and select the Network

Center. Select the Local Area Connection link and select Properties.
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b) If the Client Service for NetWare is not loaded, click the Install button, then select
Client as the type of network component that you wish to install.

c) Click the Add button and select Client Service for NetWare.
d) With your Operating System Installer Disk readily available, click the Have Disk

button and follow any remaining instructions.

To add the printer to the Windows desktop and to configure the print driver, refer to the
CentreWare Printer Drivers Guide for Windows.

Common UNIX Printing System (CUPS)
The Common Unix Printing System (CUPS) was created by Easy Software Products in
1998 as a modern replacement for the Berkeley Line Printer Daemon (LPD) and AT&T
Line Printer (LP) system designed in the 1970's for printing text to line printers.

Currently available for downloading from a number of sources on the Internet, such as
www.cups.org , CUPS is offered in both source code and binary distributions.

Verify that IPP and Port 9100 are enabled at the printer.
1. At the printer, from the Setup menu, select Gateways, then the IPP tab.
2. Verify that the Printer URL fields are filled in.

The correct format for each field is: http://controller name.domain
name.com:631/servlet/IPPServlet.IppPrinter.

Note
The controller name.domain name.com can be replaced by the printer's IP address.
Complete instructions are available in the Checking Installed Options with License
Manager procedure in the Required Set Up Steps section of this guide.

3. If the IPP selections are unavailable, select Feature Licenses from the Setup menu
and verify that the IPP license is present and enabled.

4. At the printer, from the Setup menu, select Gateways, then the Socket tab.
5. Verify that Port 9100 is Enabled.
6. If it is not, select Port 9100, right-click the system mouse, and select Enable.
7. Click Apply or OK to save the new setting.
8. If the Port 9100 selections are unavailable, select Feature Licenses from the Setup

menu and verify that the TCP/IP Socket license is present and enabled.
Complete instructions are available in the Checking Installed Options with License
Manager procedure in the Required Set Up Steps section of this guide.
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Installing CUPS on the UNIX workstation

The instructions for installing and building CUPS are contained in the CUPS Software
Administrators Manual, written and copyrighted by Easy Software Products and available
for downloading at www.cups.org/documentation.php . An Overview of the Common
UNIX Printing System, Version 1.1 by Easy Software is also available at this site.

A case history of the building and installation of CUPS source code on a FreeBSD 4.2
machine, is described in the article entitled Using CUPS--the Common UNIX Printing
System, by Ralph Krause, available at www.cups.org , through the
links/documentation/tutorials/BSD Today - Using CUPS selections. Directory locations
for the CUPS files, as described in this article, are the following:

• Programs were copied to /usr/local/bin and usr/local/sbin.
• Documentation was copied to /usr/local/share/docs/cups.
• A directory called /usr/local/share/cups was created for various CUPS data files.
• The configuration files were copied to /usr/local/etc/cups.

The binary distribution of CUPS is available in tar format with installation and removal
scripts, as well as in rpm and dpkg formats for RedHat and Debian versions of Linux.
After logging into the workstation as root (su) and downloading the appropriate files
to the root directory, the CUPS installation process begins as follows:

Tar format:

After untarring the files, run the installation script with ./cups.install (and press Enter).

RPM format:

rpm -e lpr

rpm -i cups-1.1-linux-M.m.n-intel.rpm (and press Enter).

Debian format:

dpkg -i cups-1.1-linux-M.m.n-intel.deb (and press Enter).

Note
RedHat Linux, versions 7.3 and newer, include CUPS support, so software downloading
is unnecessary. Also, CUPS is the default printing system used by Mandrake Linux.

Installing the Xerox PPD on the workstation

The Xerox PPD for CUPS is available on one of the CD-ROMs that came with your printer
and available for downloading from the Internet at www.xerox.com .

From the CD-ROM or from the downloaded Internet file, with root privileges copy the
PPD into your cups ppd folder on your workstation. If you are unsure of the folder's
location, use the Find command to locate the ppd's. An example of the location of the
ppd.gz files in RedHat 8.1 is /usr/share/cups/model.
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Adding the Xerox printer
1. Use the PS command to make sure that the CUPS daemon is running.

The daemon can be restarted from Linux using the init.d script that was created when
the CUPS RPM was installed. The command is  /etc/init.d/cups restart.

A similar script or directory entry should have been created in System V and BSD. For
the example of CUPS built and installed on a FreeBSD 4.2 machine from the source
code, run cupsd from /usr/local/sbin. ( cd /usr/local/sbin cupsd press Enter).

2. Type http://localhost:631/admin into the address (URL) box of your web browser and
press Enter.

3. For User ID, type root. For the requested password, type the root password.
4. Click Add Printer and follow the on screen prompts to add the printer to the CUPS

printer list.

Printing with CUPS
CUPS supports the use of both the System V (lp) and Berkeley (lpr) printing commands.

• Use the -d option with the lp command to print to a specific printer.
lp -dprinter filename (Enter)

• Use the -P option with the lpr command to print to a specific printer.
lpr -Pprinter filename (Enter)

For complete information on CUPS printing capabilities, see the CUPS Software Users
Manual available from  www.cups.org/documentation.php .
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7
Configuring System
Features

Refer to this section for a list of System Features and their set up instructions.

• Logging on with Microsoft ADS User Names

- Configuring the system to join the domain

- Logging on to the system with ADS user names

• Submitting print jobs with the web interface

- Configuration steps

- Accessing the web interface

- Submitting a print job

• Printing with FreeFlow

- Overview

- Configuring the Printer

- Configuring FreeFlow

• Changing printer default settings

• Accessing billing information

• Setting system preferences

- Settings available for configuration

- Accessing system preferences

• Supporting CentreWare Web

- Overview

- Installing the Software
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- Accessing the CentreWare Web home page

- Configuring the system to communicate with CentreWare Web

• Power saver setup

• Configuring switches (including banner pages)

- Overview

- Accessing switches

• Working with job accounting

- Setting up auto export

- Manually exporting the accounting log

- Copying the accounting log file to an FTP server

- Manipulating the data for import into Equitrac

- FTP commands primer

• Using the release jobs/don’t release jobs option

• Scan to digital (file) feature

• Performing a data (disk) overwrite

• Saving files to network drives

- Accessing the network filing capability

- Using the destination or save location settings

- Communications settings required to support network filing

- Setting up scan to file with NFS (Linux/UNIX or FreeFlow)

• Support for LCDS

- Overview

- Verifying the presence of the LCDS license

- Refer to LCDS license documentation

• Support for IPDS

- Overview

- Verifying the presence of the IPDS License

- Setting up IPDS queues

• Setting up a foreign device external controller

- Overview and setup

- Removing a foreign device external controller

- Hints and tips
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• Configuration backup and restore

- Overview

- Common uses

- How to create a configuration backup

- How to restore a configuration backup

- Limitations

• Enabling Transport Layer Security (TLS/SSL)

- Overview

- Installing a self-signed digital certificate

- Generating a certificate request to certificate authority

- Enabling and configuring TLS/SSL

• IP filtering

- Overview

- Accessing and configuring the IP filter

• Support for FreeFlow VI Interpreter (FF VII)

- Overview

- Verifying the presence of VIPP software

- Verifying the presence of the FreeFlow VI Interpreter License

- Installing the FreeFlow VI Interpreter software or license, if needed

- Storing VIPP Resources on the printer

- FreeFlow VI Projects

- Adding a new queue to support the FreeFlow VI Interpreter

- Dedicating the new queue to process VIPP (streaming) jobs

- Enable Settings under System Preferences to support the VIPP queue

- Selecting Stocks (feeder trays) to support the VIPP queue

- Defining Stocks with Printer Manager

- Setting up Stackers to support VIPP

- Enabling FTP and NFS to support VIPP

• DFA configuration management

- Overview

- Using a predefined Xerox-supplied configuration from the catalog

- Importing DFA profiles and configurations
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- Exporting DFA configurations

- Creating DFA profiles and configurations

- Editing DFA profiles and configurations

- Copying DFA profiles

- Deleting DFA configurations or profiles from a configuration

Logging on with Microsoft ADS User
Names
The ADS feature lets System Administrators configure the system to join a Windows
domain, and enables users to log on to the printer using their Microsoft Active Directory
Services (ADS) user names.

Configuring the system to join the domain:
1. Log on to the system by selecting Logon from the Logon menu.
2. Select System Administrator as the user from the User Name drop-down list box.
3. Enter the System Administrator password (administ, for example) and click OK.
4. From the system's Setup menu, select Network Configuration.
5. Select the DNS tab and verify that the Enable DNS check box is enabled with a check

mark and that the DNS Server list is filled in with the IP addresses of up to three DNS
servers to search when resolving host names to IP addresses.
If necessary, refer to the Setting Up TCP/IP procedure in the Required Set Up Steps
section of this guide for instructions.

6. Select the ADS tab and click the Join button.
7. Enter the fully qualified domain name of the ADS domain in the box provided.

Optionally, enter the ADS site name and click the Join button for the system to join
the ADS domain.

Note
If DNS is not enabled, the Join button will not be available.

8. To view or modify the mapping of ADS Groups to the three user account groups
(administrator, operator, user) permitted to log on to the printer, select Users &
Groups from the system's Setup menu.

9. Select the ADS Groups tab.
10. Make any modifications required, then click OK or Apply to save your settings. To

exit the window without making changes, click Cancel.

Logging on to the system with ADS user names

From the Logon menu, select ADS for authentication, then log on to the system with
your ADS user name and password.
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For this feature to work, make sure that the ADS groups have been mapped to the three
user account groups (administrator, operator, user) permitted to log on to the printer.

Submitting Print Jobs with the Web
Interface
Note
This process is not recommended and is not supported if any issues occur.

Configuration Steps

With the web interface you use a browser with a Java Run-Time Plug-in to access windows
that enable you to select a document file, set up a job ticket, and submit your file to the
printer.

1. Make sure that the HTTP Gateway is enabled as stated in the Enabling HTTP
procedure in the Recommended Steps section of this guide.

2. Make sure that a browser is available on the networked workstation.
3. Check the browser's connection settings to make sure that you are not using a proxy

server to connect to local area network addresses.

Accessing the Web Interface
1. Ensure that the printer to which you want to send jobs is powered on.
2. On your workstation, open your Internet browser.
3. Enter http:// followed by the IP address of the printer.
4. The printer's home page is displayed with the following fields:

• Printer information: The printer name, IP address, and location.
• Job Submission button: Connects you to the job setup window for the web

interface.

5. On the printer's home page, select Job Submission.
The Job Submission window opens, displaying job setup and printing options.

Submitting a Print Job
1. Access the web interface (printer's home page).
2. On the printer's home page, select Job Submission.

The Job Submission window opens, displaying job setup and printing options.
3. Select a print queue (if more than one is available).
4. Select a file to print using the Browse button.
5. Create a new job ticket for printing this file, or specify the default job ticket.

A job ticket is a set of specified options that the system uses to process the print job.
You create a new ticket by selecting or entering options in the available fields of the
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Job Submission window. The default job ticket, once one has been saved, is the set
of job parameters first displayed when the Job Submission window opens. The default
job ticket can also be displayed by selecting Restore My Default Ticket from the Job
Submission window.

6. Select your print options.
7. Select the type of page description language (PDL) that will be used for the job.
8. Select your remaining job ticket parameters.
9. If desired, record job notes by entering them in the fields in the Job Notes section.

10. To submit the file to the printer, click Print on the stationary printing section of the
Job Submission window.

Printing with FreeFlow
The FreeFlow Print Server software allows you to scan hardcopy documents, combine
them with electronic input, re-purpose them, store them, and submit them to a networked
printer for printing.

When submitting jobs to the networked printer, the FreeFlow application typically uses
a process known as the Production Print Path. Production Print Path software sends a
submitted print job file (and its associated print job ticket) from the FreeFlow Print Server
to the printer in the user's choice of TIFF, PCL, ASCII, PDF, and PostScript page description
language/file formats.

If desired, the Production Print Path software provides the ability to convert PDF
documents to PostScript format for printing, by means of a Convert PDF files to PS
option. Clicking either the Add Printer or Edit Printer buttons within the Printer Settings
dialog of the Printer Administration application provides access to this option. Similar
conversion of PDF files to PostScript, at print time, can be accomplished using the Quick
Print utility.

Note that a Common Print Path is also available with FreeFlow enabling both
monochrome and color printing to an expanded list of Xerox and third party printers.
The main differences between the Common Print Path (CPP) and the Production Print
Path (PPP) are:

• With CPP, the file is embedded in a PostScript stream and is transmitted by LPR, not
FTP.

• With CPP the transfer speed is approximately half that of PPP.
• Job ticket attributes are limited with CPP.

For complete information on all of the capabilities of the FreeFlow Prepress Suite and
production printing, refer to the customer documentation that came with the system.
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Configuring the Printer
1. Refer to the Setting Up TCP/IP procedure in the Required Set Up Steps section of this

guide to verify that the printer has a valid IP Address, Subnet Mask, and Default
Gateway address for your network.
If you will be using the printer's host name for workstation to printer communications,
make sure that DNS is enabled and that the DNS Server is configured to support host
name to IP address resolution.

2. Refer to the IPP procedure in the NOS Selection Menu section of this guide to enable
IPP on the printer.

3. Refer to the Enabling Raw TCP/IP (Port 9100) procedure in the NOS Selection Menu
section of this guide to enable Port 9100 in support of IPP printing.

4. Refer to the TCP/IP (Enabling LPD for LPR) Printing procedure in the NOS Selection
Menu section of this guide to enable the Line Printer Daemon in support of any jobs
that might be sent using LPR.

5. To make sure that FTP is enabled, log on to the system as System Administrator using
the Logon menu.
a) Enter the System Administrator password (administ, for example).
b) From the Setup menu, select FTP/Remote Diagnostics.
c) Select Enable FTP, then select OK.

6. Make sure that the system's Security Profile is set to None, Low, or Medium to enable
(non-secure) FTP communications with previous releases of DigiPath workstations.
Refer to the Selecting and creating Security Profiles procedure in the Recommended
Set Up Steps section of this guide for instructions.

7. Refer to the Checking Installed Options with License Manager procedure in the
Required Set Up Steps section of this guide to verify that the printer is licensed to
support the page description language/file formats being submitted by FreeFlow
applications.
Contact your Xerox representative to purchase any additional licenses that you need.

Configuring FreeFlow

Follow the instructions that came with your FreeFlow to add the printer to your system.
This may involve the installation of a print driver, or the use of the Add Printer button
on the Printer Settings dialog of the Printer Administration application. Once the printer
has been added to the system, send a test print to the printer to verify successful network
communications.

Note
For helpful information concerning the set up of IPP printing on Windows workstations,
see the IPP Printing procedure in the Print Drivers section of this guide.
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Changing Printer Default Settings
For systems without the Productivity Pack license, the Defaults selection from the Printer
menu is available to users to change printer default settings.

Examples of the some of the settings that can be changed are the default settings
associated with the Output, Image Quality, and Image Edit tabs of Copy or Print Services.
Once these default settings have been changed and saved, the new default settings will
be displayed to users whenever they access the Output, Image Quality, and Image Edit
tabs of the system's Copy or Print Service.

A good example of the reason for changing printer default settings is seen in the following
example. If system users tend to copy or scan a great number of the same type of original
documents, you can set custom image quality defaults accordingly. For instance, if the
majority of copying/scanning is of dark photographic content, the system defaults can
be set to accommodate this, thereby saving system users valuable job programming
time.

Note
An available PDL Tab enables you to change the printer's default resolution settings for
the supported Page Description Languages of PostScript/PDF, TIFF, and PCL. The factory
default resolution setting is 1200 x 1200 x 1 for all systems (those that do have or don't
have the Productivity Pack license enabled). A number of settings are available for each
PDL, which will be used by the printer to set the resolution of those jobs whose resolution
is not specified within the job's printer job language (settings forwarded by the print
driver to the printer).

To change Default Settings, perform the following steps:
1. Log on to the system by selecting Logon from the Logon menu.
2. Select System Administrator as the user from the User Name drop-down list box.
3. Enter the System Administrator password and click OK.
4. From the system's Printer menu, select Defaults.
5. Click on the tab corresponding to the settings you are interested in viewing or

changing.
6. Select the setting that you wish to view or change.
7. Modify the setting as required.

For help with definitions of the various settings, click the Help button.

8. Click OK or Apply to save your settings. To exit the window without making changes,
click Cancel.
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Accessing Billing Information
Depending upon the terms of your purchase agreement, you may need to access print
billing information to support billing by Xerox. Also, during a service call, you may be
asked to retrieve billing information to assist a Service Representative in identifying any
problems with your system. The ability to access and print billing information is typically
restricted to individuals with Operator or System Administrator privileges. Individuals
can be granted these privileges through use of the Users & Groups... selection of the
Setup menu, as stated in the Managing User access to the system procedure, in the
Recommended Set Up Steps section of this guide.

To access billing information, perform the following steps:
1. Log on to the system by selecting Logon from the Logon menu.
2. Select System Administrator as the user from the User Name drop-down list box.
3. Enter the System Administrator password (administ, for example) and click OK.
4. From the system's Administration menu, select Billing.
5. With the Billing window open, you can print out the displayed information, or provide

it to the Service Representative if contacting by phone.

Setting System Preferences
Settings available for configuration

After initial installation, the system can be set up to meet the needs of specific work
environments through the System Preferences selection of the Setup menu.

Note
When you make changes in settings under a tab area and then switch to another tab,
the changes made under the first tab are saved. Use Cancel prior to exiting a tab if
changes are not to be saved.

A tabbed window provides access to the following system settings:

• International Tab: International settings enable you to configure the language and
various display formats that appear on the print server, banner pages, and on billing
and accounting records, for the culture and environment in which the system is
installed.

• Save Tab: Save settings enable you to configure the directory location used to store
saved jobs submitted by a client. The Save location may be an upper level directory,
with subdirectories for each user or type of job. The default location on the FreeFlow
Print Server is /var/spool. Background Forms can be saved in FreeFlow Print Server as
multiple directories or through Network Printer Services (NPS) in one directory.

• PPML Tab: Set PPML Job Package Resource Directory path.
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• Job Processing Tab: Job Processing settings enable you to set the scheduling mode,
job processing order, and TIFF image position. Note that the Scheduling Mode is
used to specify how jobs that require unavailable paper stock or finishing options are
handled by the system. Hot Folders polling time is set here.

• Job Policy Tab: Set properties for overlimit finishing and set size checking, partitioning,
proof quantity, resolve 2nd side conflicts and set cancel inactive jobs after timeout.

• Font Site Policy Tab: Font Site settings enable you to specify the substitution of
PostScript fonts available on the system for fonts, requested by jobs, that are not
available on the system.

Note
After adding/deleting fonts, FreeFlow Print Server must be restarted before the fonts
are successfully added/deleted.

• Stocks and Trays Tab: Depending on the printing system you are using, the Stocks
and Trays settings enable you to show advanced stock attributes, allow stock
substitution, allow multiple stocks in paper trays, create names for stocks and set
tray confirmation notification process.

• Remote Workflow Tab: Remote Workflow settings enable or disable the ability to
remotely communicate with the FreeFlow Print Server (running version 4.00.00 or
higher software), using Remote Workflow software installed on networked workstation.
If the Enable All Connections radio button is selected (enabled), the FreeFlow Print
Server user interface can be displayed on the workstation, allowing a System
Administrator or Operator (Trusted User) to access the system for printer status, job
management, queue management, and administration functions.

• Default Screen Tab: The default screen settings ensure that walk-up users see the
same user interface screen every time they use the system. A pull-down menu enables
the selection of the screen to be displayed. Timeout settings are provided for
configuring the elapsed time of inactivity before users are logged out of the system,
helping to enforce system security.

Accessing System Preferences
1. Log on to the system by selecting Logon from the Logon menu.
2. Select System Administrator as the user from the User Name drop-down list box.
3. Enter the System Administrator password ( administ, for example) and click OK.
4. From the system's Setup menu, select System Preferences.
5. Click on the tab corresponding to the settings you are interested in viewing or

changing.
6. Select the setting that you wish to view or change.
7. Modify the setting as required. For help with definitions of the various settings, click

the Help button.
8. Click OK or Apply to save your settings. To exit the window without making changes,

click Cancel.
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Supporting CentreWare Web
CentreWare Web is a web site application installed on a Windows Print Server that
enables the installation, configuration, monitoring, management, and troubleshooting
of printers on the network from a remote workstation using a web browser.

For the latest information on CentreWare Web refer to
http://www.xerox.com/centrewareweb.

Printers and Servers can be added to (and deleted from) the web site's database manually
from the Printers page, or can be configured for on-demand or scheduled discovery by
SNMP over the IP/IPX network from the Discovery selection of the Administration page.
When using Discovery, for each SNMP-compliant printer that responds to an SNMP GET
REQ packet, CentreWare Web will identify the printer and store information about it in
its database. This information can then be viewed from the Printers page by performing
a search, or by selecting the printer from the navigation tree in the left pane of the page.

Using the Install Wizard from the Wizards page, print queues can be added or deleted
from both the local Server and from remote servers that CentreWare Web is permitted
to manage.

From the Network and SNMP selections of the Administration page, CentreWare Web
is set up with polling frequency and GET Community Names to retrieve information
from printers by SNMP. The Reports page enables you to create, display, and e-mail
reports or links to reports about assets, status, accounting, and printer alert history
information. For accounting and alert history reports, you define the information to
collect for the report from the Historical Data selection of the Administration page.

From the Troubleshoot selection of the Wizards page, the Troubleshoot wizard can be
used to automatically query printers and any associated print servers having problems.
The Troubleshoot Wizard queries two printer status-related Object Identifiers (OIDs)
and makes a Remote Procedure Call (RPC) to any associated print server to retrieve the
latest print queue status. The results of the Ping test and the status queries are then
displayed on the page.

Installing the Software
1. Access the Xerox website at http://www.xerox.com/centrewareweb.
2. Locate and download the CentreWare Web user (installation) guide.
3. Locate and download the software and follow the installation instructions supplied

in the user guide.

For managing print queues on Windows Servers, select an administrator account and
password. This account must have administrative privileges on any servers where
CentreWare Web will manage queues.
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Installation onto a hard disk formatted with NTFS (NT File System) is recommended,
since NTFS is required to enable security with CentreWare Web.

To install onto a Windows Server, you must install IIS from the Windows Server
installation media.

Accessing the CentreWare Web home page
1. From a networked workstation, using a web browser, type in the name of the server

where CentreWare Web is installed.
For example, http://MyServer/CentreWareWeb.

Note
Check your browser's connection settings to make sure that you are not using a proxy
server to connect to local area network addresses.

2. When the CentreWare Web home page displays, click on one of the links to start
using the features and functions of the program.

Configuring the system to communicate with CentreWare Web
1. Verify that TCP/IP is correctly configured with a valid TCP/IP Address, Subnet Mask,

and Gateway as stated in the Setting Up TCP/IP procedure in the Required Set Up
Steps section of this guide.

2. Verify that SNMP is correctly configured as stated in the Configuring SNMP procedure
in the Recommended Set Up Steps section of this guide.

Power saver setup
Accessing the Power Saver Feature
1. Log on to the system by selecting Logon from the Logon menu.
2. Select System Administrator as the user from the User Name drop-down list box.
3. Enter the System Administrator password (administ, for example) and click OK.
4. From the system's Printer menu, select Power Saver Setup.
5. Use the system mouse to place a check mark in the check box of the setting that you

wish to configure.
6. Modify the setting as required.

For help with definitions of the various settings, click the Help button.

7. Click OK or Apply to save your settings. To exit the window without making changes,
click Cancel.
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Configuring Switches (including banner
pages)
The Switches... selection of the Printer menu allows a logged-on System Administrator
to configure the settings for such features as Administrative Pages (the printing of
banner or error pages), two-sided printing, and the use of the printer's attention light
when problems (faults) occur.

Accessing Switches
1. Log on to the system by selecting Logon from the Logon menu.
2. Select System Administrator as the user from the User Name drop-down list box.
3. Enter the System Administrator password (administ, for example) and click OK.
4. From the system's Printer menu, select Switches.
5. Select the setting that you wish to configure.
6. Modify the setting as required.

For help with definitions of the various settings, click the Help button.

7. Click OK or Apply to save your settings. To exit the window without making changes,
click Cancel.

Scan to Digital (File) feature
The Scan to Digital (File) feature allows system users to save scanned documents in
single-page or multi-page TIFF, or PDF, digital file format and to store these files in the
location specified in the tabbed dialog associated with this feature. Note that the
single-page TIFF format saves each page of the job as an individual TIFF file, whereas
the multi-page TIFF format saves the entire job as a single TIFF file. The destination
(Save Location) for the scanned files can include local folders on the system's hard drive,
available system drives, and network drives (if available).

To use this feature, perform the following steps:
1. Log on to the system, unless Automatic Logon (which is enabled or disabled in the

system's Security Profiles) makes this step unnecessary.
2. Select Scan to File from the displayed list of Services.
3. In the Job Name entry box, type in a name for the scan job.
4. In the Save Location entry box, type in the location (if known) in which to save the

scanned file, or click the Save Location button and use the directory window to
browse to a desired directory and folder.

5. Use the tabs of the Scan to File dialog to program the individual settings for the scan.
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6. Click the Start button to begin the scan.
7. If necessary, log off of the system when done.

Changing the default save directory
To change the default save directory in FreeFlow Print Server:
1. From the Setup menu, select System Preferences.
2. Select the Save tab.
3. Select a parent directory. You can choose either the actual directory you want, or one

that you can browse from.

Note
While it is possible to save jobs to the root directory and /opt directory, you cannot
reprint from them with operator privileges. It is strongly recommended that you
create a new directory where jobs can be saved for reprint and easily accessed by
the operator.

4. Select the save directory from the tree view. The directory must be highlighted which
will change the unlabeled path at the bottom of the Parents Directory window to
indicate the saved directory).

5. Click OK.

Note
Even though the Jobs text box is labeled Parent Directory, do not enter the value you
want for the saved directory and click OK. This will just change the root of the tree view
below it. You must select the directory you want.

Performing a data (disk) overwrite
This procedure enables the System Administrator to erase sensitive data from all hard
disks (for example, the system disk and image disks). The erase algorithm and patterns
conform to U.S. Department of Defense overwrite requirements.

Note
This feature requires the presence of the Disk Overwrite software and license in order
to function. The Disk Overwrite software is on a CD included as part of the Disk Overwrite
kit. The software must be installed before enabling the license. To verify whether this
license is present and enabled on the system, refer to the Checking Installed Options
with License Manager procedure, in the Required Setup Steps section of this guide.

To overwrite the data on your hard disks, perform the following steps.
1. Log on to the system as System Administrator.
2. From the System menu, select Data Overwrite.
3. When prompted, note the standard items that will be overwritten and select any

additional items that you would like to be overwritten.
4. Select other desired Options, such as Use Fast Mode.
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Note
Fast Mode is a single pass sanitization of the disk for customers who want to erase
the disk but do not need the extra security required by the U.S. Department of Defense.

5. Select OK to proceed. To exit the window without proceeding, select Cancel.
6. An informational window is displayed. Carefully consider the information provided

and then click OK to proceed. To exit the window without proceeding, click Cancel.
7. The FreeFlow Print Server user interface and the Solaris operating system shut down.
8. The system reboots into Single User mode and requests the root (UNIX super user)

password. Enter the root password (which can be obtained from the Xerox Customer
Technical Support Center) and press Enter.

9. A warning message is displayed asking you if you are sure that you want to start the
Data Overwrite process. Type Y or Yes and press Enter. N or No will exit.

10. The Disk Overwrite process starts.
11. If, for some reason, the process needs to be halted, press the CTRL and C keys. The

system will clean up and boot back to FreeFlow Print Server.
12. When the Disk Overwrite process has successfully completed, the system will reboot.

The Disk Overwrite process maintains a detailed log of the entire process, including the
start and stop time for each partition, the partition name and boundaries, verbose
messages, and error messages. The log file is cumulative and every time the process is
run, details are added to the existing log. The file is maintained in
/var/spool/XRXnps/log/dataOverwrite.log. On a regular basis, the log file should be backed
up and deleted from the system.

Setting up auto export
The Automatic Export/Purge tool automatically saves the accounting log whenever the
log reaches eighty percent of its file capacity; regardless of the number of accounting
log entries chosen. For example, you can choose between 400 and 1000 log entries and
the export will still occur at 80%. Use the following procedure to set up Auto Export.

To set up Auto Export
1. Log on to the system by selecting Logon from the Logon menu.
2. Select Operator (or System Administrator) as the user from the User Name

drop-down list box.
3. Enter the Operator (or System Administrator) password and click OK.
4. From the system's Administration menu, select Accounting.
5. When the Accounting window opens, wait for the accounting log to be retrieved, and

then click the Options button.
6. Under Automatic Export / Purge, click Enable and select Settings.
7. From the Automatic Export / Purge Setup window, select the directory from the

mounted file systems.
8. Select your desired File Properties using the drop-down menus, such as File Format,

Version, Type, and Encoding.
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For information on these File Properties, select Help. From the FreeFlow Print Server
Help menu, select Administration  > Using the Administration menu  > About
accounting  > Exporting the Accounting Log.

9. Click OK.

Tip
The accounting log can be disabled and job information will not be recorded.

Manually exporting the accounting log
It may not be necessary to perform this procedure if the Automatic Export/Purge tool
has been enabled. The Automatic Export/Purge tool will automatically save the
accounting log whenever the log reaches eighty percent of its file capacity. Automatic
Export/Purge tool options are available by clicking the Options button on the Accounting
window, accessed from the Accounting selection of the system's Administration menu.
If you use the Automatic Export/Purge tool, make sure that you know where the log file
has been placed.
1. Log on to the system by selecting Logon from the Logon menu.
2. Select Operator (or System Administrator) as the user from the User Name

drop-down list box.
3. Enter the Operator (or System Administrator) password and click OK.
4. From the system's Administration menu, select Accounting.
5. When the Accounting window opens, wait for the accounting log to be retrieved,

then click the Export button.
6. When the Export Accounting Log window opens, select the directory in which you

want to save the accounting log file. Make sure it is a directory from which you will
easily be able to retrieve the file.

Note
It is recommended that you create a directory specifically for the accounting files.
This will make them easier to locate and manage. For example: /opt/accounting.

7. Select the desired file properties such as Type, Encoding, and File Format. You may
have to experiment with the correct format to allow direct import into a spreadsheet
or database. Standard formats such as Tab or Comma Separated Value files are the
easiest.

8. Specify the records to export by choosing a single Job ID, a range of Job IDs, or All.
9. Click OK.

10. The accounting records will be saved in the desired format with a file name prefix of
AccExport and a date and time stamp. When multiple files are stored, it is
recommended that they be placed in a tar file to preserve the full file names.

11. After this operation has been performed, you may purge the accounting log if desired.
Be certain that the data was exported correctly before purging.

12. Once you have checked the data, click the Purge button.
13. When prompted to confirm that you wish to purge the log, click OK.
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Tip
Operators or administrators can export the log manually and then purge. This will remove
the status and the log will then repopulate as jobs run.

Copying the accounting log file to an FTP server
After this operation has been performed, you may purge the local system's accounting
log, if not already done. To prevent data loss, be certain that the server files are complete
and that the transferred data is correct, prior to performing a local system data purge.
1. Log on to the system by selecting Logon from the Logon menu.
2. Select Operator (or System Administrator) as the user from the User Name

drop-down list box.
3. Enter the Operator (or System Administrator) password and click OK.
4. From the System menu, select UNIX Terminal Window.
5. Start a client FTP session with the command ftp and press Enter.
6. Connect to the desired FTP server and change (cd) to the directory in which the

accounting files will be stored.
If necessary, see the FTP commands primer at the end of this document.

7. Use the lcd command to change to the local directory where the exported accounting
files are stored.

8. You may want to enter a prompt command in order to transfer multiple files without
having to confirm each transfer. If you do this, the screen will display Interactive
mode off. A hash command will also let you see the transfer activity if desired.

9. Transfer the files with the put or mput commands.
10. Verify that the files were transferred with the ls l command.
11. When finished, end the FTP session with the bye command.

Manipulating the data for import into Equitrac
This process enables the person responsible for entering the data into Equitrac to
eliminate extraneous data and place the data in the correct order to allow it to be
imported.
1. Copy the accounting file(s) from the FTP server to the local computer with another

FTP client session or graphical FTP tool.
If it is necessary to use a text-based ftp, see the FTP commands primer at the end
of this document.

2. Open or import the accounting log export file. It is recommended that this be done
first with a spreadsheet program as it allows data to be excluded and manipulated
easier.

3. Delete any columns in the spreadsheet that contain data that is not needed. These
things may include Elapsed RIP time, Complexity Induced Skips, etc.

4. Once all deletions have been made, arrange columns in the order in which Equitrac
would like to import them.

5. Remove the header row if desired.
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6. Save the file or export the file as a CSV (comma separated value) file or TAB delimited
file.

7. The file can then be imported to a database program such as Microsoft Access and
appended to an existing database table.

8. Save the file for use in Equitrac.

FTP commands primer

ActionCommand

Starts FTP session on local computerftp

Connects to server with IP address of
xxx.xxx.xxx.xxx or ftp.remote.com.

open xxx.xxx.xxx.xxx or ftp.remote.com
(The latter only works if there is a valid DNS
server and entry.)

Changes directory on remote servercd

Changes directory on local computerlcd

Displays current working directory on remote
server

pwd

put single file or mput multiple filesput or mput

get single file or mget multiple filesget or mget

Set transfer mode to ASCIIascii

Set transfer mode to binarybinary

Toggles prompting for each file in a multiple
file transfer

prompt

Displays hash marks (usually #) for each block
of data transferred

hash

Displays a list of available commandshelp

Exits the FTP sessionquit or bye

Using the Release Jobs/Don't Release
Jobs option
Only for systems without the Productivity Pack license, the Release Jobs/Don't Release
Jobs option allows Operators or System Administrators to hold jobs in the Active Jobs
queue, with a displayed status of Pending. To hold jobs sent to the queue, select Don't
Release Jobs from the system's System menu. The held jobs can be released at any
time as an entire group of jobs or as individual jobs. To release the entire group, select
Release Jobs from the System menu. To release individual jobs, use the system mouse
to select the pending job in the Active Jobs queue, right-click the mouse, then select
Release from the pop-up menu.
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To use this feature, perform the following steps:
1. Log on to the system by selecting Logon from the Logon menu.
2. Select Operator (or System Administrator) as the user from the User Name

drop-down list box.
3. Enter the Operator (or System Administrator) password and click OK.
4. From the System menu, select Don't Release Jobs.
5. From the Logon menu, select Logoff.
6. At the appropriate time, log back on to the system as Operator (or System

Administrator).
7. To release the entire group of jobs being held in the Active Jobs queue, select Release

Jobs from the System menu.
8. To release individual jobs being held in the Active Jobs queue, use the system mouse

to select the pending job in the active queue, right-click the mouse, then select Release
from the pop-up menu.

9. From the Logon menu, select Logoff.

Saving Files to Network Drives
Accessing the Network Filing capability

When correctly configured, the system supports network filing using FTP or SMB in a
TCP/IP environment. The system can also be set up to support filing to mounted NFS
(Network File System) shared (Linux/UNIX/Windows running Services for UNIX) drives.

Users can access this capability in several different ways, including:

• Clicking the Copy button, then selecting the Advanced tab (NFS only).
• Clicking the Scan to File button, then selecting the Basic tab (FTP, SMB, and NFS).
• Clicking the Job Manager button, selecting a job, choosing Properties, then selecting

Destination (NFS only).
• Clicking the Job Manager button, then selecting the Saved Tab (NFS only, for systems

without the Productivity Pack enabled).
• Clicking the Print button, then selecting Saved Jobs from the Directory pull-down

menu (NFS only, for systems with the Productivity Pack enabled).

Using the Destination or Save Location Settings (FTP/SMB only)

Regardless of the displayed name, the purpose of the Destination or Save Location
settings is to enable users to save jobs to Network (and other available system) drives.

To save a file to a network drive, perform the following steps:
1. Access the Destination or Save Location Settings by clicking one of the buttons shown

in bold face type above.
2. When available (through the Copy button, for example), select either the Print &

Save or the Save radio button to enable the Save Location settings.

7-19Xerox® Nuvera®

System Administrator Guide

Configuring System Features



3. When available, click the Save Location button.
4. Select your method of saving from the Directory drop-down menu.
5. When prompted, enter in the requested Server Log On information and click OK.
6. If network authentication is successful, select your destination directory from the

displayed list of Server directories and click OK.
7. From the Save Format drop-down menu, select the format that you wish to use when

saving your file.
8. With your document loaded into the document handler, click Start to scan and save

your job.

Communication Settings Required to support Network Filing

Make sure that TCP/IP and DNS are properly configured  as stated in the Setting Up
TCP/IP procedure contained in the Required Set Up Steps section of this guide. If DNS
is not correctly set up, you will have to refer to the remote server using the IP Address.

Make sure that your desired filing protocol (FTP or SMB) is enabled by logging on to
the system as System Administrator, then selecting [ Network Configuration] from the
Setup menu. Select the SMB/FTP tab, then select [ Enable] as the setting for your filing
protocol. Click OK.

In support of SMB filing, make sure that WINS is enabled, as stated in the Setting Up
TCP/IP procedure in the Required Set Up Steps section of this guide. If WINS is not
enabled, you will have to refer to the remote server using the IP Address. If there is no
WINS server specified, the remote server must be located in the same subnet in order
for the name resolution to succeed.

Setting Up Scan to File with NFS
Note
You must be logged in as root (or sufficiently privileged other user) on your local
Linux/UNIX system in order to perform this operation successfully.

Select a link below based on your system type.

• Setting Up Scan to File with NFS from the Linux/UNIX remote storage system

• Setting Up Scan to File with NFS from the FreeFlow Print Server screen

Setting Up Scan to File with NFS from the Linux/UNIX remote storage
system
1. As root, use the documentation provided with your version of Linux/UNIX operating

system to create a NFS share directory in which you wish to store scanned images.
All NFS requests will be sent using the uid of root, and the gid of xrxgrp. You must
make sure that the NFS share allows write access to all users (other), or at least to
the xrxgrp (gid). Also make sure that the NFS share isnt read-only, and has proper
uid and gid.
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2. Record the IP address and full path to the NFS share. The IP address is recommended
as it will always work, assuming the default router and other network settings are
correct, even without a name service running.
EXAMPLE: <IPaddress> /local/var/spool/data

Note
Be aware that this file system should have enough free space to store the scanned
images and regular backup and purge of old images is important.

Setting Up Scan to File with NFS from the FreeFlow Print Server screen
1. From the main FreeFlow Print Server screen, login as System Administrator with the

correct password.
2. Select the System menu and then select UNIX terminal window.
3. When the terminal window appears, type su then press the RETURN key.
4. Enter the superuser password and press the RETURN key. The system will display a

"#" prompt.
5. Enter the command cd /etc to change to the /etc directory.
6. Enter the command cp vfstab vfstab.bak to make a backup copy of the vfstab file.

In this step, substitute the actual IP Address of the remote system for <Ipaddress>
and substitute the actual directory path on the remote system for
/local/var/spool/data.

7. Enter the command all on one line. There are 6 TAB characters (press the TAB key;
do not type TAB) separating each of the seven entries listed between the quotation
marks.
echo "<IPaddress>:/local/var/spool/data[TAB] - [TAB] /var/spool/XRXnps/saved [TAB]
nfs [TAB] - [TAB] yes [TAB] soft,bg,retry=5" >> vfstab

8. Enter the command poweroff to power the printer off.
9. Wait 30 seconds then power the printer back on. The mount will now be active.

If the mount fails due to an error in the vfstab entry, the original vfstab may be restored
by entering the command cp /etc/vfstab.bak /etc/vfstab from the command line when
logged in as root or superuser.

Support for LCDS
Verifying the presence of the LCDS License

To print LCDS jobs and enable the LCDS Console, you must verify that the LCDS license
(LCDS Interpreter) is installed and enabled on the system. To do this, follow the steps
contained in the Checking Installed Options with License Manager procedure, in the
Required Set Up Steps section of this guide.
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Note
When you install the FreeFlow Print Server software for EPS (Enterprise Printing System),
along with the Groupe Set (Channel) circuit board, and Bus & Tag hardware, you should
see the Online Setup tab under the Gateway selection of the Setup menu, as well as the
Online Manager selection under the System menu. These are required system features
for the support of LCDS (streaming) printing. The channel card is only required for sending
data over bus and tag. You can still send a streaming LCDS job over TCP/IP without the
channel card.

Overview of LCDS

Xerox Line Conditioned Data Stream (LCDS) is a Mainframe to printer, Page Description
Language (PDL) that uses referenced (system-stored) commands, as well as
stream-embedded (Dynamic Job Descriptor Entry) commands, to control the processing
of the incoming print job. This referenced command approach to printing dramatically
reduces bandwidth requirements by locating the final assembly of document elements
on the printer (where resources are stored). This eliminates the need for repeatedly
sending complex elements, like forms, from the host to the printer, as part of the data
stream. The host only needs to send the truly variable data to the printer. The printer
provides the ability to control the format of the final printed page, from outside the
application generating the variable data. A simple way to visualize this type of printing
is to think of preprinted forms where the printer prints variable information into blank
areas of the form.

To support LCDS, the Operator or System Administrator needs to make sure that the
files containing the appropriate processing commands (JDL/JDE) and supporting resources
(such as forms and fonts) are installed on the system, under LCDS Resources. The System
Administrator should also create and dedicate at least one specific queue on the system
to process LCDS (streaming) jobs.

Note
Additional queues can be set up, through Queue Manager, each with different parameters
that are pre-programmed for processing specific LCDS jobs routinely sent to the printer.
Individual queues can also be set up for spooling, rather than streaming. For LCDS jobs
sent over a TCP/IP connection, instead of through the Bus & Tag channel, make sure to
enable VPS (VTAM Print Service) on Port 9100 and select the desired LCDS queue from
the drop-down list.

Refer to the LCDS License documentation

For complete LCDS job printing and queue setup information, refer to the LCDS Print
documentation that is provided along with the LCDS license software CD.
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Support for IPDS
IPDS (Intelligent Print Data Stream) is a page description language (PDL) developed by
IBM to serve their advanced function printing (AFP) environment. This data stream
enables a two-way dialog between the printer and the host's print driver resulting in a
cooperative print management system. The data stream then contains all the information
necessary to identify, monitor, and control the functions of the printer.

Note
You must have the Productivity Pack license enabled to print IPDS jobs.

Verifying the presence of the IPDS License

Verify that the IPDS license is installed and enabled on the system. You must have this
license to print IPDS jobs, as well as to set up IPDS using the graphical user interface.
To do this, follow the steps contained in the Checking Installed Options with License
Manager procedure, in the Required Set Up Steps section of the IPDS User Guide.

Setting up IPDS Queues

To add an IPDS queue and to manage IPDS jobs, refer to the IPDS User Guide.

Setting Up a Foreign Device External
Controller
A Foreign Device External Controller is a physical device connected to the system through
a 15 pin cable and circuit board (Foreign Device Interface) which allows control of
printing and/or copying by an external device. The Xerox Customer Service Engineer
installs the optional Foreign Device Interface into the system. The customer is typically
responsible for supplying the External Controller. After connecting the External Controller
to the Foreign Device Interface, the software setup of externally controlled printing
and/or copying is accomplished by the Xerox Customer Service Engineer or the System
Administrator as follows.
1. Log on to the system as System Administrator.
2. From the Setup menu, select FDI.
3. Beginning with the Select Device dialog, select Enabled for the External Controller

Setting.
4. From the displayed list, select your External Controller Type. If you do not know which

type of external controller will be used, select Pay Per Page Device.
5. Click Next.
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6. On the Inhibit Services dialog, select which services you would like controlled by the
external device.

7. Click Next.
8. On the Job Setting dialog, select which feature you would like to be indicated by the

Premium Pin.
The Premium Pin selection allows you to indicate when a premium feature is being
used for billing purposes.

9. Click Next.
10. On the Job Timer dialog, select Enabled or Disabled to use the Cancel Job Timer.

This timer specifies how much time a user is given to provide money or another form
of credit before the system automatically deletes the job.

11. Click Next.
12. On the Page Exclusions dialog, select any pages that you would like to be excluded

from customer billing.
13. Click Next.
14. On the Usage Counter Settings dialog, select any features that you would like to

count double (provide two feed or exit pulses) for when billing. By default all features
are counted once.

Note
When using a double count and a device is attached that must make a calculation
on remaining credit, such as a magnetic card reader or coin device, it may be necessary
to adjust the feed or exit pulse width to a greater time in order to achieve accurate
billing. The maximum time is 100 milliseconds. When set to this length, your system
performance may be affected depending on other settings and the paper size being
used.

15. Click Finish.
16. Respond to the Informational Message by reading the message, performing any

additional, recommended actions, then clicking OK.

Removing a Foreign Device External Controller
1. Log on to the system as System Administrator.
2. From the Setup menu, select FDI.
3. Beginning with the Select Device dialog, select Disabled for the External Controller

Setting.
4. Click the next button repeatedly to move through all the screens.
5. At the last screen, the Next button will change to a Finish button.
6. Click Finish.
7. Power down the system and remove the Foreign Device.

Xerox® Nuvera®7-24
System Administrator Guide

Configuring System Features



Related Hints and Tips

When a Xerox Auditron/Accumulator is in use
and the operator is clearing a jam or performing
a task, Auditron can time out. The operator will
then need to re-enter their account number. To
avoid this situation, the system administrator
can either increase the amount of time before
the timeout occurs in Auditron, or disable the
timeout feature.

Accumulator device timed out

Foreign Device has an inherent problem "cred-
iting" when a job is deleted directly from the
queue (as FreeFlow Print Server is unable to in-
form PSIP of this occurrence). Do not delete
jobs controlled by the Foreign Interface Device
directly from the queue. Use the Wizard to en-
able and configure the Cancel Job Timer fea-
ture and allow the Cancel Job Timer to automat-
ically delete the unneeded jobs when they ex-
pire.

Deleting jobs

Multi-Up print jobs controlled by the Foreign
Device Interface cannot be charged a premium
or double-counted.

Multi-Up jobs

Configuration Backup and Restore
The Configuration Backup and Restore (CBR) tool has two functions: it saves the current
configuration state of the FreeFlow Print Server (FFPS) and it allows for the saved
configuration state to be restored to the FFPS at a later time.

Examples of information contained in the CBR tool backup:

• User TRC's
• FFPS License Data
• Queues
• Stock database
• DFA devices

Common uses
Note
The current version of the CBR tool does not support the restore of FFPS configurations
prior to version 5.1.
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One of the most common uses of the CBR tool is to backup the current configuration
state of the FFPS prior to reformatting the server hard drive. Once the FFPS software is
reinstalled, the CBR feature is used to restore the previously used configuration.

How to create a configuration backup
A user must log in as a System Administrator or Operator to create a configuration
backup.
1. Select the System menu and hover the mouse cursor over Backup / Restore.
2. Select Backup Configuration.
3. Hold the CTRL key and select the available categories to include in the configuration

backup.
4. Select Continue.

An archive size estimate displays.
5. Select OK to begin the configuration backup.

As the FFPS is creating the configuration backup, each category selected for backup
displays the current state of the backup process.

These states include:

• Pending - This state indicates that the CBR tool is waiting for resources to be available
before it can backup a category.

• In Progress - This state indicates that the CBR tool is currently backing up a category.
• Done - That state indicates that the CBR tool has completed backing up a category.
• Failed - This state indicates that the CBR tool has encountered an error when backing

up a category. Contact a Xerox service representative if this error is encountered.

How to restore a configuration backup
A user must log in as a System Administrator or Operator to restore a configuration
backup.
1. Select the System menu and hover the mouse cursor over Backup / Restore.
2. Select Restore Configuration.
3. Hold the CTRL key and select the available categories to include in the configuration

restore.
4. Select Continue to begin the configuration restore process.

An information window displays.

5. Select OK.

Limitations
• The CBR tool only saves a backup file to supported devices (CD-R, CD-RW, USB flash

device)

- CD-R discs that already contain data cannot be used to save a backup file
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- CD-RW discs and USB flash devices that contain a different file system than is
used for FFPS cannot be used to save a backup file, however these discs can be
reformatted to be compatible

• The CBR tool cannot backup or restore categories that are not selectable when
performing a configuration backup or restore

• The CBR tool cannot backup data that is larger than a single CD-R, CD-RW or USB
flash device

• The CBR tool cannot backup Operating System specific configuration data
• The CBR tool cannot backup to tape storage devices
• The CBR tool only restores saved configuration categories

- The FFPS does not automatically integrate all restored configuration categories
into the current FFPS

- Some information such as license files and calibration data need to be manually
setup by the user

Enabling Transport Layer Security
(TLS/SSL)
Transport Layer Security (TLS) is a network security protocol used to encrypt and transmit
data by HTTP and IPP (Internet Printing Protocol) over the TCP/IP network. While TLS
is sometimes compared to as SSL, the two protocols are different enough to prevent
their interoperability. As part of the communication process, the network client and
printing system (server) determine the protocol to use (either TLS or SSL) for data transfer
and communication.

With TLS/SSL enabled, and a digital certificate installed, remote users accessing the
system over an HTTP-based interface (such as Internet Services) are assured of having
their network communications protected against eavesdropping and tampering, using
strong encryption. The only action required by workstation users is to type https://,
followed by the IP address (or fully qualified domain name) of the system, into the
Address or URL box of the web browser application. The subsequent acceptance of a
Digital Certificate completes the exchange of the Public Key enabling the encryption
process to proceed.

Installing a Self-Signed Digital Certificate
TLS/SSL cannot be enabled unless a digital certificate is installed on the system using
the Add Certificate button. To install a self-signed certificate, perform the following
steps:
1. Log on to the system by selecting Logon from the Logon menu.
2. Select System Administrator as the user from the User Name drop-down list box.
3. Enter the System Administrator password and click OK.
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4. Select SSL/TLS from the Setup menu.
5. Click on the Add Certificate button to begin the Add Certificate Wizard.
6. Select Self-Signed Certificate, when prompted.

A self-signed Digital Certificate is inherently less secure than installing a certificate
signed by a trusted, third party Certificate Authority (CA). However, specifying a
self-signed certificate is the most convenient and easy way to start using SSL/TLS.
A self-signed certificate is also the only option if your company does not have a Server
functioning as a Certificate Authority or does not wish to use a third party CA.

7. Perform all of the remaining, self-explanatory, Wizard steps.

Generating a Certificate Request to a Certificate Authority
In addition to installing a self-signed certificate on the system, you can generate a
certificate request to a Certificate Authority as follows:
1. If not already logged on, log on to the system as System Administrator.
2. Select SSL/TLS from the Setup menu.
3. Click on the Add Certificate button to begin the Add Certificate Wizard.
4. Select Signed Certificate from a Certificate Authority, when prompted.
5. Supply the information requested by the Wizard, such as your fully qualified domain

name, IP address, Organization, and Country.
6. When prompted, save the Certificate information file (request) in your directory of

choice on the system, or on a CD in the CD Read/Write ROM drive.
7. Send the request to the Certificate Authority using a CD, email, or FTP.
8. When you receive the Certificate back from the Certificate Authority on CD, by email,

or by FTP, if necessary (not using a CD), store it in your previously chosen directory.
9. Log on to the system as System Administrator and select SSL/TLS from the Setup

menu.
10. Click the Install Received Certificate button.
11. Specify the directory on the system, or the CD in the CD ROM drive, containing the

signed Certificate from the Certificate Authority.
12. Click Install.

Enabling and Configuring TLS/SSL
1. If not already logged on, log on to the system as System Administrator.
2. Select SSL/TLS from the Setup menu.
3. Click on the box labeled Enable SSL/TLS to enable it.

Note
This setting will be unavailable until a Digital Certificate has been added (installed
on the system).

4. Click on either Normal or Secure for your desired Mode of operation. Normal allows
both secure and insecure communications. Secure allows only encrypted (https or
secure IPP) communications.

• Normal: uses port 80 for HTTP, and port 631 for IPP.
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• Secure: uses port 443 for both HTTP and IPP (both URLs start with https://).

Note
TLS/SSL cannot be enabled unless a digital certificate is installed on the system. All
other items will be grayed out if TLS/SSL is disabled.

5. Select your desired encryption strength from the Encryption Strength drop-down
menu.

6. To view, configure, or remove a certificate, once it has been installed, click the View
Certificate, Configure Certificate Display, or Remove Certificate buttons.

7. Click Close to close the SSL/TLS dialog.

IP Filtering
IP (Internet Protocol) Filtering provides a method for restricting printing access to the
system to specific IP addresses or ranges of IP addresses. Network hosts with IP addresses
outside of the specified addresses or ranges are not permitted to print to the system.
Such restrictions can prove advantageous, for example, in controlling peer-to-peer
network printing through the LPR and 9100 (raw TCP/IP) ports. In this case, access can
be restricted to the IP address or addresses of network Print Servers, requiring users to
print through a server queue rather than accessing the printer directly. Note that IP
Filtering does not constrain the use of outbound connections, such as scanning to the
network (saving files to network drives). IP Filtering applies to the entire set of application
ports upon which the system will accept LPR, IPP, HTTP, HTTPS, Raw TCP/IP printing,
and FTP connections.

Accessing and Configuring the IP Filter
1. Log on to the system by selecting Logon from the Logon menu.
2. Select System Administrator as the user from the User Name drop-down list box.
3. Enter the System Administrator password and click OK.
4. Select IP Filter from the Setup menu.
5. When the IP Filter dialog displays, select the Enable Specified Connections radio

button.
A window opens displaying two transfer boxes, labeled Addresses and Members,
allowing you to specify and modify the IP Addresses permitted to access the system.

Note
Once Addresses have been specified as stated below, they can be transferred to and
from the Members (permitted access) box exactly like transferring files with FTP.

6. To add an address or address range, right-click the system mouse in the left hand
Addresses box and select New from the pop-up menu.

7. Using the IP Edit window, click any one of the three available buttons and enter in
your filtering preferences in the boxes supplied.

8. Provide a name for your IP Address or Address range.
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9. Click Add to add the named address or address range to the left hand Addresses
transfer box.

10. Click on the name of the address or address range to select it, then click the right
facing transfer arrow to transfer the named address or range to the right hand
Members box.

11. Click OK.

To transfer a named address or address range out of the Members box and back into
the Addresses box, select the name in the Members box and click the left facing transfer
arrow.

To edit the properties of a named address or address range, right-click on the name in
either the Addresses box or the Members box and select Edit from the pop-up menu.

To delete a named address or address range, transfer the name from the Members box
to the Addresses box, right-click on the name, and select Delete from the pop-up menu.

Support for FreeFlow VI Interpreter
The FreeFlow VI Interpreter (FF VI Interpreter) is an optional software license pre-installed
on the FreeFlow Print Server that you can enable to interpret the VIPP language
(Variable-data Intelligent PostScript Printware). Often VIPP and FreeFlow VI Interpreter
are used interchangeably. However, the FF VI Interpreter refers to the software used to
interpret the VIPP commands. VIPP is used to discuss anything related to the VIPP
commands or VIPP based applications.

The VIPP language is an open programming language that uses the flexibility of
PostScript to construct dynamic documents. VIPP allows variable documents to be
composed at the printer in real time. VIPP uses the same Dynamic Document Construction
concepts as LCDS. Fonts, forms, and images reside in directories on the printer.

Page composition is controlled by interpreting the VIPP commands inside one of the
following:

• Data Base Master (DBM) used to process delimited data,
• Job Descriptor Ticket (JDT) used to process line mode or print ready data, or
• XML Job Descriptor (XJT) used to process a XML data file

These files, along with the resources (fonts, images, forms, etc), are stored in libraries
on the hard drive of the device (or located on a network connected server). Typically,
with documents created using the FF VI Interpreter, only the variable data is sent over
the network at run time.

For complete information about the FreeFlow VI Interpreter and the VIPP language,
consult the FreeFlow VIPP Language Reference Manual on the FreeFlow VI Suite
Documentation CD delivered in the VIPP ship kit.
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Verifying the presence of VIPP software
To verify that the FreeFlow VI Interpreter is installed on the system, use the UNIX
Terminal Window to verify that the /usr/xgf and /usr/xgfc directories exist on the system.
1. Log on to the system as System Administrator.
2. From the System menu, select UNIX Terminal Window.
3. At the shell prompt ($) type su (and press Enter), then type your super user password

and press Enter.
4. At the root prompt (#), type ls -a /usr (with a blank space after ls and -a) and press

Enter.

Note
At the root prompt you could alternatively type the command pkginfo | grep VIP.
This will also give you the name of the installed VIPP package, if present on the
system.

5. See if xgf and xgfc are displayed as directories. If they are, FreeFlow VI Interpreter
software is installed. If they are not, FreeFlow VI Interpreter software is NOT installed.
Typically, the FreeFlow VI Interpreter software is pre-installed on the system.

6. At the root prompt (#), type exit and press Enter.
7. At the shell prompt ($) type exit and press Enter.

Verifying the presence of the FreeFlow VI Interpreter License

To print VIPP jobs in excess of 200 pages (beyond Demo mode), you must verify that
the FreeFlow VI Interpreter license is installed and enabled on the system. To do this,
follow the steps contained in the Checking Installed Options with License Manager
procedure, in the Required Set Up Steps section of this guide.

Installing the FreeFlow VI Interpreter software or license, if needed

To install the FreeFlow VI Interpreter software or license on the system, if needed, follow
the instructions provided in the FreeFlow VIPP Language Reference Manual that is
located on the FreeFlow VI Suite Documentation CD delivered as part of the ship kit.

Storing VIPP Resources on the printer

To support the printing of individual VIPP jobs, resources (Reusable Document
Components) for each job must be stored in various subdirectories of the /usr directory
on the system. These resources consist of Job Descriptor Ticket (JDT) files, Data Base
Master (DBM) files, Forms, and other files identified with file extensions such as .ps, .eps,
.tif, .jpg, and .dbf. Refer to the FreeFlow VIPP Language Reference Manual that
accompanies the FreeFlow VI Interpreter software for a full explanation of these files.

To store resources on the printer, perform the following steps:
1. Log on to the system by selecting Logon from the Logon menu.
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2. Select System Administrator as the user from the User Name drop-down list box.
3. Enter the System Administrator password and click OK.
4. Insert a CD into the CD ROM drive containing the resources to be used with your

VIPP jobs.
5. From the System menu, select UNIX Terminal Window.
6. At the shell prompt ($) type su (and press Enter), then type your super user password

and press Enter.
7. At the root prompt (#), type /usr/openwin/bin/filemgr& and press Enter.
8. Select the CD in file manager and right-click the system mouse on the file you wish

to copy. Select copy from the pop-up menu.
9. Select the desired local directory on the system, and select paste from the pop-up

menu. The following file types should be copied into the indicated directories:

The .jdt files go into /usr/xgfc/jdtlib. The .dbm files go into /usr/xgfc/formlib. The .ps
and .eps files go into /usr/xgfc/formlib. The .tif or .jpg files go into /usr/xgfc/imglib.
The .dbf files go into any library such as /usr/xgfc/mislib. PostScript fonts can be either
installed using the PDL fonts selection of the system Administration menu, or can be
placed in /usr/xgfc/fontlib.

Note
Refer to VIPP Projects for additional information on using VI Projects.

10. When done copying files, select Quit File Manager from the File menu.
11. At the root prompt (#), type exit and press Enter.
12. At the shell prompt ($) type exit and press Enter.

FreeFlow VI Projects

FreeFlow VI Projects allows VIPP applications to print easier. All the resources for a
particular job can now be stored on the system under a single job folder. When the
FreeFlow VI Interpreter is installed, a projects folder is created under the /usr/xgfc
directory. This is a default location, but the user can specify any folder and project name.
A VI Project Container (.vpc) is a compressed version of a job folder. It contains everything
a VIPP application needs to print. FreeFlow Print Server supports the direct printing of
a vpc file through the print path. This makes printing a VIPP application as simple as
printing the .vpc file to a queue. You need to edit the queue properties and select the
filter option. Select one of the three VIPP options for the filter, such as Deploy and Print.
Once a queue is configured with the VI Project Container filter (vpcf) set to “Deploy and
Print", the user can simply lpr (print) a .vpc file to this queue. FreeFlow Print Server
automatically expands the vpd file, installs the VIPP resource files into the correct folder
locations, and runs the applications. Using VI Projects is highly recommended.

Adding a new queue to support the FreeFlow VI Interpreter

To add a new queue to the system, follow the steps contained in the Using Queue
Manager procedure, in the NOS Selection Menu section of this guide.
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Note
Systems with the Productivity Pack license enabled cannot process more than one
streaming job at a single time, regardless of the number of streaming queues existing
on the system.

Dedicating the new queue to process VIPP (streaming) jobs
1. Log on to the system by selecting Logon from the Logon menu.
2. Select System Administrator as the user from the User Name drop-down list box.
3. Enter the System Administrator password and click OK.
4. Open the Queue Manager by selecting Queue from the displayed list of Managers.
5. Select the newly created queue and double click the system mouse to open Queue

Properties.
6. Select the PDL Settings tab.
7. Click the PDF/PostScript button and do the following:

• Protected Queue: Select the Protected radio button to have the queue terminate
any printer settings made by the PS PDL after the job has completed. Select
Unprotected only if you wish PDL changed settings to be maintained from job
to job.

• Initialization File: The purpose of an Initialization File is to place a VIPP header
on a data stream that does not contain the required start command at the
beginning of the data file (such as STARTLM, STARTDBM, or STARTXML). For
typical VIPP data streams, containing the start command, select None for the
Initialization File setting. For VIPP data streams that do not contain a start
command, consult the FreeFlow VIPP Language Reference Manual or contact
your Xerox representative for advice regarding the appropriate Initialization File
setting.

8. Set the desired resolution for the queue. The recommended setting is 600 dpi.
9. Select a finishing device from the Default Finishing drop-down menu.

10. Select the Settings tab.
11. Set the Input setting to Streaming.
12. Click OK.

Setting up Stocks and Trays to support VIPP

Enable Settings under System Preferences to support the VIPP queue
1. If necessary, log on to the system as Operator or System Administrator from the

Logon menu.
2. From the system's Setup menu, select System Preferences.
3. Select the Stocks and Trays tab.
4. Enable the Option labeled Allow Tray Selection by Queue by placing a check mark in

the Option checkbox.
When this Option is enabled, a Stock Selection drop-down menu will be displayed
on the Stock tab of the Queue Manager.
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5. Click OK to save the settings.

Selecting Stocks (feeder trays) to support the VIPP queue
1. If necessary, log on to the system as Operator or System Administrator from the

Logon menu.
2. Open the Queue Manager by selecting Queue from the displayed list of Managers.
3. Select the VIPP queue and double click the system mouse to open Queue Properties.
4. Select the Stock tab.
5. From the Stock Selection drop-down menu, select Program Stock (or Feed Tray).

Note
If Feed Tray is selected, that tray will be used exclusively for all jobs in the queue.
This may not be desirable for VIPP jobs calling for a Stock name which is really a
stock definition using several preferred printer trays containing various sizes of media
(defined using the Stock Library in Printer Manager).

6. From the Name drop-down menu, select a stock name (or stock definition). Click the
Stock List button for more selections.

7. Click OK to save the settings.

Defining Stocks with Printer Manager
1. If necessary, log on to the system as Operator or System Administrator from the

Logon menu.
2. Open the Printer Manager by selecting Printer from the displayed list of Managers.
3. Select the Stock Library tab.
4. Use the View menu to enable the viewing of the Preferred Tray and Auto Size columns

(if not already shown).
5. In the displayed list of stocks, double click on any stock selection line.
6. From the pop-up menu, select New Stock to create a new stock, or Properties to view

the properties of the currently selected stock.
7. Make sure that the stock's Name is the name that you wish to select for queue use

with VIPP jobs.
8. From the Properties dialog, use the system mouse to place a check mark in the Auto

Size Option box.
The Auto Size parameter indicates whether the named stock may be loaded in
different sizes in different (preferred) trays in support of VIPP jobs.

9. From the Properties dialog, use the system mouse to place a check mark in the
Preferred Tray boxes.
Preferred trays are a list of feeder trays indicating the stocks to load in support of
VIPP jobs.

10. Click OK to save the settings.
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Setting up Stackers to support VIPP
1. If necessary, log on to the system as Operator or System Administrator from the

Logon menu.
2. Open the Printer Manager by selecting Printer from the displayed list of Managers.
3. Select the Stacking tab.
4. To set the properties of all system Stackers, select Settings from the Stacker drop-down

menu. To set the properties of individual Stackers, select an individual Stacker in the
Stacking window list and right-click. Select Settings from the pop-up window.

5. Enable the setting labeled Allow PDL Override by placing a check mark in the setting's
checkbox.

6. Click OK to save the setting.

Enabling FTP and NFS to support VIPP
1. To make sure that FTP is enabled, log on to the system as System Administrator using

the Logon menu.
2. Enter the System Administrator password.
3. From the Setup menu, select FTP/Remote Diagnostics.
4. Select Enable FTP.
5. Select OK.

Make sure that the system's Security Profile is set to None, Low, or Medium to enable
(non-secure) FTP communications and NFS (Network File Sharing). Refer to the Selecting
and Creating Security Profiles procedure in the Recommended Set Up Steps section of
this guide for instructions.

DFA Configuration Management
Document Finishing Architecture (DFA) is a set of published specifications that allows
finisher vendors to develop in-line devices that are compatible with Xerox printing
equipment. The FTM is a DFA-compliant device.

The DFA Configuration Management feature in FreeFlow Print Server provides you, the
System Administrator, with the ability to import DFA configurations from another
system's directory for example, view existing DFA profiles, and create configurations
and profiles. A set of default DFA configurations and profiles are preinstalled for each
series of Xerox-approved DFA-compliant finishers installed on the system. Generally, the
DFA profile can be supplied by the finisher vendor and installed at the time of the finisher
installation.

Note
If your system is equipped with a 3rd-party finisher, contact your Xerox Representative
for more information about DFA configurations and for the Xerox Nuvera DFA Resource
Guide.
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Using a Predefined Xerox-Supplied Configuration from the Catalog
The External Finisher window is empty until you import a configuration from the system
directory, CD, USB drive or from the Xerox supplied catalog of configurations available
from the Catalog button.
1. Log on to the system by selecting Logon from the Logon menu.
2. Select System Administrator as the user from the User Name drop-down list box.
3. Enter the System Administrator password and click OK.
4. Select the Printer Manager from FreeFlow Print Server user interface.
5. Select the Finishing tab.
6. Select the Finishers pull down menu and select External Finisher.

The External Finisher screen displays.
7. Select the Catalog button.

A Configuration Catalog window displays listing all the Xerox-supplied configurations
(with profiles).

8. Select your configuration and OK.
The configuration and profiles are imported into your configuration list window. You
now need to enable the profiles to place the configuration online.

9. From the External Finisher list window, expand the configuration to view all of the
profiles contained within it.

10. Select the profile, right-click, and select Enable.
The profile is identified as enabled and the configuration as online.

11. Select Close and program your job settings at the FreeFlow Print Server as usual.

Notice the Name, Description, and Type areas at the right of the External Finisher window.
The Type field indicates whether the configuration was predefined by Xerox or created
and defined by the user.

Importing DFA Profiles and Configurations
1. Log on to the system by selecting Logon from the Logon menu.
2. Select System Administrator as the user from the User Name drop-down list box.
3. Enter the System Administrator password and click OK.
4. Select the Printer Manager from FreeFlow Print Server user interface.
5. Select the Finishing tab.
6. Select the Finishers pull down menu and select External Finisher.

The External Finisher screen displays.
7. Import your DFA configuration by selecting Configuration > Import. Select from

CD, USB drive or File directory and select the Import button.
The imported configuration already contains profiles (you can create additional
profiles for it). You now need to enable the profiles and place the configuration online.

8. From the External Finisher list window, expand the configuration you just imported
to view its profiles.

9. Select a profile, right-click, and select Enable.
The profile name displays as enabled and the configuration as online.

Xerox® Nuvera®7-36
System Administrator Guide

Configuring System Features



10. Select Close.

Exporting DFA Configurations
1. Log on to the system by selecting Logon from the Logon menu.
2. Select System Administrator as the user from the User Name drop-down list box.
3. Enter the System Administrator password and click OK.
4. Select the Printer Manager from FreeFlow Print Server user interface.
5. Select the Finishing tab.
6. Select the Finishers pull down menu and select External Finisher.

The External Finisher screen displays.
7. Select the configuration you want to export.
8. Either right-click and select Export or select Configuration > Export from the menu

bar.
9. Select the destination to which to export and save the configuration (CD, USB drive

or to a file on the directory).
10. Select Export or OK.

The configuration is saved to that destination.

Creating DFA Profiles and Configurations
1. Log on to the system by selecting Logon from the Logon menu.
2. Select System Administrator as the user from the User Name drop-down list box.
3. Enter the System Administrator password and click OK.
4. Select the Printer Manager from FreeFlow Print Server user interface.
5. Select the Finishing tab.
6. Select the Finishers pull down menu and select External Finisher.

The External Finisher screen displays.
7. To create a configuration and then a profile within it, select Configuration > New

Configuration from the menu bar.
The Configuration Properties window displays.

8. Enter the configuration name and description (description is optional but
recommended). For the name, it is recommended to use the format: module + module
+ module.

9. Select OK.
You are returned to the External Finisher window.

10. To create a DFA Profile, select the configuration you just created and right-click.
11. Select New Profile from the menu bar. Alternatively you can select Profile  > New

Profile.
The Profile Properties window displays. Refer to the DFA Resource Guide or the
finisher's manual for setting up the profile timings and entering all value settings for
this profile.

12. Select Save.
13. To enable both the profile and the configuration, from the External Finisher list

window, expand the configuration you just created to view its profiles.
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14. Right-click on the profile and select Enable.
The profile is enabled and the configuration is online.

15. Select Close.

Editing DFA Profiles and Configurations
You can only edit user defined configurations and profiles (not system -supplied) You
cannot edit configurations and profiles that are enabled and currently in use by the
printer
1. Log on to the system by selecting Logon from the Logon menu.
2. Select System Administrator as the user from the User Name drop-down list box.
3. Enter the System Administrator password and click OK.
4. Select the Printer Manager from FreeFlow Print Server user interface.
5. Select the Finishing tab.
6. Select the Finishers pull down menu and select External Finisher .

The External Finisher screen displays.
7. Select the profile you want to edit, right-click, and select Disable.
8. With the profile selected, right-click, and select Properties .

The Profile Properties window displays.
9. Change the name and/or description and any other attributes of the profile.

10. Select Save.
11. To enable both the profile and the configuration, from the External Finisher list

window, expand the configuration you just edited to view its profiles.
12. Right-click on the profile and select Enable.

The profile is enabled and the configuration is online.
13. Select Close.

Copying DFA Profiles
You can copy either user-defined or system-supplied profiles.
1. Log on to the system by selecting Logon from the Logon menu.
2. Select System Administrator as the user from the User Name drop-down list box.
3. Enter the System Administrator password and click OK.
4. Select the Printer Manager from FreeFlow Print Server user interface.
5. Select the Finishing tab.
6. Select the Finishers pull down menu and select External Finisher.

The External Finisher screen displays.
7. Select the profile or configuration you want to copy, right-click, and select Copy.
8. From the Properties window, change the name of the profile in the Name field and

any other profile attributes.
9. Select Save.

10. To enable both the profile and the configuration, from the External Finisher list
window, expand the configuration to view the copied profile.

11. Right-click on the profile and select Enable.
The profile is enabled and the configuration is online.
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12. Select Close.

Deleting DFA Configurations or Profiles from a Configuration
You can delete any offline configuration or enabled profile listed in the Configuration
list window. You cannot delete configurations that have profiles that are currently online.
1. Log on to the system by selecting Logon from the Logon menu.
2. Select System Administrator as the user from the User Name drop-down list box.
3. Enter the System Administrator password and click OK.
4. Select the Printer Manager from FreeFlow Print Server user interface.
5. Select the Finishing tab.
6. Select the Finishers pull down menu and select External Finisher.

The External Finisher screen displays.
7. If a configuration is identified as online, before you can delete it you must disable

all its profiles.
8. Select the profile or configuration you want to delete, right-click, and select Delete.

Or, select Configuration > Delete or Profile > Delete from the menu bar.
9. Confirm the deletion in the Delete message that displays.

When you delete a configuration, you delete all of the profiles that are listed under that
configuration.
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8
Troubleshooting Tips

Refer to this section for help in troubleshooting network communication and other
system problems.

Note
System Administrator privileges are required to check communication settings at the
printer.

• TCP/IP troubleshooting checklists

- Check communication settings at the printer

- Check communication settings at the workstation

• IPP troubleshooting checklists

- Check physical media and network interface cards

- Check communication settings at the printer

- Check communication settings at the workstation

• NetWare Bindery troubleshooting

- Check physical media and network interface cards

- Check communication settings at the printer

- Check communication settings at the workstation

- Tasks to perform at the server

• NetWare NDS troubleshooting

- Check physical media and network interface cards

- Check communication settings at the printer

- Check communication settings at the workstation

- Tasks to perform at the server
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• AppleTalk troubleshooting

- Check physical media and network interface cards

- Check communication settings at the printer

- Tasks to perform at the Macintosh workstation

• Running an Auto Repair Boot (File System Check-FSCK)

- When to run an auto repair or file system check

- How to run an auto repair or file system check

• Recovering from a system lockup (non-responsive user interface)

- If the cursor can still be moved

- Shutting down from a terminal window

- If you cannot access the System menu

- If the cursor is locked on the screen

TCP/IP Troubleshooting
Use the checklists in this section to troubleshoot your network communication problem.
To check settings at the printer you will have to log on as System Administrator.

Check Physical Media and Network Interface Cards
1. Verify that the printer is powered on.
2. Verify that the printer and workstation are using the correct cabling to communicate

over the network. Use category 5 UTP patch (not crossover) cable for 10 BaseT / 100
BaseTX/ 1000 BaseT communications.

3. Verify that the cable at both the workstation and printer is fully plugged into the
Network Interface Card (NIC). Check the link light, which is typically a green LED, to
make sure that it is lit. Typically, but not always, a second amber light on the Network
Interface Card will be intermittently flashing, indicating the presence of network
traffic. If neither of these lights is lit, there is a problem with the NIC, a problem with
the network drop, or a problem with the cable.

Note
The printer's NIC is located behind an access panel on the left side of the print station.
Refer to the Cable Connection and NIC Speed Setting procedure in the Required Set
Up Steps section of this guide for the location. As this panel is secured with a latch
to prevent tampering, if you have difficulty gaining access to the NIC, perform the
following procedure.

4. To check the function of the printer's NIC through software, perform the following
steps:
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a) Log on to the system as System Administrator (administ is the factory default
password).

b) From the System menu, select UNIX Terminal Window.
c) At the shell prompt ($) type su (and press Enter), then type your super user (root)

password when prompted (and press Enter).
The default password is available through the Xerox Customer Technical Support
Center.

d) At the root prompt (#), type ifconfig -a (with a blank space before -a) and press
Enter.
If the NIC is functioning it will be displayed as UP, in association with the IP
address of the printer.

e) At the root prompt (#), type exit and press Enter.
f) At the shell prompt ($) type exit and press Enter.

Check Communication Settings at the printer
Note
System Administrator privileges are required to check communication settings at the
printer.

1. Verify TCP/IP address settings.
a) From the system's Setup menu, select Network Configuration.
b) If not already enabled by factory default, click on the Enable IP check box to

enable it with a check mark.
c) Determine the method being used to assign TCP/IP addressing to the printer.

DHCP is the factory default method.

d) Verify that the IP Address, Subnet Mask, and Gateway addresses are correct for
your network and have not changed from their previous settings.

Note
The use of DHCP (the DHCP Server) with a short lease time can cause the printer
to be assigned a new IP Address when it is powered off for an extended period of
time. This will interrupt communications with workstations using the old IP address.
You will need to reconfigure all the workstations.

e) If you do not want the IP address to be subject to constant changes, either increase
the lease time at the DHCP Server, or select Static IP Configuration as your
addressing method.

f) Supply a valid IP address, Subnet Mask, and Gateway address (if used) for your
network.

g) If you are using a naming server to resolve host or NetBIOS names to IP addresses,
verify that you have correctly configured these settings at the printer by following
the instructions supplied in the Setting Up TCP/IP procedure in the Required Set
Up Steps section of this guide.

2. From the system's Setup menu, select Gateways.
a) Select the LPD tab.
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b) If you are communicating with the printer through an LPR port, make sure that
LPD is Enabled. If it isn't, enable it by selecting the Enabled radio button.

c) Select the Enabled radio button for LPD Default Queue (mandatory for single
queue Office systems, optional for multiple, internal queue Production systems).

d) Also verify that the displayed port number is 515. If not, set it to 515.

3. From the system's Setup menu, select Gateways.
a) Select the Socket tab.
b) To enable the printer to automatically determine the Page Description Language

(PDL) to use in processing incoming raw data streams , make sure that Port 9100
is enabled.

c) Select Port 9100, right-click the system mouse, and select Enable.
d) Select Port 9100 a second time, right-click the system mouse, and select Properties.
e) Select Non-VPS for operation with PCL and PostScript page description languages.

Select VPS only for work with mainframe data streams like LCDS.

Note
If the Port 9100 selections are unavailable, select Feature Licenses… from the
Setup menu and verify that the TCP/IP Socket license is present and enabled.
Complete instructions are available in the Checking Installed Options with License
Manager procedure in the Required Set Up Steps section of this guide.

4. From the Setup menu, select Feature Licenses.
a) Right-click the system mouse on the line labeled HTTP Gateway and select

Properties.
b) Make sure that both the Activate (under License) and Enable (under Feature)

radio buttons are selected.
c) The HTTP Gateway must be enabled to support job submission from workstations

using the web Interface, or NDS Plus software. If the HTTP Gateway license is not
functioning correctly, or is missing entirely, contact your Xerox Representative.

5. If a reboot is indicated to enable settings to take effect, reboot the system as
described in the Rebooting the System procedure in the Required Set Up Steps section
of this guide.

Check Communication Settings at the workstation
1. Open your web browser and enter the TCP/IP address of the printer in the Address

or Location field. Press Enter.

• If the printer's home page displays on the workstation, you are communicating
with the printer. Perform the next step.

• If not, make sure that your web browser is not using a proxy server to connect to
local area network addresses and repeat the procedure.

2. Verify that the workstation has been assigned an IP address, subnet mask, and
gateway address by running a command prompt, typing ipconfig/all (Windows) and
pressing Enter. (For UNIX workstations, the command is ifconfig.).
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3. If the addresses are incorrect or missing, verify that the TCP/IP protocol is installed
and correctly configured on your workstation as stated in the TCP/IP Peer to Peer
(LPR) Printing procedure in the Print Driver Installation section of this guide.

4. Run a command prompt on the workstation and perform ping tests to verify successful
packet transmission first to the workstation's NIC, then to the Gateway (if being
used), then to the printer's NIC. To run ping tests, at the command prompt, type:
ping xxx.xxx.xxx.xxx and press Enter.

Note
There is a space between the word ping and the first xxx. Let xxx.xxx.xxx.xxx first
represent the workstation's IP address, then the IP address of the default gateway,
and finally the IP address of the printer. If successful, you will receive a reply such as:
Reply from xxx.xxx.xxx.xxx: bytes=32 time<10ms TTL=128. If you receive Time Out
or 0 bytes received notifications, the device being pinged is incorrectly configured or
malfunctioning.

5. If web browser and ping tests are successful but you are still unable to print to the
printer, verify that the driver is using the correct LPR Port to print through.
a) From the operating sytem you are usng, verify that the IP Address on the LPR Port

being printed through matches the IP Address of the printer.
b) If the IP address does not match, you are printing to the wrong device on the

network. Either select the correct port from the displayed list, or use the Add Port
button to create a new port with an IP Address matching that of your printer.

6. If the correct Port is being used by the driver but you are still unable to print, perform
the following procedure. In Windows, follow the instructions for TCP/IP Peer to Peer
(LPR) Printing, in the Print Driver Installation section of this guide, to verify that Print
Services for Unix are installed in the workstation.

7. Note that access to this printer's services can be restricted by Host IP address ranges.
As this feature could cause communications to appear to fail in certain instances,
see the IP Filter information, accessed through the General Tab hot link of the
Selecting and Creating Security Profiles procedure, located in the Recommended Set
Up Steps section of this guide.

8. To assure successful printing, make sure that the printer is configured to support the
Page Description Language (PDL) being used by your driver. To check the PDL being
used by the driver, print a test job to file.
a) Open and view the job in a text editing program such as Notepad. The PDL being

used by the driver will be revealed in the first few lines of the displayed Printer Job
Language.

b) Next, determine the Page Description Languages being supported by the printer
by using the Checking Installed Options with License Manager procedure, contained
in the Required Set Up Steps section of this guide.

Note
The PDL being used by your driver and the PDL being supported by the printer
must match to assure successful printing. If they do not match, either install a
driver that matches the printer's licensed PDL options, or purchase and install a
PDL license in the printer that matches the output of your workstation drivers.
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IPP Troubleshooting
Use the following check list to troubleshoot your network communication problem. To
check settings at the printer you will have to log on as System Administrator, using a
password such as administ (the factory default setting).

Check Physical Media and Network Interface Cards
1. Verify that the printer is powered on.
2. Verify that the printer and workstation are using the correct cabling to communicate

over the network. Use category 5 UTP patch (not crossover) cable for 10 BaseT / 100
BaseTX/ 1000 BaseT communications.

3. Verify that the cable at both the workstation and printer is fully plugged into the
Network Interface Card (NIC). Check the link light, which is typically a green LED, to
make sure that it is lit. Typically, but not always, a second amber light on the Network
Interface Card will be intermittently flashing, indicating the presence of network
traffic. If neither of these lights is lit, there is a problem with the NIC, a problem with
the network drop, or a problem with the cable.

Note
The printer's NIC is located behind an access panel on the left side of the print station.
Refer to the Cable Connection and NIC Speed Setting procedure in the Required Set
Up Steps section of this guide for the location. As this panel is secured with a latch
to prevent tampering, if you have difficulty gaining access to the NIC, perform the
following procedure.

4. To check the function of the printer's NIC through software, perform the following
steps:
a) Log on to the system as System Administrator (administ is the factory default

password).
b) From the System menu, select UNIX Terminal Window.
c) At the shell prompt ($) type su (and press Enter), then type your super user (root)

password when prompted (and press Enter).
The default password is available through the Xerox Customer Technical Support
Center.

d) At the root prompt (#), type ifconfig -a (with a blank space before -a) and press
Enter.
If the NIC is functioning it will be displayed as UP, in association with the IP
address of the printer.

e) At the root prompt (#), type exit and press Enter.
f) At the shell prompt ($) type exit and press Enter.
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Check Communication Settings at the printer
1. Verify TCP/IP address settings.

a) From the system's Setup menu, select Network Configuration.
b) If not already enabled by factory default, click on the Enable IP check box to

enable it with a check mark.
c) Determine the method being used to assign TCP/IP addressing to the printer.

DHCP is the factory default method.

d) Verify that the IP Address, Subnet Mask, and Gateway addresses are correct for
your network and have not changed from their previous settings.

Note
The use of DHCP (the DHCP Server) with a short lease time can cause the printer
to be assigned a new IP Address when it is powered off for an extended period of
time. This will interrupt communications with workstations using the old IP address.
You will need to reconfigure all the workstations.

e) If you do not want the IP address to be subject to constant changes, either increase
the lease time at the DHCP Server, or select Static IP Configuration as your
addressing method.

f) Supply a valid IP address, Subnet Mask, and Gateway address (if used) for your
network.

g) If you are using a naming server to resolve host or NetBIOS names to IP addresses,
verify that you have correctly configured these settings at the printer by following
the instructions supplied in the Setting Up TCP/IP procedure in the Required Set
Up Steps section of this guide.

2. From the system's Setup menu, select Gateways.
a) Select the IPP tab.
b) Verify that a check mark is displayed within the Enable IPP checkbox. If necessary,

use the system mouse to place a checkmark within the Enable IPP checkbox.

Note
If the IPP selections are unavailable, select Feature Licenses from the Setup menu
and verify that the IPP license is present and enabled. Complete instructions are
available in the Checking Installed Options with License Manager procedure in
the Required Set Up Steps section of this guide.

3. From the system's Setup menu, select Gateways.
a) Select the Socket tab.
b) To enable the printer to automatically determine the Page Description Language

(PDL) to use in processing incoming raw data streams , make sure that Port 9100
is enabled.

c) Select Port 9100, right-click the system mouse, and select Enable.
d) Select Port 9100 a second time, right-click the system mouse, and select Properties.
e) Select Non-VPS for operation with PCL and PostScript page description languages.

Select VPS only for work with mainframe data streams like LCDS.
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Note
If the Port 9100 selections are unavailable, select Feature Licenses… from the
Setup menu and verify that the TCP/IP Socket license is present and enabled.
Complete instructions are available in the Checking Installed Options with License
Manager procedure in the Required Set Up Steps section of this guide.

4. From the Setup menu, select Feature Licenses.
a) Right-click the system mouse on the line labeled HTTP Gateway and select

Properties.
b) Make sure that both the Activate (under License) and Enable (under Feature)

radio buttons are selected.
c) The HTTP Gateway must be enabled to support job submission from workstations

using the web Interface, or NDS Plus software. If the HTTP Gateway license is not
functioning correctly, or is missing entirely, contact your Xerox Representative.

Check Communication Settings at the workstation
The IPP (Internet Printing Protocol) printing service is available for workstation operating
systems through downloads from the Microsoft web site. Follow the instructions provided
by Microsoft, or other trusted sources on the Internet, to install the IPP service on
Windows operating systems. In general, troubleshooting procedures for other operating
systems will be similar to this one.
1. Open your web browser and enter the TCP/IP address of the printer in the Address

or Location field. Press Enter.

• If the printer's home page displays on the workstation, you are communicating
with the printer. Perform the next step.

• If not, make sure that your web browser is not using a proxy server to connect to
local area network addresses and repeat the procedure.

2. Verify that the Internet protocol (TCP/IP) is installed in the Windows workstation.
Verify that the Internet Protocol (TCP/IP) has been loaded.
a) On the Windows desktop, select Start  > Control Panel, and select the Network

Center. View your active networks and locate the Internet type connection. Select
the Local Area Connection link. The status window displays.

b) Verify that the Protocol has been loaded by selecting the Properties button. The
Properties window displays. Verify that this workstation is using either a dynamic
or static method to obtain a valid TCP/IP address, and that the workstation's host
name is being resolved using DNS.

c) If the TCP/IP protocol is not loaded, click the Install button, then select Protocol
as the type of network component that you wish to install.

d) Click the Add button and select Internet Protocol (TCP/IP).
e) With your Operating System Installer Disk readily available, click the Have Disk

button and follow any remaining instructions.
f) Once the protocol has been installed, you can click on (highlight) the item with

your mouse and click the Properties button to verify or set up the method being
used for TCP/IP addressing.
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3. Run a command prompt on the workstation and perform ping tests to verify successful
packet transmission first to the workstation's NIC, then to the Gateway (if being
used), then to the printer's NIC. To run ping tests, at the command prompt, type:
ping xxx.xxx.xxx.xxx and press Enter.

Note
There is a space between the word ping and the first xxx. Let xxx.xxx.xxx.xxx first
represent the workstation's IP address, then the IP address of the default gateway,
and finally the IP address of the printer. If successful, you will receive a reply such as:
Reply from xxx.xxx.xxx.xxx: bytes=32 time<10ms TTL=128. If you receive Time Out
or 0 bytes received notifications, the device being pinged is incorrectly configured or
malfunctioning.

4. If Web browser and Ping Tests are successful but you are still unable to print to the
printer, verify that the driver is using an IPP Port to print through.
a) From the Windows desktop, select Start  > Devices and Printers, right-click on

the printer's icon, and select Printer Properties.

Note
If the printer's icon is missing, you need to install or reinstall the driver.

b) Select the Ports Tab and verify that the IPP Port being printed through matches
the IP Address, or fully qualified Domain Name, of the printer.

c) If the IP address (or fully qualified Domain Name) does not match, you are printing
to the wrong device on the network. Either select the correct port from the displayed
list, or use the Add Port button to create a new IPP port with an IP Address (or
fully qualified Domain Name) matching that of your printer.

Note
A fully qualified Domain Name consists of the printer's Internet host name,
followed by its internet domain name, separated by periods.

5. Note that access to this printer's services can be restricted by Host IP address ranges.
As this feature could cause communications to appear to fail in certain instances,
see the IP Filter information, accessed through the General Tab hot link of the
Selecting and Creating Security Profiles procedure, located in the Recommended Set
Up Steps section of this guide.

6. To assure successful printing, make sure that the printer is configured to support the
Page Description Language (PDL) being used by your driver. To check the PDL being
used by the driver, print a test job to file.
a) Open and view the job in a text editing program such as Notepad. The PDL being

used by the driver will be revealed in the first few lines of the displayed Printer Job
Language.

b) Next, determine the Page Description Languages being supported by the printer
by using the Checking Installed Options with License Manager procedure, contained
in the Required Set Up Steps section of this guide.
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Note
The PDL being used by your driver and the PDL being supported by the printer
must match to assure successful printing. If they do not match, either install a
driver that matches the printer's licensed PDL options, or purchase and install a
PDL license in the printer that matches the output of your workstation drivers.

NetWare Bindery Troubleshooting
Use the following check list to troubleshoot your network communication problem. To
check settings at the printer you will have to log on as System Administrator, using a
password such as administ (the factory default setting).

Check Physical Media and Network Interface Cards
1. Verify that the printer is powered on.
2. Verify that the printer and workstation are using the correct cabling to communicate

over the network. Use category 5 UTP patch (not crossover) cable for 10 BaseT / 100
BaseTX/ 1000 BaseT communications.

3. Verify that the cable at both the workstation and printer is fully plugged into the
Network Interface Card (NIC). Check the link light, which is typically a green LED, to
make sure that it is lit. Typically, but not always, a second amber light on the Network
Interface Card will be intermittently flashing, indicating the presence of network
traffic. If neither of these lights is lit, there is a problem with the NIC, a problem with
the network drop, or a problem with the cable.

Note
The printer's NIC is located behind an access panel on the left side of the print station.
Refer to the Cable Connection and NIC Speed Setting procedure in the Required Set
Up Steps section of this guide for the location. As this panel is secured with a latch
to prevent tampering, if you have difficulty gaining access to the NIC, perform the
following procedure.

4. To check the function of the printer's NIC through software, perform the following
steps:
a) Log on to the system as System Administrator (administ is the factory default

password).
b) From the System menu, select UNIX Terminal Window.
c) At the shell prompt ($) type su (and press Enter), then type your super user (root)

password when prompted (and press Enter).
The default password is available through the Xerox Customer Technical Support
Center.

d) At the root prompt (#), type ifconfig -a (with a blank space before -a) and press
Enter.
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If the NIC is functioning it will be displayed as UP, in association with the IP
address of the printer.

e) At the root prompt (#), type exit and press Enter.
f) At the shell prompt ($) type exit and press Enter.

Check Communication Settings at the printer
1. From the system's Setup menu, select Gateways. Select the NetWare tab.

Note
If the NetWare tab is grayed out, select Feature Licenses under the Setup menu and
verify that the Novell NetWare Gateway license is present and enabled. License
checking instructions are available in the Checking Installed Options with License
Manager procedure in the Required Set Up Steps section of this guide. If the license
is not present, contact your Xerox representative.

2. The NetWare tab indicates NetWare routes and their supported frame types. Auto
configuration is the default setting for detection, but manual changes can be made.
a) Verify that a displayed Frame Type and Novell Net Number matches your network

settings.
b) To make manual changes to the displayed information, click the Setup button,

select Manual Configuration, then click OK.
c) When the Warning prompt displays, click OK.
d) Select the line for the setting you wish to change and right-click the system mouse.
e) From the displayed dialog, select Properties, Add, or Delete to bring up a dialog

enabling you to make your changes.

3. From the system's Setup menu, select Gateways. Select the Queue Server tab.

Note
In the upper left corner of the Queue Server window, verify that the Enable NetWare
checkbox is checked (enabled). Also displayed in the upper left corner should be the
Mode for your system. If the displayed Mode does not match your system, click the
Setup button, select the correct Mode, and click OK.

4. Note that the Queue Server window provides two tables for configuring the printer's
connection to the NetWare server. The upper table is used for configuring NDS
connections, while the lower table is used for configuring Bindery connections. To
successfully communicate with the Novell Server, your connection configuration to
the Server must be shown in the Bindery table.

5. To further view the properties of an existing connection configuration, in the Bindery
table, right-click on a horizontal selection line and select Properties from the pop-up
menu.

Note
For a successful Bindery connection you will need a File Server name, Print Server
name and password, and a Query Interval (queue polling interval).

6. If your connection configuration is missing from the Bindery table, you need to set
up a new connection configuration for your Novell Server .
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a) Click on the New button in the window's lower right corner and select New from
the pop-up menu.

b) Follow the setup instructions supplied under the heading Configuring Queue Server
for your Mode, in the NetWare (NDS and Bindery) procedure in the NOS Selection
Menu section of this guide.

Check Communication Settings at the workstation
1. Verify that the correct Protocol and Service are installed.

a) Verify that the NW Link/IPX/SPX/NetBIOS Compatible Transport Protocol is
installed in the workstation. On the Windows desktop, select Start  > Control
Panel, and select Network Center. View your active networks and locate the
Internet type connection. Select the Local Area Connection link. The status window
displays.

b) Verify that the Protocol has been loaded by selecting the Properties button. The
Properties window displays. If the protocol is not loaded, click the Install button,
then select Protocol as the type of network component that you wish to install.

c) If the protocol is not loaded, click the Install button, then select Protocol as the
type of network component that you wish to install.

d) Click the Add button and select NW Link/IPX/SPX/NetBIOS Compatible Transport
Protocol.

e) With your Operating System Installer Disk readily available, click the Have Disk
button and follow any remaining instructions.

f) Verify that the Client Service for NetWare is installed in the workstation. Select
Start  > Control Panel, and select Network Center. Select the Local Area
Connection link and select Properties.

g) If the Client Service for NetWare is not loaded, click the Install button, then select
Client as the type of network component that you wish to install.

h) Click the Add button and select Client Service for NetWare.
i) With your Operating System Installer Disk readily available, click the Have Disk

button and follow any remaining instructions.

2. For all workstations, verify that the driver is using the correct Network Port to print
through.
a) On your Windows desktop, select Start  > Devices and Printers, right-click on the

printer's icon, and select Printer Properties.

Note
If the printer's icon is missing you need to install or reinstall the driver

b) Select the Ports Tab and verify that the Network Port being printed through
includes the name of the Primary (File) Server and Print Queue. If the Primary
(File) Server name does not match the name shown in the Bindery table of the
Queue Server window at the printer, you are printing to the wrong Server on the
network. Either select the correct port from the displayed list, or use the Add Port
button to create a new Network Port.

c) From the General Tab of the driver send a Test Page to the printer to see if you
can print.

Xerox® Nuvera®8-12
System Administrator Guide

Troubleshooting Tips



3. For all workstations, make sure that the Page Description Language (PDL) being used
by your driver is supported by the printer.
a) To check the PDL being used by the driver, print a test job to file. Open and view

the job in a text editing program such as Notepad. The PDL being used by the
driver will be revealed in the first few lines of the displayed Printer Job Language.

b) Next, determine the Page Description Languages being supported by the printer
by using the Checking Installed Options with License Manager procedure, contained
in the Required Set Up Steps section of this guide.

c) The PDL being used by your driver and the PDL being supported by the printer
must match to assure successful printing. If they do not match, either install a
driver that matches the printer's licensed PDL options, or purchase and install a
PDL license in the printer that matches the output of your workstation drivers.

At the Primary (File) Server, perform these tasks

At the Primary (File) Server, perform these additional troubleshooting tasks.

• Check the printer’s log in using PCONSOLE

• If the printer did not log in, check to see if it logged in to another Server

• Verify the existence of a Configuration File for the printer

• If the Printer Configuration File is present and correctly named, check for the Print
Server and Queue Names

• Editing the Printer Configuration File

• Check to see if the printer is now logged into the network

• Check to see if a lack of Novell Licenses is preventing the printer from logging in

• Suspecting a problem with the Server

Check the printer’s log in using PCONSOLE
1. From a workstation with a network connection, log in (with System Administrator

Privileges) to the Primary Server.

Note
While the use of PCONSOLE described below does not require System Administrator
privileges, if you will be making modifications or changing the Printer Configuration
file on the Server, you will need to be logged in as System Administrator.

2. Make sure that you have a drive mapped to the SYS volume. This is the volume that
contains the LOGIN and PUBLIC directories.

3. At the command prompt, if not already in the PUBLIC directory, change to the PUBLIC
directory by typing cd public and press Enter.

4. At the PUBLIC prompt, type pconsole and press Enter.
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5. When the PCONSOLE screen displays, observe the information at the top of the screen
to verify that you are connected to the correct Primary File Server. If correct, the
Server name will match the File Server name shown in the Bindery table of the Queue
Server window at the printer.

Note
If you are not connected to the correct file server you will be checking for the Printer
login in the wrong place.

6. Under Available Options, highlight Print Queue Information and press Enter.
The Print Queues will be displayed in a list.

7. Select the name of your printer Print Queue from the list and press Enter.
8. Under Print Queue Information, highlight Currently Attached Servers and press Enter.

If a Print Server is shown, the printer logged into the network properly. If nothing is
shown, the printer did not log in to the network correctly. Check to see if the Printer
logged into another Server, or reboot the printer to see if it logs into this file server
properly.

9. Press the Escape key as many times as required to back out of displayed menus and
screens, until the Exit Pconsole prompt is displayed. Highlight Yes and press Enter.

If the printer did not log in, check to see if it logged in to another Server
1. To find out how many File Servers are on the network, at the PUBLIC prompt, type

slist and press Enter.
2. If you suspect that another File Server contains the Printer Configuration File (with

the Print Queue and Print Server names), log in to the server of interest. To log in to
one of the displayed servers, type login (the server name)\(your login name) and
press Enter.

Note
Add a space between login and the server name.

3. Check the Printer's Log In using PCONSOLE, as previously described.

Verify the existence of a Configuration File for the printer
1. On the known Primary File Server, after logging in to the server, make sure that you

have a drive mapped to the SYS volume containing the LOGIN and PUBLIC directories.
2. The printer configuration file is required to be located on the Primary Server, typically

using a directory structure such as: SYS/LOGIN/XEROX. Go to the XEROX directory
(by typing cd (directory) Enter), and verify the existence of the printer configuration
file (by typing dir).

If you have a Printer Configuration file for your printer, you should see a file with a name
such as x(plus the last 6 digits of the printer NIC (MAC) address). If this file is missing,
you will have to create it or the printer will not be able to communicate over the Novell
network. Refer to your Novell documentation for the steps to follow to create this type
of file. To edit an existing file, see Editing the Printer Configuration File below.
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If the Printer Configuration File is present and correctly named, check
for the Print Server and Queue Names
1. Switch to the PUBLIC directory (if not already there) by typing cd public Enter, and

type pconsole, and press Enter.
2. In PCONSOLE, from the Available Options screen select Print Queue Information.
3. From the list of displayed Print Queues, look for the queue for your printer and write

down its name (RHINO2_Q, for example).
4. From the Available Options screen select Print Server Information.
5. From the list of displayed Print Servers, look for the server for your printer and write

down its name (RHINO2_PS, for example).
6. Press the Escape key as many times as required to back out of displayed menus and

screens, until the Exit Pconsole prompt is displayed. Highlight Yes and press Enter.

Editing the Printer Configuration File
This procedure requires System Administrator privileges.
1. Change directories (cd login, cd xerox) to display the LOGIN\XEROX prompt and

typically type EDIT x (plus the last 6 digits of the printer NIC (MAC) address) and
press Enter.

2. Your screen should now display a text string similar to the following:
PQA1_312:FHINO2_Q:RHINO2_PS:Parallel::

3. The first entry in this file is the Primary Server name (in this case PQA1_312), which,
if correct, matches the File Server name displayed in the Bindery table of the Queue
Server window at the printer. The next entry is the Queue Name (FHINO2_Q) which
should match the queue (RHINO2_Q) that was displayed in PCONSOLE.

Note
This example (FHINO2_Q) is showing an incorrect entry so you know what to look
for.

4. The next entry is the Print Server (RHINO2_PS) which should (and in this case does)
match the Print Server that was displayed in PCONSOLE.

5. The last entry :Parallel:: appears in all correct Printer Configuration files. Note the
colon before and 2 colons after "Parallel." If this is not exactly as shown, your file will
need to be recreated.

6. To correct the incorrectly shown entry for Print Queue, type in RHINO2_Q in place of
FHINO2_Q.

7. From the File menu, select New and press Enter.
8. When prompted to save the loaded file, select Yes and press Enter.
9. After making a change in the Printer Configuration file in the Primary (File) Server

(that the printer refers to when logging into the network) power cycle (reboot) the
printer to enable the printer to freshly log into the Novell network. Wait for two to
three minutes for the printer to log in.
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Check to see if the printer is now logged into the network

Using USERLIST - At the PUBLIC prompt (cd public), type userlist and press ENTER. If
the printer logged into the network correctly, its Print Server name (RHINO2_PS, for
example) should be displayed in the list along with the time of log in.

Note
As the printer logs into the server as a user, you must NOT exceed your maximum number
of Novell user licenses or the printer will fail to log in.

Using PCONSOLE - See the above-described procedure under the heading Check the
printer log in using PCONSOLE.

Check to see if a lack of Novell Licenses is preventing the printer from
logging in

At the Server Console, with monitor.nlm running, type version to display the number of
user licenses installed. For comparison, from the Monitor Screen in the window labeled
Information for Server, the total number of licenses in use is displayed.

Suspecting a problem with the Server

If all of the previous troubleshooting steps have been taken and the printer still fails to
log into the network correctly, the problem might be with the Server. In this case, it is
recommended that you delete the current Printer Configuration file and all associated
Server entries, and freshly set up the Configuration File, and Install a Print Server (create
Queue, create Print Server, define printer), as stated in Novell's documentation.

NetWare NDS Troubleshooting
Use the following check list to troubleshoot your network communication problem. To
check settings at the printer you will have to log on as System Administrator, using a
password such as administ (the factory default setting).

Check Physical Media and Network Interface Cards
1. Verify that the printer is powered on.
2. Verify that the printer and workstation are using the correct cabling to communicate

over the network. Use category 5 UTP patch (not crossover) cable for 10 BaseT / 100
BaseTX/ 1000 BaseT communications.
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3. Verify that the cable at both the workstation and printer is fully plugged into the
Network Interface Card (NIC). Check the link light, which is typically a green LED, to
make sure that it is lit. Typically, but not always, a second amber light on the Network
Interface Card will be intermittently flashing, indicating the presence of network
traffic. If neither of these lights is lit, there is a problem with the NIC, a problem with
the network drop, or a problem with the cable.

Note
The printer's NIC is located behind an access panel on the left side of the print station.
Refer to the Cable Connection and NIC Speed Setting procedure in the Required Set
Up Steps section of this guide for the location. As this panel is secured with a latch
to prevent tampering, if you have difficulty gaining access to the NIC, perform the
following procedure.

4. To check the function of the printer's NIC through software, perform the following
steps:
a) Log on to the system as System Administrator (administ is the factory default

password).
b) From the System menu, select UNIX Terminal Window.
c) At the shell prompt ($) type su (and press Enter), then type your super user (root)

password when prompted (and press Enter).
The default password is available through the Xerox Customer Technical Support
Center.

d) At the root prompt (#), type ifconfig -a (with a blank space before -a) and press
Enter.
If the NIC is functioning it will be displayed as UP, in association with the IP
address of the printer.

e) At the root prompt (#), type exit and press Enter.
f) At the shell prompt ($) type exit and press Enter.

Check Communication Settings at the printer
1. From the system's Setup menu, select Gateways. Select the NetWare tab.

Note
If the NetWare tab is grayed out, select Feature Licenses under the Setup menu and
verify that the Novell NetWare Gateway license is present and enabled. License
checking instructions are available in the Checking Installed Options with License
Manager procedure in the Required Set Up Steps section of this guide. If the license
is not present, contact your Xerox representative.

2. The NetWare tab indicates NetWare routes and their supported frame types. Auto
configuration is the default setting for detection, but manual changes can be made.
a) Verify that a displayed Frame Type and Novell Net Number matches your network

settings.
b) To make manual changes to the displayed information, click the Setup button,

select Manual Configuration, then click OK.
c) When the Warning prompt displays, click OK.
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d) Select the line for the setting you wish to change and right-click the system mouse.
e) From the displayed dialog, select Properties, Add, or Delete to bring up a dialog

enabling you to make your changes.

3. From the system's Setup menu, select Gateways. Select the Queue Server tab.

Note
In the upper left corner of the Queue Server window, verify that the Enable NetWare
checkbox is checked (enabled). Also displayed in the upper left corner should be the
Mode for your system. If the displayed Mode does not match your system, click the
Setup button, select the correct Mode, and click OK.

4. Note that the Queue Server window provides two tables for configuring the printer's
connection to the NetWare server. The upper table is used for configuring NDS
connections, while the lower table is used for configuring Bindery connections. To
successfully communicate with the Novell Server, your connection configuration to
the Server must be shown in the NDS table.

5. To further view the properties of an existing connection configuration, in the NDS
table, right-click on a horizontal selection line and select Properties from the pop-up
menu.

Note
For a successful NDS connection you will need a Tree Name, Context Name, Print
Server name and password, and a Query Interval (queue polling interval).

6. If your connection configuration is missing from the NDS table, you need to set up
a new connection configuration for your Novell Server.
a) Click on the New button in the window's lower right corner and select New from

the pop-up menu.
b) Follow the setup instructions supplied under the heading Configuring Queue Server

for your Mode, in the NetWare (NDS and Bindery) procedure in the NOS Selection
Menu section of this guide.

Check Communication Settings at the workstation
1. Verify that the correct Protocol and Service are installed.

a) Verify that the NW Link/IPX/SPX/NetBIOS Compatible Transport Protocol is
installed in the workstation. On the Windows desktop, select Start  > Control
Panel, and select Network Center. View your active networks and locate the
Internet type connection. Select the Local Area Connection link. The status window
displays.

b) Verify that the Protocol has been loaded by selecting the Properties button. The
Properties window displays. If the protocol is not loaded, click the Install button,
then select Protocol as the type of network component that you wish to install.

c) If the protocol is not loaded, click the Install button, then select Protocol as the
type of network component that you wish to install.

d) Click the Add button and select NW Link/IPX/SPX/NetBIOS Compatible Transport
Protocol.
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e) With your Operating System Installer Disk readily available, click the Have Disk
button and follow any remaining instructions.

f) Verify that the Client Service for NetWare is installed in the workstation. Select
Start  > Control Panel, and select Network Center. Select the Local Area
Connection link and select Properties.

g) If the Client Service for NetWare is not loaded, click the Install button, then select
Client as the type of network component that you wish to install.

h) Click the Add button and select Client Service for NetWare.
i) With your Operating System Installer Disk readily available, click the Have Disk

button and follow any remaining instructions.

2. For all workstations, verify that the driver is using the correct Network Port to print
through.
a) On your Windows desktop, select Start  > Devices and Printers, right-click on the

printer's icon, and select Printer Properties.

Note
If the printer's icon is missing you need to install or reinstall the driver

b) Select the Ports Tab and verify that the Network Port being printed through
includes the name of the Primary (File) Server and Print Queue. If the Primary
(File) Server name does not match the name shown in the Bindery table of the
Queue Server window at the printer, you are printing to the wrong Server on the
network. Either select the correct port from the displayed list, or use the Add Port
button to create a new Network Port.

c) From the General Tab of the driver send a Test Page to the printer to see if you
can print.

3. For all workstations, make sure that the Page Description Language (PDL) being used
by your driver is supported by the printer.
a) To check the PDL being used by the driver, print a test job to file. Open and view

the job in a text editing program such as Notepad. The PDL being used by the
driver will be revealed in the first few lines of the displayed Printer Job Language.

b) Next, determine the Page Description Languages being supported by the printer
by using the Checking Installed Options with License Manager procedure, contained
in the Required Set Up Steps section of this guide.

c) The PDL being used by your driver and the PDL being supported by the printer
must match to assure successful printing. If they do not match, either install a
driver that matches the printer's licensed PDL options, or purchase and install a
PDL license in the printer that matches the output of your workstation drivers.

At the Server, perform these tasks

At the Server, perform these additional troubleshooting tasks.

• Check the printer’s log in using PCONSOLE

• Check the printer log in with NLIST USER
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• Check to see if a lack of available Novell Licenses is preventing the printer from logging
in

• Suspecting a problem with the Server

Check the printer’s log in using PCONSOLE
1. Log into the Novell Server as System Administrator using a workstation running Novell

Client services.
2. Check the context displayed on screen to make sure that the current context is the

same as the context of the file server that was used when setting up the print server
and print queue.

Note
If necessary, to change context type cx and the correct context name, separated by
a space, and press Enter.

3. At the drive prompt (if your search path is set for the PUBLIC directory) or by first
typing cd public, Enter, type pconsole and press Enter.

4. From PCONSOLE's Available Options window, select Print Queues and press Enter.
5. In the Print Queues window, select the printer queue and press Enter.
6. In the Print Queue Information window, scroll down to Attached Print Servers and

press Enter.
7. If the printer logged into the server correctly, the Print Servers Currently Servicing

Print Queues window should show the name of the printer's Print Server. If nothing
is shown, the printer did not log in correctly and, referring to your Novell
documentation, you should follow the instructions to set up a Print Server, Print Queue,
and Printer using NWADMIN or PCONSOLE. When following these instructions, if you
find that the print server name was incorrect, correct it, save the new setup, and
power off/power on the printer to log back into the network correctly.

8. Press your Escape key to exit PCONSOLE.

Check the printer log in with NLIST USER

At the PUBLIC prompt (cd public), type nlist user and press Enter. If the printer logged
into the network correctly, its Print Server name should be displayed in the list along
with the time of log in.

Note
The NLIST can be misleading if the display is not refreshed frequently, or the printer has
been left on for an extended period of time. It can be used as a guide, however, by
powering the printer off, then on, to see if the time of login shown in the NLIST updates.
If it does, you know that the printer is logging into the network.
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Check to see if a lack of available Novell Licenses is preventing the
printer from logging in

At the Server Console, with monitor.nlm running, type version to display the number of
user licenses installed. For comparison, from the NetWare 4.x Console Monitor, in the
General Information window, the total number of licenses in use is displayed.

Suspecting a problem with the Server

If all of the previous troubleshooting steps have been taken and the printer still fails to
log into the network correctly, the problem might be with the Server. In this case, it is
recommended that you delete the current Print Server, Print Queue, and Printer objects,
and freshly set them up in the appropriate Context (NDS Tree) using NetWare
Administrator, NetAdmin, or PCONSOLE.

AppleTalk Troubleshooting
Use the following check list to troubleshoot your network communication problem. To
check settings at the printer you will have to log on as System Administrator, using a
password such as administ (the factory default setting).

Check Physical Media and Network Interface Cards
1. Verify that the printer is powered on.
2. Verify that the printer and workstation are using the correct cabling to communicate

over the network. Use category 5 UTP patch (not crossover) cable for 10 BaseT / 100
BaseTX/ 1000 BaseT communications.

3. Verify that the cable at both the workstation and printer is fully plugged into the
Network Interface Card (NIC). Check the link light, which is typically a green LED, to
make sure that it is lit. Typically, but not always, a second amber light on the Network
Interface Card will be intermittently flashing, indicating the presence of network
traffic. If neither of these lights is lit, there is a problem with the NIC, a problem with
the network drop, or a problem with the cable.

Note
The printer's NIC is located behind an access panel on the left side of the print station.
Refer to the Cable Connection and NIC Speed Setting procedure in the Required Set
Up Steps section of this guide for the location. As this panel is secured with a latch
to prevent tampering, if you have difficulty gaining access to the NIC, perform the
following procedure.

4. To check the function of the printer's NIC through software, perform the following
steps:
a) Log on to the system as System Administrator (administ is the factory default

password).
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b) From the System menu, select UNIX Terminal Window.
c) At the shell prompt ($) type su (and press Enter), then type your super user (root)

password when prompted (and press Enter).
The default password is available through the Xerox Customer Technical Support
Center.

d) At the root prompt (#), type ifconfig -a (with a blank space before -a) and press
Enter.
If the NIC is functioning it will be displayed as UP, in association with the IP
address of the printer.

e) At the root prompt (#), type exit and press Enter.
f) At the shell prompt ($) type exit and press Enter.

Check Communication Settings at the printer
1. From the system's Setup menu, select Gateways.

a) Select the AppleTalk tab. Verify that the Phase Type is correctly set for your
network.

The Phase Type is set to 2 by default. This denotes a multi-zoned network of 256
workstations per zone. The Phase 1 setting, which is available by clicking the selection
arrow, is an older phase with a limit of 256 workstations on a single network.

Note
If the AppleTalk selections are unavailable, select Feature Licenses from the Setup
menu and verify that the AppleTalk license is present and enabled. Complete
instructions are available in the Checking Installed Options with License Manager
procedure in the Required Set Up Steps section of this guide.

2. Also from the AppleTalk tab, verify that the Zone Name is set as a star (*) by default.
This setting lets the closest router assign the printer to a zone.

3. Also note the AppleTalk Printer Name, which is the name selected in Chooser on
Macintosh OS 9.x workstations, or in the Printer List on Macintosh OS X workstations.

For systems without the Productivity Pack enabled, this name is the same as the
printer's single, internal queue name (either XRX followed by the MAC address, or
the IP hostname followed by the letters VP). For systems with the Productivity Pack
license enabled, with multiple, possible internal queues, to view or modify the queue
name (AppleTalk Printer Name), use Queue Manager. For instructions, refer to the
Using Queue Manager procedure in the NOS Selection Menu section of this guide.

4. From the Setup menu, select Feature Licenses.
a) Look for a horizontal selection line indicating the presence of a PostScript license.

The PostScript page description language is required to support AppleTalk printing.
b) If a PostScript selection line is not displayed on your screen, contact your Xerox

representative.
c) If a PostScript selection line is displayed, right-click on the line with the system

mouse and select Properties.
d) Make sure that both the Activate (under License) and Enable (under Feature)

radio buttons are selected.
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e) A License String box should also be filled in with a lengthy string of characters
(letters and numbers, indicating a valid PostScript license.

At the Macintosh workstation

Verify that the Printer is visible in Chooser on Macintosh OS 9.x workstations, or in the
Printer List on Macintosh OS X workstations. If it is not, install the Driver and PPD files
as stated in the AppleTalk Printing procedure in the Print Driver Installation section of
this guide.

Note
As OS X workstations can communicate with the printer by TCP/IP (LPR), if problems are
encountered with this printing method, perform the Check Communication Settings at
the printer steps, supplied in the TCP/IP Troubleshooting procedure, in this section of
the guide.

Running an Auto Repair Boot (File System
Check-FSCK)
When to run an auto repair or file system check

• Whenever the system has experienced a sudden or improper power off.
• When, during startup, the following message is displayed: Type Ctrl -d to proceed

with normal startup, (or give root password for system maintenance).
• When unusual software behavior is observed.

How to run an auto repair or file system check
1. Power down the system.
2. Power the system on. After a few seconds, a GNU GRUB blue screen with several

menu selections displays.
3. Use the arrow keys to select Auto-repair boot. You must move the arrow keys within

10 seconds or the system will attempt a normal boot, FreeFlow Print Server (default).
In approximately two minutes, Auto-Repair boot processes and completes five phases
and the system re-boots.

4. If problems continue, perform these steps a second time. If you still experience
problems, contact Xerox for additional assistance.

8-23Xerox® Nuvera®

System Administrator Guide

Troubleshooting Tips



Recovering from a system lockup
(non-responsive user interface)
The following are steps to recover from an unresponsive system.

If the cursor can still be moved
1. Try to shut down the system by selecting Shutdown from the System menu. The most

controlled shutdown method available, Shutdown completes jobs currently printing
or scanning before shutting the system down.

2. After the system has been shut down, restart it by pressing the on position (labeled
I) on the power on/off button, located on the right front of the print station (to the
right of the system's monitor).

Shutting down from a terminal window
1. Log on to the system as System Administrator.
2. From the System menu, select UNIX Terminal Window.

• If the cursor is locked on the screen, try holding down the Alt key and pressing
the S key.

• If the System menu displays, hold down the Alt key again and press the U key.

3. At the shell prompt ($) type su (and press Enter), then type your super user (root)
password* when prompted (and press Enter).

Note
The default password is available through the Xerox Customer Technical Support
Center

4. If login is successful, a # prompt will be displayed.
5. Type sync;sync;poweroff and press Enter.

Note
To undo typing mistakes, hold down the Control key and press the U key.

6. After the system has been shut down, restart it by pressing the on position (labeled
I) on the power on/off button, located on the right front of the print station (to the
right of the system's monitor).

If you cannot access the System menu
Try to shut down the system using the power on/off button as follows:
1. Briefly press and release the off position (labeled O) on the power on/off button,

located on the right front of the print station (to the right of the system's monitor).
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2. When prompted, select Shutdown from the displayed menu.
3. Wait for the status window to finish displaying its power down in progress message.
4. After the system has been shut down, restart it by pressing the on position (labeled

I) on the power on/off button, located on the right front of the print station (to the
right of the system's monitor).

If the cursor is locked on the screen
Note
This procedure is considered a hard stop and should only be used if other shutdown
methods fail to work. You may have to run FSCK, as stated in this Troubleshooting
section, after performing this hard stop procedure.

1. Initially, try holding down the Alt key and pressing the S key.
a) If the System menu displays, hold down the Alt key again and press the S key (to

select Shutdown).
b) Press Enter in response to the displayed confirmation message.

2. If the Alt, S key combination fails to work, on the left side of the keyboard hold down
the Stop key and press the A key.

3. At the ok prompt, type sync and press Enter.

Note
To undo typing mistakes, hold down the Control key and press the U key.

4. When the screen goes blank, press the system's power on/off button, located on the
right front of the print station (to the right of the system's monitor). Hold the button
in the on position (labeled I) for approximately 4 seconds.

5. After the system has been shut down, restart it by pressing the on position (labeled
I) on the power on/off button, located on the right front of the print station (to the
right of the system's monitor).
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